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Za vaso varnost

Preberite ta preprosta navodila. NeupoStevanje predpisov je lahko nevarno ali protizakonito. Za podrobnejSe informacije preberite celoten
priroCnik za uporabo.
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VARNO VKLAPLJANJE

Ne vklapljajte naprave, Ce je uporaba mobilnega telefona prepovedana ali ¢e lahko povzro€i interferenco ali nevarnost.

VARNOST V PROMETU JE NA PRVEM MESTU

Upostevajte vse zakone, ki veljajo v doloCeni drZavi. Med voznjo imejte vedno proste roke, da boste lahko upravljali vozilo. Misliti
morate predvsem na varnost na cesti.

INTERFERENCA

Vse brezzi¢ne naprave so obCutljive za interferenco, ki lahko moti njihovo delovanje.

IZKLAPLJANJE V BOLNISNICAH

Upostevajte prepovedi. 1zklopite napravo v blizini medicinske opreme.

IZKLAPLJANJE V LETALU

Upostevajte prepovedi. Brezzitne naprave lahko povzrocijo interferenco v letalih.

IZKLAPLJANJE PRI NATAKANJU GORIVA

Naprave ne uporabljajte na bencinski Crpalki. Ne uporabljajte je blizu goriv ali kemikalij.

IZKLAPLJANJE V BLIZINI RAZSTRELJEVANJA

Upostevajte prepovedi. Naprave ne uporabljajte tam, kjer poteka razstreljevanje.

RAZSODNA UPORABA

I1zdelek uporabljajte le v normalnem poloZaju, kakor je razlozeno v prilozeni dokumentaciji. Ne dotikajte se anten po nepotrebnem.
STROKOVNI SERVIS

Ta izdelek sme vgraditi ali popravljati samo usposobljeno osebje.

DODATNA OPREMA IN BATERIJE

Uporabljajte samo odobreno dodatno opremo in baterije. Ne priklapljajte nezdruZljivih naprav.

NEPREPUSTNOST ZA VODO
Va3a naprava ni neprepustna za vodo. Skrbite, da bo vedno suha.

VARNOSTNE KOPIE
Ne pozabite si prepisati ali narediti varnostnih kopij vseh pomembnih podatkov.

POVEZOVANJE Z DRUGIMI NAPRAVAMI

Pri povezovanju s katero koli drugo napravo preberite podrobna varnostna navodila v njenem prirocniku. Ne priklapljajte
nezdruZljivih naprav.

KLICI VSILI

Telefonska funkcija naprave mora biti vklopljena in naprava mora biti v dosegu signala omrezja. Pritisnite tipko za konec, kolikorkrat
je treba, da se zaslon zbriSe in se prikaZe zaslon za pripravljenost. Vnesite Stevilko za klice v sili, nato pritisnite klicno tipko. Povejte,
kje ste. Klica ne koncajte, dokler vam tega ne dovoli klicana sluzba.

B O vasi napravi

Lo

Mobilna naprava, opisana v tem priro¢niku, je odobrena za uporabo v omrezjih GSM 850/900/1800/1900, UMTS 2100. Ve€ informacij
o omreZjih dobite pri svojem ponudniku storitev.

Pri uporabi funkcij te naprave upostevajte vse zakone ter spostujte zasebnost in zakonite pravice drugih.

Opozorilo: Naprava mora biti vklopljena, Ce Zelite uporabljati katero koli njeno funkcijo, z izjemo budilke. Naprave ne vklapljajte,
kadar lahko uporaba brezzitnih naprav povzrodi interferenco ali nevarnost.

B OMREZNE STORITVE

Da bi telefon lahko uporabljali, morate imeti dostop do storitve ponudnika mobilnih storitev. Delovanje mnogih funkcij te naprave je odvisno
od delovanja funkcij mobilnega omreZzja. Te omreZzne storitve morda ne bodo na voljo v vseh omrezjih ali pa se boste morali, Ce jih boste hoteli
uporabljati, nanje posebej narociti pri ponudniku storitev. Vas ponudnik storitev vam bo morda moral dati dodatna navodila in informacije o
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Za va%o0 varnost

strodkih. Nekatera omrezja imajo lahko omejitve, ki vplivajo na uporabo omreznih storitev. Nekatera omreZzja na primer ne podpirajo vseh
storitev ali znakov nekaterih jezikov.

Vas$ ponudnik storitev je morda zahteval izklop ali onemogotil vklop nekaterih funkcij v vasi napravi. V tem primeru v meniju naprave ne bodo
prikazane. Naprava je bila morda tudi posebej nastavljena. To lahko vklju€uje spremembe imen menijev, vrstnega reda menijev in ikon. Vet
informacij lahko dobite pri ponudniku storitev.

Ta naprava podpira protokole WAP 2.0 (HTTP in SSL), ki delujejo prek protokolov TCP/IP. Ce omreZje ne podpira tehnologij, na katerih temeljijo
nekatere funkcije te naprave, na primer vepredstavnostna sporocila, brskalnik, e-posta in nalaganje vsebine z brskalnikom, jih ne boste mogli
uporabljati.

B Dodatna oprema, baterije in polnilniki

Pred uporabo s to napravo vedno preverite oznako modela polnilnika. Delovanje te naprave omogocta napajanije s polnilniki AC-4, AC-3 in DC-4
ter polnilniki ACP-8, ACP-9, ACP-12, LCH-8, LCH-9, LCH-12 in AC-1, Ce jih uporabljate z adapterjem CA-44.

& Opozorilo: Uporabljajte le baterije, polnilnike in opremo, ki jih je druzba Nokia odobrila za uporabo s tem modelom. Uporaba kak3$nih
drugih vrst lahko iznici garancijo in moZznost zamenjave in je lahko nevarna.

Glede razpolozljivosti odobrene dodatne opreme se posvetujte s pooblas¢enim prodajalcem. Ko izklapljate napajalni kabel katere koli dodatne
opreme, primite in potegnite vtikac, ne kabla.

Ta naprava in oprema zanjo lahko vsebujejo majhne sestavne dele. Hranite jih nedosegljive otrokom.
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@ Opomba: Vas ponudnik storitev je morda zahteval izklop ali onemogoCil vklop nekaterih funkcij v vasi napravi. V tem
primeru niso prikazane v meniju naprave. Naprava je bila morda tudi posebej nastavljena za vaSega mobilnega
operaterja. To lahko vkljuCuje spremembe imen menijev, vrstnega reda menijev in ikon. Vet informacij lahko dobite
pri ponudniku storitev.

Oznaka modela: Nokia E61-1
V nadaljevanju Nokia E61.

B Vstavljanje kartice SIM in baterije

Vse kartice SIM hranite nedosegljive majhnim otrokom.

Informacije o razpoloZljivosti in uporabi storitev SIM lahko dobite pri izdajatelju kartice SIM, tj. pri ponudniku storitev, mobilnem
operaterju ali drugih prodajalcih izdelkov mobilne telefonije.

1. Preden odstranite baterijo, napravo vedno izklopite in jo loite od polnilnika.

Napravo obrnite s hrbtno stranjo proti sebi, pritisnite gumb za sprostitev pokrovcka (1) in potisnite hrbtni pokrovtek v smeri
pusCice (2).

3. Vstavite kartico SIM (1) v ustrezno reZo (2). Prirezani vogal kartice mora biti obrnjen proti spodnjemu delu naprave, prikljucki
na njej pa proti napravi.

4. Da bi vstavili baterijo, poravnajte njene prikljutke z ustreznimi prikljucki v prostoru za baterijo, vstavite jo v smeri pus€ice
in previdno pritisnite nanjo, da se zaskoci.
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Namesto kartice SIM lahko uporabite tudi kartico USIM, izboljsano razlicico kartice SIM, ki jo podpirajo mobilni telefoni UMTS
(omrezna storitev). Ve€ informacij lahko dobite pri ponudniku storitev.

B Vstavljanje in odstranjevanje pomnilniske kartice

(e imate pomnilnisko kartico, jo vstavljajte v napravo in odstranjujte iz nje skladno z navodili.
Glejte "Pomnilnik", str. 14.

1. Odstranite pokrovek baterije.

2. Pomnilnisko kartico (1) potisnite v rezo (2) do konca, da se zaskoci. Predel s priklju¢ki mora biti obrnjen navzdol.

3. Ponovno namestite pokrov baterije.

4. (e Zelite odstraniti pomnilnisko kartico, odstranite pokrovtek baterije in potisnite kartico v napravo, da sproZite mehanizem
za sprostitev kartice. Nato kartico previdno izvlecite iz naprave.

@ Pomembno: Pomnilnike kartice ne odstranjujte med delovanjem, torej ko naprava uporablja podatke na njej. Ce
jo odstranite med delovanjem, lahko poleg kartice poskodujete tudi napravo in podatke, shranjene na kartici.

B Polnjenje baterije

1. Polnilnik prikljucite v elektri¢no vticnico.

2. Drugi konec prikljucite na spodnjo stran naprave. Ce potrebujete adapter za polnilnik, prikljutite polnilnik na adapter, tega
pa na spodnji del naprave.

3. Napajalni kabel prikljutite na adapter. Kazalnik napolnjenosti baterije na zaslonu se zatne pomikati. Ce je baterija povsem
prazna, utegne trajati nekaj minut, preden se prikaze kazalnik polnjenja. Med polnjenjem lahko napravo uporabljate.

4. Ko se baterija napolni, se kazalnik napolnjenosti ne pomika vel. Polnilnik najprej izkljuCite iz naprave, potem pa Se iz
elektri¢ne vticnice.

Kadar napolnjenost baterije na zadostuje za delovanje naprave, se ta izklopi.

B Vklop naprave
1. Napravo vklopite tako, da pritisnete tipko za vklop/izklop.
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2. (e naprava zahteva kodo PIN (oziroma kodo UPIN, ¢e imate kartico USIM), kodo za zaklepanie ali zastitno kodo, jo vpisite in
izberite OK.

3. Napravo izklopite tako, da pritisnete tipko za vklop/izklop.

:‘é’: Nasvet: Naprava bo ob vklopu morda prepoznala ponudnika kartice SIM in samodejno konfigurirala pravilne nastavitve
za besedilna ter velpredstavnostna sporocila in povezavo GPRS. (e se to ne zgodi, lahko pravilne nastavitve dobite pri
ponudniku storitev ali pa uporabite aplikacijo Nast. Carov..

Kadar kartica SIM ni vstavljena ali je vklju€en profil Brez povezave, lahko napravo uporabljate brez telefonskih oziroma omreznih
funkcij.

B Vnos osnovnih nastavitev

Ko napravo vklopite prvi€ ali potem ko je bila baterija dalj ¢asa odstranjena, morate nastaviti mesto, uro in datum. Nastavitve
lahko pozneje spremenite v meniju Ura.

1. Naseznamu izberite mesto, kjer ste, in OK. Mesto lahko poisCete, tako da zalnete pisati njegovo ime, ali pa se pomaknite do
ustreznega mesta. Pomembno je, da izberete pravo mesto, saj se ob izbiri mesta, ki je v drugem ¢asovnem pasu, lahko
nacrtovani koledarski vpisi spremenijo.

2. Nastavite uro in izberite OK.
3. Nastavite datum in izberite OK.

B Tipke in deli
18— == a1
17— ‘
16| |
15—

(== == =
13 | \:__ﬂ\@@::j/ 4
TEEEE T
12 — h:\llljlﬂlED[‘__ 5
0 %g _lum}“lillqu[_‘;E g
8-@?7 L—>—38
10 9

1 — Tipka za vklop/izklop

2 — Leva izbirna tipka, krmilna palcka in desna izbirna tipka.
3 — Tipka za konec

4 — E-postna tipka

5 — Vratalka

6 — Tipka Enter

7 — Znakovna tipka

8 — Dvigalka

9 — Krmilka (Ctrl)

10 — Preslednica

11 — Modra funkcijska tipka
12 — Telefonska tipkovnica
13 — Tipka Meni

14 —Klicna tipka

15 — Glasovna tipka

16 — Tipki za glasnost

17 — Zvotnik

Copyright © 2006 Nokia. All Rights Reserved. 10



Hitri zatetek

18 — Lucka za obvestanje o e-posti

1 — Zvocnik
2 — Tipki za glasnost
3 — Glasovna tipka

Klju¢ne funkcije
Izbirni tipki
S pritiskom na eno od izbirnih tipk uporabite ukaz, ki je izpisan na zaslonu nad njo. Glejte "Stanji pripravljenosti", str. 13. (e

Zelite zamenjati bliznjice v stanju pripravljenosti, izberite Meni > Orodja > Nastavitve > Telefon > Pripravljenost ter aplikacije v
podmenijih Leva izbirna tipka in Desna izbirna tipka.

Krmilna palcka

Pritisnite krmilno palcko, Ce Zelite kaj urediti ali izbrati. Z njo tudi dostopate do najpogosteje uporabljenih funkcij v razli¢nih
aplikacijah. Skrmilno paltko se lahko pomikate levo, desno, navzgor, navzdol in po zaslonu (na primer med brskanjem po spletu).
V stanju pripravljenosti s pomikanjem ali pritiskom nanjo dostopate do razli¢nih bliznjic. Ce Zelite te bliznjice zamenjati, izberite
Meni > Orodja > Nastavitve > Telefon > Pripravljenost > Aktiv. pripravljenost > Izklju€eno in bliznjice v podmenijih Navigac. tipka
desno, Navigac. tipka levo, Navigac. tipka dol, Navigac. tipka gor in Izbirna tipka.

Klicna tipka in tipka za konec

Klic sprejmete s pritiskom na klicno tipko. V pripravljenosti pritisnite klicno tipko, da odprete Dnevnik.

S pritiskom na tipko za konec zavrnete klice, koncate aktivne in zadrZzane klice ter zaprete aplikacije. Tipko pridrZite, da prekinete
podatkovne povezave (GPRS, podatkovni Klici).

E-postna tipka
S pritiskom na e-postno tipko odprete privzeti e-postni nabiralnik. Ce e niste nastavili e-po3tnega ratuna, se odpre ¢arovnik za

nabiralnik, ki vam bo pri tem v pomot. Ce e-po3tno tipko pridrZite, se odpre privzeti e-postni urejevalnik. Funkcije so odvisne
tudi od vaSega ponudnika e-postne storitve. E-poStno tipko lahko nastavite sami. Glejte "Nastavitev e-poStne tipke", str. 21.

Znakovna tipka

Znakovno tipko pritisnite, Ce Zelite med pisanjem vstaviti znake, ki niso izpisani na tipkah.

(e se Zelite pomikati po seznamu naglasenih ¢rk, pridrzite znakovno tipko in pritisnite drugo tipko, kolikorkrat je potrebno, da
se prikaZe Zelena naglasena Crka.

Dvigalki (tipki Shift)
(e Zelite vstaviti malo ¢rko med velike ali veliko med male ¢rke, pritisnite dvigalko, da se na zaslonu prikaze 4{» in Zeleno tipko.

(e Zelite pisati samo z velikimi ¢rkami, dvakrat pritisnite dvigalko, da se na zaslonu prikaze RBL. (e zelite pisati samo z malimi
Crkami, dvakrat pritisnite dvigalko, da se na zaslonu prikaze abc.

(e Zelite izbrati besedilo, pritisnite dvigalko in potisnite krmilno paltko levo ali desno.
Modra funkcijska tipka
(e Zelite vnesti modro izpisan znak, pritisnite modro funkcijsko tipko, da se na zaslonu prikaZe @, in Zeleno tipko.

(e Zelite vnasati samo znake, ki so na tipkah izpisani modro, dvakrat pritisnite modro funkcijsko tipko, da se na zaslonu prikaze
®J. in tipke z Zelenimi znaki.

Funkcijo Bluetooth vkljucite tako, da hkrati pritisnete modro funkcijsko tipko in tipko Ctrl. Izkljucite jo tako, da znova pritisnete
modro funkcijsko tipko in tipko Ctrl.

InfrardeCi vmesnik vkljuCite tako, da hkrati pritisnete modro funkcijsko in znakovno tipko.

Tipka Meni

(e pustite, da se aplikacije izvajajo v ozadju, se bo izraba baterije povetala, ¢as delovanja baterije pa se bo skrajal. S pritiskanjem
menijske tipke lahko v obeh stanjih pripravljenosti odpirate aplikacije. To tipko pritisnite tudi, Ce se Zelite vrniti v Meni, aplikacijo
pa ohraniti odprto v ozadju. Z daljsim pritiskom odprete seznam aktivnih aplikacij in preklapljate med njimi. V tem priro¢niku
se "izberite Meni" nanaSa na pritisk te tipke.
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Glasovna tipka

S pritiskom te tipke odprete Snemalnik in zatnete snemati zvotno belezko. (e Zelite uporabljati glasovne ukaze, tipko pridrZite.
Glejte "Glasovni ukazi", str. 38.

B Zaklepanje tipkovnice

Stevilko za klice v sili, ki je vprogramirana v napravo, lahko morda poklicete, tudi Ce je tipkovnica zaklenjena.
Zaklepajte tipkovnico in preprecite nenamerne pritiske na tipke naprave.

(e Zelite v pripravljenosti zakleniti tipkovnico, pritisnite levo izbirno tipko (1) in modro funkcijsko tipko | = ‘
(2). Odklenete jo tako, da znova pritisnete levo izbirno tipko in modro funkcijsko tipko. j‘®GD \
M Nasvet: Ce Zelite tipkovnico zakleniti v glavnem meniju (Meni) ali odprti aplikaciji, na kratko CA000000] |
¢< P g ju (Men) ali odprti aplikacij EnREEEEl

pritisnite tipko za vklop/izklop in izberite Zakleni tipkovnico. Odklenete jo tako, da pritisnete PNERNEEE
levo izbirno tipko in modro funkcijsko tipko. )IOC 1000

Napravo lahko v pripravljenosti zaklenete tudi s kodo za zaklepanje. Pritisnite tipko za vklop/izklop,
izberite Zakleni telefon in vnesite kodo za zaklepanje. Privzeta koda za zaklepanje je 12345. Napravo
odklenete tako, da pritisnete levo izbirno tipko, vnesete kodo za zaklepanje in pritisnete krmilno palcko.

W Prikljutki

Opozorilo: Uporaba slusalk lahko vpliva na sposobnost zaznavanja zvokov iz okolice. SluSalk ne uporabljajte, kadar bi
to lahko ogrozilo vaSo varnost.

Prikljucek PopPort™ za slusalke in
drugo dodatno opremo

Prikljucek za polnilnik

Infrardeci vmesnik

B Antene
VaSa naprava ima dve notranji anteni.

Q Opomba: Tako kakor pri vseh drugih radiooddajnih napravah se nobene antene ne dotikajte po nepotrebnem, ko je
naprava vklopljena. Dotikanje antene vpliva na kakovost signalov in lahko povzro€i, da naprava deluje z ve¢jo mocjo,
kot je potrebna sicer. (e se med klicem ne dotikate obmotja antene, to izbolj$a njeno delovanje in podalja ¢as za
telefonske pogovore.
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Slika prikazuje obicajno uporabo naprave ob usesu, na primer med glasovnimi klici.

B Nadzor glasnosti

& Opozorilo: Med uporabo zvocnika naprave ne drzite ob usesu, saj je lahko zelo glasna.

(e Zelite med klicem nastaviti glasnost, pritisnite eno od tipk za glasnost.

(e Zelite nastaviti glasnost, ko je vkljuten zvotnik, pritisnite eno od tipk za glasnost.

B O zaslonu

Na zaslonu se lahko pojavi manjse $tevilo manjkajocih, razbarvanih ali svetlih pik. To je znatilno za to vrsto zaslona. Nekateri
zasloni imajo lahko pike ali tocke, ki ostanejo vkljucene ali izklju¢ene. To je normalno in ne gre za napako.

B Stanji pripravljenosti

VaSa naprava je lahko v dveh stanjih: obi¢ajnem stanju pripravljenosti ali stanju aktivne pripravljenosti.

Stanje aktivne pripravljenosti

Kadar je naprava vklopljena in pripravljena za uporabo, uporabnik pa $e ni niesar izbral ali vpisal, pravimo, da je naprava v
aktivnem stanju pripravljenosti. V tem stanju lahko vidite razlicne informacije, kot sta ponudnik storitev in omrezje, razne znake,
na primer za vklju¢eno budilko, in aplikacije, do katerih Zelite neposredno dostopati. V stanju aktivne pripravljenosti lahko na
primer vidite koledarske informacije, kot so naCrtovani sestanki. Pomaknite se na informacijo in pritisnite krmilno palcko, da
odprete podrobnosti v koledarju.

Da bi izbrali aplikacije, do katerih Zelite dostopati v aktivni pripravljenosti, izberite Meni > Orodja > Nastavitve > Telefon >
Pripravljenost > Aplikacije v priprav.. Pomaknite se do razli¢nih nastavitev bliznjic in pritisnite krmilno palcko. PoisCite Zeleno
aplikacijo in pritisnite krmilno palcko.

V stanju aktivne pripravljenosti lahko vidite sporocila v mapi s prejetimi sporoCili in v telefonskem predalu. Izberite Meni >
Orodja > Nastavitve > Telefon > Pripravljenost in mape v stanju Nabiralnik v aktivni pripravljenosti.

:‘é’: Nasvet: V stanju aktivne pripravljenosti lahko vidite tudi razlitha obvestila, na primer o neodgovorjenih klicih,
neprebranih sporoCilih in sporoCilin v telefonskem predalu. Ta obvestila omogocajo hitro preverjanje
komunikacijskega stanja naprave. Odprite Meni > Orodja > Nastavitve > Telefon > Pripravljenost > VtiCniki v aktivni
pripravljenosti in izberite vti¢nike. Morda ne bodo vedno na voljo isti vti¢niki.

(e Zelite uporabljati osnovno stanje pripravljenosti, izberite Meni > Orodja > Nastavitve > Telefon > Pripravljenost > Aktiv.
pripravljenost > Izklju€eno.

(e Zelite poklicati telefonski predal (omreZna storitev), pridrzite tipko 1.

Pritisnite tipko 0, da bi odprli aplikacijo Storitve in vzpostavili povezavo s spletom.

Stanje pripravljenosti
V tem stanju lahko vidite razli¢ne informacije, kot so ponudnik storitev, ura in razni znaki, na primer za vklju€eno budilko.

V stanju pripravljenosti lahko uporabljate bliZnjice, ki so opisane v nadaljevanju. Te bliZznjice ponavadi niso na voljo v stanju
aktivne pripravljenosti, v katerem se po moznostih pomikate s krmilno pal¢ko.

(e si Zelite ogledati zadnije klicane 3tevilke, pritisnite klicno tipko. Pomaknite se na ime ali stevilko; e jo Zelite poklicati, znova
pritisnite klicno tipko.

(e Zelite poklicati telefonski predal (omreZna storitev), pridrZite tipko 1.
Informacije v koledarju prikaZete tako, da se pomaknete v desno.

(e Zelite napisati besedilno sporoilo in ga poslati, se pomaknite levo.
(e Zelite odpreti imenik, pritisnite krmilno paltko.

Profil zamenjate tako, da na kratko pritisnete tipko za vklop/izklop, se pomaknete na Zeleni profil in ga vklju€ite s pritiskom na
krmilno paltko.
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Pritisnite tipko 0, da bi odprli aplikacijo Storitve in vzpostavili povezavo s spletom.

(e Zelite zamenjati bliZnjice, izberite Meni > Orodja > Nastavitve > Telefon > Pripravljenost.

B Znaki na zaslonu

v Naprava se uporablja v omreZju GSM. Kazalnik ob ikoni oznaluje moc signala mobilnega omreZja na mestu, kjer trenutno

3G Naprava se uporablja v omreZju UMTS (omreZna storitev). Kazalnik ob ikoni oznatuje moc signala mobilnega omreZja na

mestu, kjer trenutno ste. (im visji je stolpec, tem mocnejsi je signal.

[1 Stopnja napolnjenosti baterije. Visji stolpec oznacuje polnejso baterijo.
== V mapi Prejeto v meniju Sporodila je eno ali vet neprebranih sporoCil.
@ V oddaljeni nabiralnik ste prejeli novo e-postno sporocilo.

+—O Tipkovnica naprave je zaklenjena.

#) Naprava je zaklenjena.

4J Imate enega ali ve€ neodgovorjenih klicev.

2 Budilka je vkljutena.

2 Izbrali ste tihi profil, zato vas naprava ne bo zvotno opozorila na dohodne klice ali prejeta sporocila.

3 Funkcija Bluetooth je vkljucena.

mmn[] Vzpostavljena je infrardeCa povezava. (e znak utripa, sku$a naprava povezavo vzpostaviti ali pa se je ta pravkar prekinila.
Na voljo je paketna podatkovna povezava GPRS ali EGPRS.

Vzpostavljena je paketna podatkovna povezava GPRS ali EGPRS.

Paketna podatkovna povezava GPRS ali EGPRS je zadrZzana.

e 1le e

3"3 Na voljo je paketna podatkovna povezava UMTS.

=

f_.f Vzpostavljena je paketna podatkovna povezava UMTS.

.i/f. Paketna podatkovna povezava UMTS je zadrzana.
B8 Napravo ste nastavili za iskanje omreZij WLAN in takSno omreZje je na voljo.
H Vzpostavljena je povezava z omrezjem WLAN, ki ne uporablja Sifriranja.
B Vzpostavljena je povezava z omrezjem WLAN, ki uporablja Sifriranje.
&g Naprava je povezana z osebnim ratunalnikom po podatkovnem kablu USB.
b Vzpostavljen je podatkovni Klic.
IP Prehod IP je dejaven.
1in 2 Oznaluje izbrano telefonsko linijo, €e ste naroceni na dve liniji (omreZna storitev).
A Vsiklici so preusmerjeni na drugo telefonsko Stevilko.
Q Na napravo so prikljucene slusalke.
& Povezava Bluetooth s slusalko je prekinjena.
Za1 Na napravo je priklju¢en komplet za prostorotno uporabo v vozilu.
dD Na napravo je prikljuten komplet za uporabnike slusnih aparatov.
<> Nanapravo je prikljuten Besedilni telefon.
¢ Naprava se sinhronizira.
@3 Vzpostavljena je povezava Pritisni in govori.
fibc, ABC, abc Znaki izbrane velikosti ¢rk.
;A Enkrat ste pritisnili modro funkcijsko tipko, da bi vnesli modro izpisano Stevilko ali znak na tipkovnici.
¥J Dvakrat ste pritisnili modro funkcijsko tipko, da bi vnasali samo modro izpisane Stevilke ali znake na tipkovnici.

4{» Enkrat ste pritisnili dvigalko, da bi vnesli veliko ¢rko med male ali obratno.

B Pomnilnik

Obstajata dve vrsti pomnilnika za shranjevanje podatkov in names€anje aplikacij: pomnilnik naprave in izmenljivi pomnilnik.
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Notranji pomnilnik naprave

V napravi vgrajeni pomnilnik je dinami¢ni pomnilnik, ki si ga delijo Stevilne aplikacije. Koli¢ina notranjega pomnilnika, ki je na
voljo za uporabo, se spreminja, vendar je ni mogoce povecati na ve¢, kakor doloca tovarniska nastavitev. Ta pomnilnik zasedajo
podatki, ki so shranjeni v napravi, na primer aplikacije, slike in glasba.

Izmenljivi pomnilnik

Izmenljivi pomnilnik je medij za shranjevanje podatkov, ki ni vgrajen v napravo, na primer kartica SIM ali pomnilniSka kartica.
Na kartici SIM so shranjene razli¢ne informacije, na primer podatki o0 mobilnem operaterju in imenik. Pomnilniska kartica je
zunanji medij za shranjevanje aplikacij, slik, glasbe, imenika, besedila in drugih vrst podatkov v elektronski obliki. V prodaji so
tudi zelo zmogljive pomnilniske kartice.

Podrobnosti o pomnilniku

Izberite Meni, MoZnosti > Podrobnosti pomnil. in Pomn. telefona ali Pomn. kartica.

Ogledate si lahko koli¢ino pomnilnika v uporabi in prostega pomnilnika ter porabo glede na razli¢ne vrste podatkov. Preverite

lahko na primer, koliko pomnilnika zasedajo e-postna sporoCila, besedilni dokumenti ali sestanki v koledarju.

:\é’: Nasvet: Z rednim brisanjem, prenasanjem na pomnilnisko kartico ali shranjevanjem podatkov v racunalnik poskrbite,
da bo v napravi vedno dovolj prostega pomnilnika.

Pomnilniska kartica

Ta naprava uporablja mini pomnilnisko kartico Secure Digital (SD). misf!i
-

V napravi uporabljajte le zdruzljive pomnilniske kartice miniSD. Druge pomnilniske kartice, na primer obicajne ali
pomanjs$ane kartice MMC ali kartice SD obiCajne velikosti, se ne prilegajo v rezo in niso zdruZljive s to napravo. Uporaba
nezdruZzljive pomnilniSke kartice lahko poleg kartice poSkoduje tudi napravo in na nezdruZljivi kartici shranjene podatke.

Vasa naprava Nokia podpira datote¢na sistema FAT16 in FAT32 za pomnilniske kartice. (e nameravate uporabljati pomnilnisko
kartico iz druge naprave ali Zelite zagotoviti zdruZljivost pomnilniSke kartice s svojo napravo Nokia, boste morda morali kartico
formatirati. Vendar se pri formatiranju trajno zbriSejo vsi podatki na njej.

Formatiranje pomnilnidke kartice

Vsi podatki na pomnilniski kartici se s formatiranjem trajno izgubijo. VpraSajte prodajalca, ali morate pomnilnisko kartico pred
uporabo formatirati. Ce Zelite formatirati pomnilnisko kartico, izberite MoZnosti > Formatiraj kartico. Ko je postopek dokoncan,
vpiSite Zeleno ime za kartico.

Varnostno kopiranje podatkov na pomnilnidko kartico in njihovo obnavljanje v napravo

Podatke v pomnilniku naprave redno varnostno kopirajte na pomnilniko kartico. Pozneje jih lahko obnovite v napravo.
Pomnilniske kartice ne odstranjujte med delovanjem, torej ko naprava uporablja podatke na njej. Ce jo odstranite med
delovanjem, lahko poleg kartice poskodujete tudi napravo in podatke, shranjene nakartici. Ce Zelite varnostno kopijo pomnilnika
naprave shraniti na pomnilnisko kartico, izberite Meni > Orodja > Pomnilniska kartica > MoZnosti > Varnost. kopija tel. Ce Zelite
obnoviti podatke s pomnilniske kartice v pomnilnik naprave, izberite Meni > Orodja > Pomnilniska kartica > MoZnosti > Povrni
s kartice.

Ce pomnilniske kartice ne morete uporabljati v napravi, je kartica morda napatne vrste, ni formatirana za va3o napravo ali pa
je njen datotecni sistem poskodovan.

:\éf: Nasvet: Pomnilnisko kartico lahko vstavite v napravo ali jo iz nje odstranite, ne da bi morali napravo izklopiti ali
odstraniti baterijo.

Zas(ita pomnilniske kartice

Pomnilnisko kartico lahko zas€itite z geslom, da bi preprecili nepooblasten dostop do podatkov na njej. Ce Zelite nastaviti geslo,
izberite MoZnosti > Nastavi geslo. Geslo je lahko dolgo do 8 znakov in je obCutljivo na velikost ¢rk. Shrani se v napravo in vam
ga ni treba znova vnesti, dokler pomnilnisko kartico uporabljate z isto napravo. Geslo morate vnesti, Ce jo uporabite v drugi
napravi. Vse pomnilniske kartice ne podpirajo zas€ite z geslom.

(e Zelite zbrisati geslo za uporabo pomnilniske kartice, izberite Moznosti > Odstrani geslo. Ce odstranite geslo, podatki na
pomnilniski kartici niso zas€iteni pred nepooblas¢eno uporabo.

Odklepanje pomnilnike kartice

Da bi odklenili zaklenjeno pomnilnisko kartico, izberite MoZnosti > Odkleni pom. kartico. VpiSite geslo.

Bl Pomoc in Vadnica

Odgovore na vprasanja lahko najdete tudi, kadar nimate pri sebi prirocnika za uporabo. Naprava namre€ vklju¢uje pomotin
aplikacijo Vadnica.
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Hitri zatetek

Pomo¢ v napravi

Do pomoci lahko dostopate v odprtih aplikacijah ali glavnem meniju (Meni). V odprti aplikaciji izberite MoZnosti > Pomoc, da bi
prebrali navodila za uporabo prikazanih funkcij.

Odprite Meni in izberite Pomo€ > Pomot. V meniju Pomot lahko izberete Zelene kategorije navodil. Pomaknite se do kategorije,
na primer SporoCila, in pritisnite krmilno paltko, da bi videli, katera navodila (teme pomoti) so na voljo. Med branjem teme se
pomaknite levo ali desno, da prikaZete druge teme v kategoriji.

Med branjem navodil pridrzite menijsko tipko, da bi preklapljali med pomo¢jo in aplikacijo v ozadju.

Vadnica

Vadnica vsebuje informacije o napravi in navodila za njeno uporabo. Del vsebine Vadnice je morda shranjen na pomnilniski
kartici. Da bi lahko dostopali do njega, morate kartico vstaviti v napravo.

(e Zelite Vadnico odpreti v meniju, izberite Meni > Pomot, odprite Vadnica in Zeleno poglavje.

Bl Nokia PC Suite

Programski paket Nokia PC Suite lahko namestite s CD-ja ali iz spleta. Programsko opremo Nokia PC Suite lahko uporabljate
samo v operacijskih sistemih Windows 2000 in Windows XP. S programi v paketu lahko varnostno kopirate podatke,
sinhronizirate svojo napravo z zdruzljivim racunalnikom, med njima premikate datoteke ali mobilno napravo uporabljate kot
modem.

B Podpora Nokia in kontaktni podatki

(e Zelite najnovejso razlitico tega prirotnika, dodatne informacije, datoteke za nalaganie in storitve za svoj izdelek Nokia,
obiscite www.nokia.com/support ali krajevno spletno mesto Nokia.

Na spletnem mestu boste nasli informacije o uporabi izdelkov in storitev Nokia. Ce potrebujete podporo sluzbe za pomot
uporabnikom, preverite sezham centrov Nokia na spletni strani www.nokia.com/customerservice.

(e potrebujete vzdrzevalne storitve, poistite najbliZji servisni center Nokia na spletnem naslovu www.nokia.com/repair.
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2. VaSanaprava

Naprava bo ob vklopu morda prepoznala ponudnika kartice SIM in samodejno konfigurirala pravilne nastavitve za besedilna
ter veCpredstavnostna sporocila in povezavo GPRS. Nastavitve lahko dobite tudi od ponudnika storitev v posebnem sporoCilu.

B Meni

Meni je zacetno mesto, kjer lahko odpirate vse aplikacije v napravi ali na pomnilniski kartici. Meni vsebuje aplikacije in mape,
ki so skupine podobnih aplikacij. S krmilno pal¢ko se pomikajte navzgor in navzdol po zaslonu.

Aplikacije, ki jih sami namestite v napravo, se privzeto shranijo v mapo Namestit..
Da bi odprli aplikacijo, se pomaknite nanjo in pritisnite krmilno palcko.

Da bi prikazali seznam aplikacij, izberite MoZnosti > Zamenjaj pogled > Seznam. (e se Zelite vrniti v prikaz mreZe, izberite
Moznosti > Zamenjaj pogled > MrezZa.

Da bi preverili, koliko pomnilnika zasedajo razli¢ne aplikacije in podatki v napravi in na pomnilniski kartici ter koliko ga je $e
na voljo, izberite MoZnosti > Podrobnosti pomnil..

(e Zelite mapo zamenjati, se pomaknite do aplikacije, ki bi jo radi premaknili, in izberite MoZnosti > Premakni. Poleg aplikacije
se pojavi oznaka. Pomaknite se do novega mesta za aplikacijo in izberite OK.

(e Zelite aplikacijo premakniti v drugo mapo, se pomaknite na Zeleno aplikacijo ter izberite MoZnosti > Premakni v mapo, novo
mapo in OK.

(e Zelite naloziti aplikacije iz spleta, izberite MoZnosti > NaloZi aplikacije.
(e Zelite ustvariti novo mapo, izberite MoZnosti > Nova mapa. Znotraj map ne morete ustvarjati novih map.
(e Zelite preimenovati novo mapo, izberite MoZnosti > Preimenuj.

:\é’: Nasvet: Med vec odprtimi aplikacijami preklapljate tako, da pridrzite menijsko tipko. Odpre se okno za preklapljanje,
v katerem so prikazane odprte aplikacije. Pomaknite se na Zeleno aplikacijo in pritisnite krmilno palcko.

B Pomikanje in izbiranje

Zapomikanje in izbiranje uporabite krmilno palcko. S krmilno paltko se lahko pomikate navzgor, navzdol, levo ali desno v meniju
(Meni), po razlitnih aplikacijah ali seznamih. S pritiskom nanjo pa lahko odpirate aplikacije, datoteke ali urejate nastavitve.

(e Zelite izbrati besedilo, pridrzite dvigalko in s pomikanjem v levo ali desno izberite besedilo.

(e Zelite izbrati razli¢ne predmete, kot so sporotila, datoteke ali vizitke, se pomaknite navzgor, navzdol, levo ali desno, da bi
oznacili zeleni predmet. Izberite MoZnosti > Oznai/Opusti > Oznadi, da bi izbrali en predmet, ali MoZnosti > Oznaci/Opusti >
Oznaci vse, da bi izbrali vse predmete.

(e Zelite izbrati predmet v datoteki (na primer prilogo v dokumentu), se pomaknite nanj, da se ob straneh predmeta prikaZejo
oglate oznake.

B Pisanje besedila
Va$a naprava ima celotno tipkovnico. Ve€ina pogostih lo€il ima svojo tipko, druga locila pa lahko vnesete s kombinacijo tipk.
Abc, ABLC in abc 0znacujejo izbrano velikost Crk.

Nekateri znaki, na primer lo€ila in simboli, so na tipkah izpisani modro. Ce Zelite vnesti modro izpisan znak, pritisnite modro
funkcijsko tipko in tipko z Zelenim modrim znakom.

(e Zelite vnesti Stevilko, pritisnite modro funkcijsko tipko, da se na zaslonu prikaze @, in ustrezno tipko s $tevilko na modrem
ozadju. Ce Zelite zakleniti modro funkcijsko tipko in vnasati samo stevilke, tipko dvakrat pritisnite, da se na zaslonu prikaze

o
(e Zelite zbrisati znak, pritisnite vratalko. Z dalj$im pritiskom na vraalko zbri$ete vet znakov hkrati.

Seznam posebnih znakov odprete tako, da pritisnete znakovno tipko. S krmilno pal¢ko se pomikajte po seznamu in izberite
znak.

(e Zelite dodati znak z uporabo drugih tipk, na primer "A" ali "0", pridrZite znakovno tipko in hkrati pritisnite drugo tipko
tolikokrat, kot je potrebno, da se prikaze Zeleni znak.

(e Zelite preklapljati med razli¢nimi velikostmi &rk, pritisnite dvigalko, da se na zaslonu prikaze O
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Va%a naprava

Kopiranje in lepljenje besedila

1. Pridrzite dvigalko, da bi izbrali besede in rke. Hkrati se pomaknite v ustrezni smeri, da bi oznacili Zeleno besedo, skupino
besed ali vrstico. Ko premikate izbiro, s tem oznacujete besedilo.

2. Besedilo kopirate v odlozisCe tako, da pritisnete Ctrl + C. V dokument ga vstavite tako, da pritisnete Ctrl + V.

B Zamenjava jezika pisanja

Pri pisanju besedila lahko zamenjate jezik. Ce med pisanjem vetkrat pritisnete znakovno tipko + a, se prikaZejo razli¢ni znaki.
(e zamenjate jezik pisanja, bodo s to kombinacijo tipk na voljo drugi znaki.

(e na primer pisete sporotilo z nelatinsko abecedo in Zelite z latinskimi ¢rkami dodati prejemnika, izberite MoZnosti > Jezik
pisanja in jezik pisanja, ki uporablja latinske Crke.

B Pogoste funkcije v ve aplikacijah

Naslednje funkcije najdete v ve€ aplikacijah:
Med odprtimi aplikacijami preklapljate tako, da pridrZite menijsko tipko in odprete seznam odprtih aplikacij. Izberite aplikacijo.
(e Zelite zamenjati profil oziroma izklopiti ali zakleniti napravo, na kratko pritisnite tipko za vklop/izklop.

(e Zelite shraniti datoteko, izberite MoZnosti > Shrani. Na voljo so razliéne moZnosti shranjevanja, odvisno od aplikacije, ki jo
uporabljate.

(e Zelite poslati datoteko, izberite MoZnosti > Poslji. Glede na aplikacijo, ki jo uporabljate, so navoljo razlicne moznosti posiljanja,
na primer e-posta ali vecpredstavnostna sporoCila, infrardea povezava ali povezava Bluetooth.

(e Zelite tiskati z zdruZljivim tiskalnikom, izberite MoZznosti > Natisni. Elemente, ki jih Zelite natisniti, si lahko ogledate ali pa
uredite videz natisnjenih strani. Pred tiskanjem napravo poveZzite z zdruzljivim tiskalnikom. Glejte "Tiskanje", str. 65.

Datoteko zbriSete tako, da pritisnete vracalko ali izberete MoZnosti > Zbrisi.
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3.  PrenaSanje vsebine med napravami

Iz zdruZljive naprave znamke Nokia lahko po povezavi Bluetooth ali infrardeli povezavi v napravo Nokia E61 prenasate vsebino,
kot so vizitke imenika. Vrsta vsebine, ki jo lahko kopirate, je odvisna od modela druge naprave. Ce druga naprava podpira
sinhronizacijo, lahko tudi sinhronizirate podatke med njo in napravo Nokia E61.

B Prenos podatkov prek povezave Bluetooth ali infrardeCe povezave

:\éf: Nasvet: (e prenasate podatke iz svoje prej$nje naprave, boste morda morali vstaviti kartico SIM. Nokia E61 za prenos
podatkov ne potrebuje kartice SIM.

Prenos podatkov iz zdruZljive naprave zacnete tako, da izberete Meni > Orodja > Prenos.

Povezovanje prek tehnologije Bluetooth

1. V prikazu podatkov izberite Nadaljuj.

2. Izberite Po povezavi Bluetooth. Izbrano vrsto povezave morata podpirati obe napravi.

3. Vkljucite vmesnik Bluetooth v drugi napravi in v napravi Nokia E61 izberite Nadaljuj, da zalnete iskanje naprav s podporo za
Bluetooth.

4. Ko Nokia E61 najde drugo napravo, izberite Ustavi.

5. Naseznamu izberite drugo napravo. Nokia E61 zahteva, da vpiSete geslo (1 do 16 Stevilk). Za potrditev te povezave je treba
geslo uporabiti le enkrat.

6. VpiSite geslo v napravo Nokia E61 in izberite OK. VpiSite geslo v drugo napravo in izberite OK. Napravi sta tako seznanjeni.
Glejte "Seznanjanje naprav"”, str. 49.

Pri nekaterih modelih telefonov se aplikacija Prenesi podatke poslje drugi napravi v sporotilu. Ce Zelite aplikacijo Prenesi
podatke namestiti v drugo napravo, odprite sporocilo in se ravnajte po navodilih na zaslonu.

7. V napravi Nokia E61 izberite vsebino, ki jo Zelite prenesti iz druge naprave, in moznost OK.
Infrarde€a povezava

1. V prikazu podatkov izberite Nadaljuj.

2. lzberite Po infrardedi povezavi. Izbrano vrsto povezave morata podpirati obe napravi.

3. Povezite obe napravi. Glejte "Infrardeci vmesnik®, str. 50.

4. V napravi Nokia E61 izberite vsebino, ki jo Zelite prenesti iz druge naprave, in moznost OK.

Vsebina se iz pomnilnika druge naprave kopira na ustrezno mesto v vasi napravi. Cas kopiranja je odvisen od koli¢ine podatkov.
Postopek lahko prekinete in ga nadaljujete pozneje.

Postopek prenaSanja podatkov morda ne bo vedno enak; to je med drugim odvisno tudi od tega, ali ste prekinili prejsnji prenos
podatkov. RazpoloZljivost predmetov za prenos je odvisna od druge naprave.

B Sinhronizacija podatkov z drugo napravo

(e ste v napravo Nokia E61 7e prenasali podatke, druga naprava pa podpira sinhronizacijo, lahko z aplikacijo Prenos usklajujete
podatke v obeh napravah.

1. Izberite Telefoni in pritisnite krmilno palcko.
2. PoisCite napravo, iz katere Zelite prenesti podatke, in pritisnite krmilno palcko.

3. Izberite Sinhroniziraj in pritisnite krmilno paltko. Napravi se zaCneta sinhronizirati prek vrste povezave, ki ste jo izbrali pri
prvem prenosu podatkov. Sinhronizirajo se samo podatki, ki ste jih takrat izbrali za prenos.

(e Zelite spremeniti nastavitve prenosa in sinhronizacije podatkov, izberite Sinhroniziraj, pomaknite se na napravo, pritisnite
krmilno paltko in izberite Uredi.
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4.  Sporocila

Izberite Meni > Sporodila.

Pred prejemanjem in posiljanjem sporocil boste morda morali poskrbeti za naslednje:

+ Biti morate v dosegu signala mobilnega omreZja, v napravi pa mora biti vstavljena veljavna kartica SIM.

- Preverite, ali omreZje podpira sporo€ilne funkcije, ki jih Zelite uporabljati, in ali so vklju€ene na kartici SIM.
* V napravi doloCite nastavitve internetne dostopne tocke (IAP). Glejte "Dostopne tocke", str. 85.

 V napravi doloCite nastavitve e-poStnega raCuna. Glejte "Nastavitve e-postnega rauna”, str. 23.
* Vnapravi doloCite nastavitve sporoCil SMS. Glejte "Nastavitve besedilnih sporodil”, str. 25.

 V napravi doloCite nastavitve sporocil MMS. Glejte "Nastavitve vecpredstavnostnih sporocil”, str. 28.

Vasa naprava lahko prepozna ponudnika kartice SIM in samodejno konfigurira nekatere nastavitve sporotil. Ce se to ne zgodi,
boste nastavitve morda morali nastaviti ro¢no ali pa se obrniti na ponudnika storitev, mobilnega operaterja ali ponudnika
dostopa do interneta.

Aplikacija Sporotila prikazuje mape z vsemi vrstami sporo€il v obliki seznama; v vsaki mapi je najnovejse sporotilo prikazano
prvo.

Izberite med naslednjimi moznostmi:

+ Novo sporotilo — Ustvarite in posljite besedilno, veCpredstavnostno ali e-postno sporoCilo.
* Prejeto — Preglejte prejeta sporoCila, razen e-poste in sporocil v celici.

» Moje mape — Ustvarite lastne mape za shranjevanje sporoCil in predlog.

« Nabiralnik — Preglejte prejeta e-postna sporotila in odgovorite nanje.

+ Osnutki — Shranite neodposlana sporoCila.

 Poslano — V to mapo se shranjujejo poslana sporocila.

« V posiljanju — Preglejte sporoCila, ki ¢akajo na posiljanje.

« Povratnice — Preglejte informacije o dostavi poslanih sporocil.

B RazvriCanje sporodil
(e Zelite ustvariti novo mapo za razvr$tanje sporofil, izberite Moje mape > MoZnosti > Nova mapa. Vnesite ime mape in izberite

OK.

(e Zelite preimenovati mapo, jo izberite in MoZnosti > Preimenuj mapo. Vnesite novo ime mape in izberite OK. Preimenujete
lahko le mape, ki ste jih ustvarili sami.

(e Zelite premakniti sporotilo v drugo mapo, odprite sporofilo in izberite MoZnosti > Premakni v mapo, mapo in OK.

(e Zelite razvrstiti sporotila v dolotenem vrstnem redu, izberite MoZnosti > Razvrsti po. Razvrstite jih lahko po Datumu,
Posiljatelju, Zadevi ali Vrsti sporoCila.

(e Zelite prikazati lastnosti sporotila, izberite sporotilo in MoZnosti > Podrabn. sporofila.

B Iskanje sporo(il
(e Zelite poiskati sporotilo, odprite Zeleno mapo in izberite MoZnosti > Poisti. Vnesite iskalni niz in izberite OK.

B Nastavitve za sporoCila

Izberite MoZnosti > Nastavitve.

(e Zelite dolotiti ali urediti nastavitve za razli¢ne vrste sporofil, izberite Besedilno sporocilo, Vetpredst. sporocilo, E-posta,
Obvestilo storitve, SporoCila v celici ali Drugo.

Glejte "Nastavitve besedilnih sporodil", str. 25.

Glejte "Nastavitve ve¢predstavnostnih sporocil", str. 28.

Glejte "Nastavitve e-postnega racuna"”, str. 23.

Druge nastavitve
Izberite Meni > Sporocila > MozZnosti > Nastavitve > Drugo.
Izberite med temi moZnostmi:

+ Shrani poslana spor. — Izberite, ali naj se poslana sporotila shranijo v mapo Poslano.

« St. shranjenih spor. — Vnesite $tevilo poslanih sporotil, ki jih Zelite shraniti. Ko doseZete omejitev, se zbri$e najstarejse
sporocilo.

 Pogled map — Izberite, ali naj bodo seznami sporocil v mapah prikazani v eni ali dveh vrsticah.

Copyright © 2006 Nokia. All Rights Reserved. 20



Sporotila

+ Uporabljeni pomnilnik — Izberite, kam naj se shranijo prejeta sporotila. Sporocila se lahko shranijo na pomnilnisko kartico
samo, Ce je ta vstavljena.

Morda ne bo vedno mogoce urediti istih nastavitev.

B Nastavitve centra za besedilna sporocila

Izberite MoZnosti > Nastavitve > Besedilno sporoCilo > Centri za sporocila.

(e Zelite urejati centre za sporofila, izberite Zeleni center in MoZnosti > Uredi.

(e Zelite dodati nov center za sporoila, izberite MoZnosti > Nov center za spor..
(e Zelite zbrisati centre za sporofila, izberite neZeleni center in pritisnite vratalko.

B E-postna sporoCila

(e Zelite prejemati in posiljati posto, morate biti naro¢eni na storitev oddaljenega nabiralnika. Uporabite storitev ponudnika
dostopa do interneta, mobilnega operaterja ali podjetja, v katerem ste zaposleni. Vada naprava je zdruZljiva z internetnimi
standardi IMAP4 (prva razliica) in POP3 ter razlicnimi reSitvami za uporabo potisne e-poste. Storitve raznih ponudnikov e-poste
imajo morda drugacne nastavitve ali funkcije od tistih, ki so opisane v tem priro¢niku.

Pred posiljanjem, prejemanjem, nalaganjem, odgovarjanjem in posredovanjem poste z napravo morate poskrbeti za naslednje:
« Nastavite internetno dostopno tocko (IAP). Glejte "Dostopne tocke", str. 85.

 Nastavite e-postni ra€un in pravilno dolocite e-postne nastavitve. Glejte "Nastavitve e-postnega rauna”, str. 23.

UpoStevajte navodila, ki ste jih dobili od ponudnika poStnega nabiralnika in dostopa do interneta. Pravilne nastavitve dobite
pri mobilnem operaterju ali ponudniku internetnih storitev.

Nastavitev e-po3tnega ratuna

(e izberete Nabiralnik in $e niste ustvarili e-potnega ratuna, bo naprava to zahtevala. Izberite Da, da zatnete z vodnikom za
nabiralnik nastavljati e-postni racun.

1. Izberite Zacni, Ce Zelite vpisati e-poStne nastavitve.
2. V nastavitvi Vrsta nabiralnika izberite IMAP4 ali POP3 in Naprej.

:‘é’: Nasvet: POP3 je razliCica poStnega protokola, ki se uporablja za shranjevanje in prenasanje e-poste ali internetnih
postnih sporoCil. IMAP4 je razliCica protokola dostopa do internetnih sporocil, ki omogoca dostop do in urejanje e-
postnih sporoCil, shranjenih v e-pos$tnem strezniku. Nato lahko izberete, katera sporocila Zelite naloZiti v napravo.

3. Vnesite e-postni naslov v polje Moj e-po3tni naslov. Izberite Naprej.
4. V polje Strez. za prej. poste vnesite ime oddaljenega streznika, ki prejema vaso e-posto, in izberite Naprej.

5. Vpolje StreZ.za po8. poste vnesite ime oddaljenega streznika, ki poSilja vaSo e-posto, in izberite Naprej. Morda boste namesto
streznika ponudnika e-poSte morali uporabiti operaterjev streZnik za poSiljanje poste, kar je odvisno od slednjega.

6. V nastavitvi Dostopna totka izberite dostopno totko, ki naj jo naprava uporabi pri nalaganju e-poste. Ce izberete Vedno
vpra$aj, boste morali dostopno tocko izbrati pred vsakim nalaganjem, e izberete tocko, pa se bo naprava povezovala
samodejno. Izberite Naprej.

;\é’: Nasvet: Ce izberete Izberi skupino, naprava samodejno vzpostavi povezavo prek najboljse razpoloZljive internetne
dostopne tocke v skupini. Izberite skupino dostopnih tock in Nazaj, da nastavitev shranite.
7. Poimenujte novi nabiralnik in izberite Kon€ano.
Ko ustvarite nov nabiralnik, izbrano ime samodejno zamenja Nabiralnik v glavnem prikazu Sporo(ila.
Izbira privzetega nabiralnika

(e imate nastavljenih vet nabiralnikov, lahko enega od njih nastavite za privzetega. Ce Zelite doloiti privzeti nabiralnik, izberite
MoZnosti > Nastavitve > E-poSta > Upor. nabiralnik in nabiralnik.

(e ste dolofili vet nabiralnikov, izberite tistega, ki ga Zelite uporabiti vsaki¢, ko zatnete sestavljati novo e-postno sporotilo.

Nastavitev e-po3tne tipke

VaSa napravaimae-postno tipko. Z njo lahko dostopate do privzetega e-poStnega nabiralnika ali v aktivni pripravljenosti odprete
privzeti e-postni urejevalnik. Funkcije so odvisne tudi od vaSega ponudnika e-poStne storitve.

(e Zelite nastaviti e-postno tipko, izberite Meni > Orodja > E-po3. tipka. |zberite e-postni ratun, ki ga Zelite uporabljati s tipko.

Povezovanje z nabiralnikom

E-posta, ki je naslovljena na vas, se poSlje oddaljenemu nabiralniku in je vaSa naprava ne prejme samodejno. Preberete jo lahko
Sele, ko se povezete z nabiralnikom in izberete e-postna sporoCila, ki jih Zelite prenesti v napravo. Ce Zelite prejemati in posiljati

Copyright © 2006 Nokia. All Rights Reserved. 21



Sporotila

e-postna sporocila, morate biti naroceni na e-postno storitev. Da bi v napravi ustvarili e-postni ratun, izberite Sporocila >
MoZnosti > Nastavitve > E-posta > MoZnosti > Nov nabiralnik. Pravilne nastavitve lahko dobite pri svojem ponudniku storitev.

(e Zelite naloZiti prejeto e-posto v napravo in jo pregledati brez povezave, v glavnem prikazu Sporofila izberite nabiralnik. Ko
naprava vpraSa Se poveZem z nabiralnikom?, izberite Da.

Izberite mapo in pritisnite krmilno paltko, da bi videli e-postna sporocila v mapi. Nato se pomaknite na sporoCilo in pritisnite
krmilno paltko.

(e Zelite v napravo naloZiti e-po$tna sporofila, izberite MoZznosti > NaloZi e-posto > Novo za sporofila, ki jih 3e niste niti prebrali
niti naloZili, Izbrano, da naloZite samo sporoCila, ki ste jih izbrali v oddaljenem nabiralniku, ali Vse, da naloZite vsa sporocila, ki
e niso bila naloZzena v napravo.

Povezavo z oddaljenim nabiralnikom prekinete tako, da izberete MoZnosti > Prekini.

Pregledovanje e-po3te brez povezave

Delo brez povezave pomeni, da naprava ni povezana z oddaljenim nabiralnikom. Z upravljanjem e-poste brez povezave lahko
prihranite pri strodkih povezave in delate v razmerah, ki ne omogotajo podatkovnih povezav. Ce spremenite mape v oddaljenem
nabiralniku, ko niste na zvezi, se spremembe upostevajo naslednji¢, ko vzpostavite povezavo in sinhronizirate podatke. Ce
zbriSete e-postno sporodilo iz naprave, ko niste na zvezi, se to zbriSe iz oddaljenega nabiralnika ob naslednji povezavi z njim.

1. Izberite SporoCila > MoZnosti > Nastavitve > E-posta. Izberite e-postni raCun in pritisnite krmilno palcko. Izberite Nastavitve
nalaganja > NaloZi e-po3to > Sporoc. in priloge, Ce Zelite v napravo naloziti cela e-postna sporocila, s prilogami vred.

2. Odprite nabiralnik in izberite Moznosti > NaloZi e-posto. Izberite Novo za nova sporoCila, ki jih e niste niti prebrali niti naloZili,
Izbrano, da naloZite samo sporoCila, ki ste jih izbrali v oddaljenem nabiralniku, ali Vse, da naloZite vsa sporoCila, ki Se niso
bila nalozena v napravo. Naprava vzpostavi povezavo z nabiralnikom in nalozi sporocila.

3. (e se Zelite potem vrniti v natin brez povezave, izberite Moznosti > Prekini.
4. E-postno sporoCilo prikaZete tako, da se pomaknete nanj in pritisnete krmilno palcko.
Pri nekaterih moZnostih se morate povezati z oddaljenim nabiralnikom.

:\é/: Nasvet: Druge mape v oddaljenem nabiralniku lahko naro€ite, Ce izberete E-po$tne nastavitve > Nastavitve
nalaganja > Naroene mape. E-posta v narofenih mapah se posodobi ob vsakem nalaganju e-poste iz oddaljenega
nabiralnika.

Lu€ka za obvestanje o e-posti
Lucko na pokrovcku naprave lahko nastavite tako, da ob prejemu novega e-postnega sporo€ila utripa.

Izberite Meni > Sporocila > MoZnosti > Nastavitve > E-posta. V nastavitvi Nastavitve lutke dolo€ite, ali naj lu¢ka utripa in kako
dolgo.

Branje e-poste in odgovarjanje

G Pomembno: E-poStna sporotila lahko vsebujejo viruse ali so drugace 3kodljiva za vaso napravo ali racunalnik. Prilog
ne odpirajte, e posiljatelju ne zaupate.

Prejeto e-postno sporocilo lahko preberete, e se pomaknete nanj in pritisnete krmilno palcko.

Da bi poiskali e-postno sporocilo v nabiralniku, izberite MoZnosti > Poi(i. Vnesite iskalni niz in izberite OK.

(e Zelite odpreti prilogo, izberite MoZnosti > Priloge. Pomaknite se na prilogo in pritisnite krmilno paltko.

(e Zelite odgovoriti samo posiljatelju e-postnega sporotila, odprite sporotilo in izberite MoZnosti > Odgovori > Posiljatelju.

(e Zelite odgovoriti vsem prejemnikom e-po$tnega sporoila, odprite sporoilo in izberite MoZnosti > Odgovori > Vsem.

;\é’: Nasvet: (e odgov\_/orite na e-poétno sporgf_ilo, ki somu priloZene datoteke, se priloge ne vkljutijo v odgovor. (e prejeto
e-poStno sporocilo posredujete, se posljejo tudi priloge.

(e Zelite zbrisati prilogo iz e-poste, ki jo posiljate, izberite prilogo in MoZnosti > Priloge > Odstrani.

(e Zelite nastaviti prednost sporoila, izberite eno od moZnosti na meniju MoZnosti > Pomembnost.

(e Zelite poklicati posiljatelja e-postnega sporotila, sporotilo odprite in izberite MoZnosti > Poklii.

(e Zelite odgovoriti posiljatelju e-podtnega sporotila z besedilnim ali ve¢predstavnostnim sporotilom, odprite prejeto sporotilo
in izberite MoZnosti > Ustvari sporocilo.

(e Zelite posredovati e-posto, odprite sporocilo in izberite MoZnosti > Posreduj.
Brisanje sporoil

Redno brisite sporocila v mapah Prejeto in Poslano ter naloZeno e-posto; tako boste sprostili prostor v pomnilniku naprave.
(e Zelite zbrisati sporotilo, se pomaknite nanj in pritisnite vratalko.
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Zbrisete lahko lokalna e-poStna sporodila v napravi, izvirna pa ohranite v strezniku, ali zbriSete lokalna sporocila v napravi in
izvirnike v strezniku.

(e Zelite zbrisati samo e-postna sporotila v napravi, izberite Moznosti > Zbrisi > Samo telefona.

(e Zelite zbrisati e-postno sporofilo iz naprave in oddaljenega streZnika, sporotilo odprite in izberite MoZznosti > Zbrisi > Telef.
in streznika.

E-poStne mape
(e ste v oddaljenem strezniku IMAP4 ustvarili podmape, si jih lahko v napravi ogledate in upravljate. Naroite lahko samo mape
v nabiralnikih IMAP4. Narotene mape v oddaljenem nabiralniku lahko pregledujete v svoji napravi.

(e si Zelite ogledati mape v svojem nabiralniku IMAP4, vzpostavite povezavo in izberite MoZnosti > E-po3tne nas. > Nastavitve
nalaganja > Narofene mape.

(e si 7elite ogledati oddaljeno mapo, izberite mapo in MoZnosti > Vkljuti narotnino. Ob vsaki vzpostavitvi povezave se narotene
mape posodobijo. Postopek lahko traja precej Casa, ¢e so mape obsezne.

(e Zelite posodobiti seznam map, izberite mapo in Moznosti > Posodobi sezn. map.
Pisanje in posiljanje e-poste

(e Zelite napisati e-posto, izberite MoZnosti > Dodaj prejemnika, da bi poiskali e-po3tne naslove v imeniku, ali pa jih vpisite v
polje Za. Posamezne prejemnike lotite s podpi¢jem. Pomaknite se navzdol in v polje Kopija vnesite prejemnike kopije sporoCila,
v polje Skr. kop. pa prejemnike slepe kopije. V polje Zadeva vtipkajte zadevo sporoCila. Vnesite sporocilo v besedilno polje in
izberite MoZnosti > Poslji.

Ce zelite e-posti priloZiti datoteko, izberite MoZnosti > Vstavi in Zeleno datoteko. PriloZite lahko slike, zvotne posnetke, belezke
in druge datoteke, na primer pisarniske dokumente.

(as posiljanja e-postnega sporotila nastavite tako, da izberete Moznosti > MoZnosti posiljanja > Polji sporocilo. Izberite
Takoj ali Ob naslednji pov., ¢e e-posto uporabljate brez povezave.

E-postna sporotila se pred posiljanjem shranijo v mapo V posiljanju. Ce e-postnega sporotila ne posljete takoj, lahko odprete
mapo V posiljanju in posiljanje sporotila preloZite ali nadaljujete ali pa sporocilo odprete.

Nastavitve e-postnega rauna

Izberite Meni > Sporocila > Nabiralnik.
Morda ne bo vedno mogoce urediti istih nastavitev. Nekatere nastavitve je morda dolocil Ze ponudnik storitev.

(e Zelite urediti nastavitve nabiralnika, vendar e niste nastavili e-postnega rauna, se odpre vodnik za uporabo nabiralnika in
vam pomaga nastaviti e-postni racun.

Nastavitve za prejeto e-posto
Izberite Dohodna e-posta in eno od naslednjih nastavitev:

+ Uporabnisko ime — Vnesite uporabnisko ime za e-postno storitev.

+ Geslo — Vnesite geslo za e-poStno storitev.

« StreZ. za prej. poSte — Vnesite naslov IP ali ime streZnika, ki prejema vaSo e-posto.

« Upor. dostopna totka — Izberite internetno dostopno tocko, ki jo naprava uporablja za nalaganje prejetih e-postnih sporodil.

* Privzeti nabiralnik — Vnesite ime za nabiralnik.

« Vrsta nabiralnika — Izberite protokol, ki ga priporoca vas ponudnik oddaljenega postnega nabiralnika. Moznosti sta POP3 in
IMAP4. To nastavitev lahko dolotite le enkrat; ko je shranjena, je ne morete vet spremeniti. (e uporabljate protokol POP3, se
e-postna sporocila ob povezavi ne posodabljajo samodejno. (e Zelite videti nova e-postna sporo€ila, morate povezavo z
nabiralnikom prekiniti in jo znova vzpostaviti.

« Varnost (vrata) — Izberite varnostno moznost za zasCito povezave.

+ Vrata — DoloCite vrata za povezavo.

« APOP zasit. prijava (samo za POP3) — To moZnost uporabljajte s protokolom POP3 za Sifriranje gesel, ki jih naprava med
povezavo z nabiralnikom poSilja oddaljenemu e-poStnemu strezniku.

Nastavitve za poslano e-po3to
Izberite Odhodna e-pota in eno od naslednjih nastavitev:

 Moj e-postni naslov — Vpisite e-postni naslov, ki ste ga dobili pri ponudniku storitev. Odgovori na vasa sporocila bodo poslani
na ta naslov.

» Uporabnisko ime — Vnesite uporabnisko ime za e-poStno storitev.

» Geslo — Vnesite geslo za e-postno storitev.

+ StreZ. za pos. poSte — VpiSite naslov IP ali ime streznika, ki poSilja vaSo e-poSto. Morda boste lahko uporabljali le operaterjev
streznik za posiljanje e-poste. VeC informacij lahko dobite pri ponudniku storitev.

« Upor. dostopna totka — Izberite internetno dostopno tocko, ki jo naprava uporablja za posiljanje vasih e-postnih sporoCil.
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+ Varnost (vrata) — Izberite varnostno moznost za zasCito povezave z oddaljenim nabiralnikom.
- Vrata — Dolocite vrata za povezavo.

Uporabniske nastavitve

Izberite Uporabn. nastavitve in eno od naslednjih nastavitev:

+ Moje ime — Vnesite ime, ki naj se v poslani e-posti pojavi pred vasim naslovom.

+ Naslov za odgovor — Izberite, ali naj se odgovori preusmerijo na drug naslov. Izberite Vklju€eno in vnesite e-postni naslov,
na katerega zelite preusmeriti odgovore. Vnesete lahko samo en naslov.

« Zbrisi e-posto iz — Izberite, ali naj se e-postna sporoila zbrisejo samo iz naprave ali iz naprave in streznika. I1zberite Vedno
vprasaj, Ce Zelite to izbrati posebej ob vsakem brisanju sporoCil.

« Poslji sporoCilo — Izberete lahko, da se e-posta poslje ¢im prej, da se poslje ob naslednjem prejemanju ali da se shrani v
mapo V poSiljanju, od koder jo lahko posljete pozneje.

« Posdlji kopijo sebi — Izberite, e Zelite kopijo e-postnega sporotila poslati v oddaljeni nabiralnik in na naslov, dolocen v polju
Moj e-postni naslov nastavitev Odhodna e-posta.

+ Podpisi — Izberite, Ce Zelite poslanim e-poStnim sporotilom dodati podpis.

+ Op. na novo e-posto — Izberite, Ce Zelite, da vas naprava na novo e-posto v nabiralniku opozori s predvajanjem tona in
obvestilom.

« Utrip. ob novi e-po&ti — Izberite, ali naj ob prejemu novih sporocil utripa lutka za obvestanje o e-posti in kako dolgo.

Nastavitve nalaganja

Izberite Nastavitve nalaganja in eno od naslednjih nastavitev:

+ NaloZi e-posto (samo za nabiralnike POP3) — Izberite, ali Zelite naloZiti le glave e-postnih sporoCil (te vsebujejo podatke, kot
so posiljatelj, zadeva in datum), e-postna sporocila ali e-postna sporocila in priloge.

« Kolitina — Izberite Stevilo e-postnih sporoCil, ki jih Zelite prenesti iz oddaljenega streznika v napravo.

+ Pot map IMAP4 (samo za nabiralnike IMAP4) — Dolotite poti do map, ki jih Zelite naroCiti.

« Narotene mape (samo za nabiralnike IMAP4) — NaroCite $e druge mape v oddaljenem nabiralniku in naloZite njihovo vsebino.

Nastavitve samodejnega nalaganja

Izberite Samodej. nalaganje in eno od naslednjih nastavitev:

« Obvestila o e-posti — Izberite, Ce Zelite prejeti obvestilo ob prejemu nove e-poste v oddaljeni nabiralnik. Izberite Vedno
omogoceno, Ce Zelite, da se vsa nova e-poStna sporotila samodejno naloZijo iz oddaljenega nabiralnika, ali Samo v dom.
om,, Ce Zelite, da se e-postna sporotila iz oddaljenega nabiralnika samodejno naloZijo samo v domafem omreZzju in ne, ko
ste na primer v tujini.

« Dnevi vzpost. zveze — Izberite, ob katerih dneh naj se e-postna sporotila naloZijo v napravo.

« Ure vzpostav. zveze — DoloCite uro za nalaganje e-postnih sporocil.

« Interval vzp. zveze — Doloite Casovni razmik med preverjanji novih e-postnih sporoCil.

B Besedilna sporoCila

Ta naprava podpira poSiljanje besedilnih sporocil, daljsih od obitajne omejitve za eno sporocilo. Dalj$a sporo€ila so poslana kot
niz dveh ali ve€ sporoil. Ponudnik storitev lahko to ustrezno zaracuna. Znaki z naglasi ali drugimi znamenji in znaki nekaterih
jezikov, na primer kitajski, lahko zasedejo vec prostora, zaradi Cesar lahko v enem sporocilu posljete manj znakov kakor sicer.

Kazalnik dolZine sporocilav navigacijski vrstici odsteva od 160. 10 (2) na primer pomeni, da lahko dodate Se 10 znakov in besedilo
posljete v dveh sporodilih.

Pisanje in posiljanje besedilnih sporoCil
Izberite Meni > Sporocila > Novo sporotilo > Besedilno sporodilo.

1. V polju Za pritisnite krmilno palcko in izberite prejemnike iz menija Imenik ali pa rono vpisite njihove mobilne telefonske
Stevilke. Ce vpisete vel stevilk, jih locite s podpicjem.

2. Napisite besedilo sporotila. Ce Zelite uporabiti predlogo, izberite MoZnosti > Vstavi > Predloga.
3. lzberite Moznosti > Poslji, da bi poslali sporotilo.

MoZnosti posiljanja besedilnih sporoil

(e Zelite izbrati moZnosti posiljanja za besedilno sporotilo, izberite MoZnosti > MoZnosti posiljanja.
Dolocite naslednje:

« Uporabljeni center — Izberite center za posiljanje sporoCila.

« Kodiranje znakov — Izberite Omejena podpora, da se, Ce je to mogo(e, uporabi samodejno pretvarjanje znakov v drug kodirni
sistem.

+ Povratnica — Izberite Da, Ce Zelite, da vam omreZje poslje obvestila o dostavi poslanih sporotil (omrezZna storitev).
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« Veljavnost sporotila— Izberite, kako dolgo naj center za sporoCila skusa poslati sporo€ilo, ¢e prvi poskus ne uspe (omrezna
storitev). Ce prejemnik sporofila ni dosegljiv v ¢asu veljavnosti sporofila, se sporotilo odstrani iz centra.

« Sporo€. poslano kot — SporoCilo pretvorite v drugo obliko zapisa, na primer Besedilo, Faks, Pozivnik ali E-posta. To moZnost
spremenite samo, Ce ste prepritani, da vas center za sporocila podpira pretvorbo besedilnih sporodil v druge zapise. Obrnite
se na mobilnega operaterja.

 0Odg.prekistegac.—Tomoznost izberite, €e Zelite, da prejemnik sporocila poslje odgovor prekiste Stevilke centraza besedilna
sporocila (omreZna storitev).

Odgovarjanje na prejeta besedilna sporo€ila

(e Zelite odgovoriti na besedilno sporotilo, ga odprite v mapi Prejeto. Izberite Moznosti > Odgovori. Napisite besedilo sporotila
in izberite MoZnosti > Polji.

(e Zelite poklicati posiljatelja besedilnega sporotila, odprite sporotilo v mapi Prejeto in izberite Moznosti > Poklii.

Besedilna sporocila na kartici SIM

Besedilna sporoCila lahko shranite na kartico SIM. Sporocila na kartici SIM morate prekopirati v mapo v napravi, da bi jih lahko
pregledali. Potem jih lahko pregledate v mapi, v katero ste jih kopirali, ali jih zbriSete s kartice SIM.

Izberite MoZnosti > Sporotila na SIM.

1. Izberite MoZnosti > Oznadi/Opusti > Ozna(i ali Oznadi vse, da bi oznadili vsa sporoCila.

2. Izberite Moznosti > Kopiraj.

3. Izberite mapo in OK, da bi zaCeli kopiranje.

(e Zelite pregledati sporofila s kartice SIM, odprite mapo, v katero ste jih kopirali, in Zeleno sporoilo.

(e Zelite zbrisati besedilno sporofilo s kartice SIM, ga izberite in pritisnite vratalko.

Nastavitve besedilnih sporocil

Izberite MoZnosti > Nastavitve > Besed. spor..
DoloCite naslednje:

« Centri za sporo€ila — Oglejte si razpoloZljive centre za sporoCila v napravi.

« Uporabljeni center — Izberite center za posiljanje sporoCila.

+ Kodiranje znakov — Izberite Omejena podpora, da se, Ce je to mogote, uporabi samodejno pretvarjanje znakov v drug kodirni
sistem.

 Povratnica — Izberite Da, Ce Zelite, da vam omrezje poslje obvestila o dostavi poslanih sporocil (omreZna storitev).

« Veljavnost sporoCila — Izberite, kako dolgo naj center za sporotila skusa poslati sporoCilo, ¢e prvi poskus ne uspe (omrezna
storitev). Ce prejemnik sporofila ni dosegljiv v ¢asu veljavnosti sporofila, se sporotilo odstrani iz centra.

« Sporot. poslano kot — SporoCilo pretvorite v drugo obliko zapisa, na primer Besedilo, Faks, Pozivnik ali E-posta. To moZnost
spremenite samo, Ce ste preprifani, da vas center za sporocila podpira pretvorbo besedilnih sporocil v druge zapise. Obrnite
se na mobilnega operaterja.

+ Prednostna povez. — Izberite prednostni nain povezovanja pri posiljanju besedilnih sporoCil iz naprave.

 Odg.prekistegac.—Tomoznost izberite, €e Zelite, da prejemnik sporocila poslje odgovor prekiste Stevilke centraza besedilna
sporocila (omreZna storitev).

Slikovna sporocila

Q Opomba: Funkcijo slikovnega sporotanja lahko uporabljate le, €e jo omogoca vas omrezni operater ali ponudnik
storitev. Slikovna sporocila lahko sprejmejo in prikazejo le naprave, ki omogocajo delo s slikovnimi sporocili.

Izberite Meni > Sporodila.

(e Zelite prikazati slikovno sporotilo, ga odprite v mapi Prejeto.

Izberite MoZnosti in eno od naslednjih moznosti:

« Podrobn. sporocila — PrikaZite informacije o sporocilu.

* Premakni v mapo — Sporotilo shranite v drugo mapo.

+ Dodaj v Imenik — Stevilko posiljatelja dodajte v imenik.

« PoisCi — Poiscite telefonske Stevilke in naslove, ki jih sporoilo morda vsebuije.

Posredovanije slikovnih sporodil

Zaradi za3Cite avtorskih pravic morda ne boste mogli kopirati, spreminjati, prenasati ali posredovati nekaterih slik, skladb
(vklju¢no s toni zvonjenja) in druge vsebine.

1. Odprite slikovno sporotilo v mapi Prejeto in izberite MoZnosti > Posreduj.
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2. Vnesite telefonsko $tevilko prejemnika v polje Za ali pritisnite krmilno paltko, da bi jo poiskali v meniju Imenik. Ce vpisete
vec Stevilk, jih loCite s podpic¢jem.

3. Napisite vsebino sporotila. Sporotilo ima lahko najvet 120 znakov. (e Zelite uporabiti predlogo, izberite MoZnosti > Vstavi >
Predloga.

Sporotilo posljite s pritiskom na klicno tipko.

A

- Nasvet: (e Zelite iz sporoCila odstraniti sliko, izberite MoZnosti > Odstrani sliko.

B Velpredstavnostna sporo€ila

Veclpredstavnostno sporocilo (MMS) lahko vsebuje besedilo in predmete, kot so slike, zvocni in video posnetki.

Opomba: Velpredstavnostna sporocila lahko prejemajo in prikazujejo le naprave z zdruZljivimi funkcijami. Videz
sporoCila je lahko drugacen, odvisno od naprave, ki ga prejme.

Preden zaCnete posiljati in prejemati vecpredstavnostna sporo€ila, morate pravilno doloditi ustrezne nastavitve. Vasa naprava
je morda prepoznala ponudnika kartice SIM in samodejno konfigurirala vepredstavnostna sporo€ila. Drugace se obrnite na
ponudnika storitev. Glejte "Nastavitve ve€predstavnostnih sporo(il”, str. 28.

Ustvarjanje in posiljanje vecpredstavnostnih sporocil
Privzeta nastavitev za vepredstavnostno sporocanje je ponavadi: storitev je vkljucena.
Izberite Novo sporoCilo > Vetpred. sporoCilo.

Zaradi zas(ite avtorskih pravic morda ne boste mogli kopirati, spreminjati, prenasati ali posredovati nekaterih slik, skladb
(vkljucno s toni zvonjenja) in druge vsebine.

1. V polju Za pritisnite krmilno paltko in izberite prejemnike iz menija Imenik ali pa rono vpisite njihove mobilne telefonske
Stevilke ali e-poStne naslove.

2. V polje Zadeva vtipkajte zadevo sporofila. Ce Zelite zamenjati prikazana polja, izberite MoZnosti > Polja za naslove.

3. Napisite besedilo sporoCila in izberite MoZnosti > Vstavi predmet, da bi dodali predstavnostne predmete. Dodate lahko
datoteke vrste Slika, Zvo€ni posnetek ali Video posnetek.

Mobilno omreZje lahko omejuje velikost ve¢predstavostnih sporofil. (e vstavljena slika preseZe omejitev, jo bo morda
naprava pomanjsala, tako da jo boste lahko poslali prek storitve MMS.

4. Vsaka stran v sporotilu lahko vsebuje le en zvotni ali video posnetek. Ce Zelite v sporotilo dodati vet strani, izberite
MoZnosti > Vstavi novo > Stran. (e Zelite spremeniti vrstni red strani, izberite MoZnosti > Premakni.

5. Celotno sporocilo prikaZete pred posiljanjem tako, da izberete MoZnosti > Predogled.
6. SporoCilo posljete s pritiskom na klicno tipko.
- Nasvet: VeCpredstavnostna sporocila lahko tudi neposredno ustvarjate v vec aplikacijah, kot sta Imenik in Galerija.

(e Zelite zbrisati predmet iz veCpredstavnostnega sporotila, izberite MoZnosti > Odstrani.
MoZnosti posiljanja veCpredstavnostnih sporoCil
Izberite MoZnosti > MoZnosti posiljanja in eno od naslednjih moZnosti:

+ Povratnice — Izberite Da, Ce Zelite prejeti obvestilo, ko bo poslano sporotilo uspe$no dostavljeno. Prejemanje obvestil o
dostavi veCpredstavnostnih sporoCil, poslanih na e-postni naslov, morda ne bo mogoce.

« Veljavnost sporotila — Izberite, kako dolgo naj sporotilni center sku$a poslati sporotilo. e prejemnik sporotila ni dosegljiv
v Casu veljavnosti sporocila, se to odstrani iz sporotilnega centra. Ta funkcija deluje samo, Ce jo podpira omrezje. Najvedja
mogocta je najdaljsa veljavnost, ki jo omrezje omogoca.

Ustvarjanje predstavitev
Izberite Novo sporocilo > Vetpred. sporoCilo.

1. V polju Za pritisnite krmilno paltko in izberite prejemnike iz menija Imenik ali pa rono vpisite njihove mobilne telefonske
Stevilke ali e-poStne naslove.

2. Izberite MoZnosti > Ustv. predstavitev in predlogo za predstavitev.
;\é’: Nasvet: Predloga lahko doloCa, katere predstavnostne predmete lahko vkljudite v predstavitev, kje se ti prikazejo,
ter uinke prehoda med slikami in stranmi.
3. Pomaknite se na prostor za besedilo in vnesite besedilo.

4. (e zelitev predstavitev vstaviti slike, zvok, video ali belezke, se pomaknite na ustrezno obmodje in izberite MoZnosti >
Vstavi.

:‘é’: Nasvet: Med obmotji predmetov se lahko pomikate navzgor ali navzdol.
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5. Strani dodate tako, da izberete Vstavi > Nova stran.
6. Izberite MoZnosti in med temi mozZnostmi:

Predogled — Preverite, kak$na je videti predstavitev, ko je odprta. Vepredstavnostne predstavitve je mogoce prikazovati
samo v zdruZljivih napravah, ki podpirajo predstavitve. V razli¢nih napravah imajo lahko razli¢en videz.

Nastavitve ozadja — Izberite barvo ozadja predstavitve in slike za ozadje razli¢nih strani.

- Nastavitve u€inkov — Izberite u€inke prehoda med slikami in stranmi.

Ustvarjanje vetpredstavnostnih predstavitev ni mogoce, ¢e je Natin ustv. spor. MMS nastavljeno na Omejeno. (e Zelite spremeniti
nastavitve za Nacin ustv. spor. MMS, izberite SporoCila > MoZnosti > Nastavitve > Velpredst. sporoCilo.

Morda ne bodo vedno na voljo iste moznosti.

Velpredstavnostno predstavitev posljete s pritiskom na krmilno palcko.
;\é’: Nasvet: Ce Zelite sporotilo shraniti v mapo Osnutki, ne da bi ga poslali, izberite Kon¢ano.

Prejemanje ve{predstavnostnih sporodil in odgovarjanje nanje

@ Pomembno: Predmeti vecpredstavnostnih sporoCil lahko vsebujejo viruse ali so drugace Skodljivi za va$o napravo ali
raCunalnik. Prilog ne odpirajte, Ce posiljatelju ne zaupate.

Preden zaCnete posiljati in prejemati vecpredstavnostna sporoCila, morate pravilno doloCiti ustrezne nastavitve. Vasa naprava

je morda prepoznala ponudnika kartice SIM in samodejno konfigurirala vepredstavnostna sporoCila. Drugace se obrnite na

ponudnika storitev. Glejte "Nastavitve vepredstavnostnih sporodil*, str. 28.

(e prejmete velpredstavnostno sporocilo s predmeti, ki jih naprava ne podpira, si teh predmetov ne boste mogli ogledati.
1. (e Zelite odgovoriti na vepredstavnostno sporoftilo, ga odprite v mapi Prejeto in izberite MoZnosti > Odgovori.

2. lzberite MoZnosti > Posiljatelju, da bi posiljatelju poslali ve€predstavnostno sporocilo, ali MoZnosti > Prek besed. sporotila,
Ce Zelite odgovoriti z besedilnim sporocilom.

:\é’: Nasvet: Ce Zelite odgovoru dodati prejemnike, izberite MoZnosti > Dodaj prejemnika in jih poiscite v imeniku ali pa
vpisite telefonske Stevilke ali e-poStne naslove v polje Za.

3. Vtipkajte besedilo sporocila in pritisnite klicno tipko, da ga posljete.

Prikaz predstavitev

Odprite Prejeto, pomaknite se na veCpredstavnostno sporodilo, ki vsebuje predstavitev, in pritisnite krmilno pal¢ko. Pomaknite
se na predstavitev in pritisnite krmilno palcko.

(e Zelite zatasno ustaviti predvajanje predstavitve, pritisnite eno od izbirnih tipk pod zaslonom.
Ko je predvajanje zacasno ustavljeno ali koncano, izberite MoZnosti in eno od naslednjih moZnosti:

+ Odpri povezavo — Odprite povezavo in brskajte po spletni strani.

« Vkljuti drsenje — Pomikajte se po besedilu ali slikah, prevelikih za prikaz na zaslonu.

+ Nadaljuj — Nadaljujte predvajanje predstavitve.

+ Predvajaj — Ponovno predvajajte predstavitev od zaletka.

+ Poisti — PoisCite telefonske 3tevilke ter e-postne in spletne naslove, ki jih predstavitev morda vsebuje. Stevilke in naslove
lahko uporabljate na primer za klicanje, posiljanje sporocil ali ustvarjanje zaznamkov.

Morda ne bodo vedno na voljo iste moznosti.

Prikaz predstavnostnih predmetov

Odprite mapo Prejeto, pomaknite se na vecpredstavnostno sporocilo in pritisnite krmilno palcko. Izberite MoZnosti >
Predmeti.

Predstavnostni predmet prikaZete ali predvajate tako, da se pomaknete nanj in pritisnete krmilno palcko.

Predstavnostni predmeti in priloge sporoCil lahko vsebujejo viruse in drugo $kodljivo programsko opremo. Predmetov ali prilog
ne odpirajte, Ce posiljatelju ne zaupate.

Predstavnostni predmet shranite v ustrezno aplikacijo tako, da se pomaknete nanj in izberete MoZnosti > Shrani.
Pomaknite se na predmet in izberite Moznosti > Poslji, da bi ga poslali zdruZljivi napravi.
;\é’: Nasvet: Ce prejmete sporotilo s predstavnostnim predmetom, ki ga naprava ne more odpreti, poskusite predmet poslati

drugi napravi, na primer ratunalniku.
Prikaz in shranitev ve€predstavnostnih prilog

Odprite vepredstavnostno sporodilo in izberite MoZnosti > Predv. predstavitev, Ce ga Zelite predvajati kot predstavitev.

;\é’: Nasvet: Ko izberete velpredstavnostni predmet v sporodilu, ga lahko prikaZete ali predvajate tako, da izberete PrikaZi
sliko, Predv. zvo€ni posn. ali Predvajaj video p..
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(e si zelite ogledati ime in velikost priloge, odprite sporofilo in izberite MoZnosti > Predmeti.

(e Zelite shraniti ve¢predstavnostni predmet, izberite MoZnosti > Predmeti, Zeleni predmet in MoZnosti > Shrani.

Nastavitve vepredstavnostnih sporodil

Izberite MoZnosti > Nastavitve > VeCpredst. sporotilo.
DoloCite naslednje:

« Velikost slike — Izberite Majhna ali Velika, da bi v vetpredstavnostna sporofila vstavili manjse ali vetje slike. (e izberete
moznost Izvirna, se ohrani izvirna velikost slik.

« Nacinustv. spor. MMS— Izberite Omejeno, Ce Zelite, da vam naprava prepreci posiljanje vsebine, ki je omrezje ali prejemnikova
naprava verjetno ne podpirata. Ce Zelite prejemati opozorila o vkljutitvi take vsebine v sporofila, izberite Z opozorili. Ce Zelite
ustvariti vetpredstavnostna sporotila brez omejitev vsebine, izberite Brez opozoril. Ce izberete Omejeno, ne boste mogli
ustvarjati veCpredstavnostnih predstavitev.

« Upor. dostopna totka — Izberite privzeto dostopno totko za povezavo s centrom za ve¢predstavnostna sporotila. (e je
privzeto dostopno tocko nastavil ponudnik storitev, je morda ne boste mogli zamenijati.

« Nalaganje veCpr. sp. — Izberite Vedno samodejno, da bi naprava vedno samodejno prejela vecpredstavnostna sporocila,
Samod. v dom. omr., da bi prejemali obvestila o novih ve€predstavnostnih sporocilih, ki jih lahko naloZite iz sporoCilnega
centra (na primer v tujini), Rocno, €e Zelite vedno sami naloZiti sporocila iz centra, ali Izklju€eno, da prepretite prejemanje
velpredstavnostnih sporocil.

« Dovoli anonimna sp. — Izberite, ali Zelite prejemati tudi sporocila neznanih posiljateljev.

« Sprejem oglasov — Izberite, ali Zelite prejemati sporo€ila, oznatena kot oglasi.

+ Povratnice — Izberite Da, Ce Zelite, da bo stanje poslanega sporocila prikazano v dnevniku (omreZna storitev). Prejemanije
obvestil o dostavi ve€predstavnostnih sporocil, poslanih na e-postni naslov, morda ne bo mogoce.

« Prepreci pos. povrat. — Izberite Da, Ce Zelite, da naprava ne posilja poro€il o prejemu vecpredstavnostnih sporoCil.

+ Veljavnost sporotil — Izberite, kako dolgo naj sporotilni center sku$a poslati sporotilo (omreZna storitev). Ce prejemnik ni
dosegljiv v ¢asu veljavnosti sporoCila, se to odstrani iz centra za ve€predstavnostna sporocila. Najve¢ja mogoca je najdaljsa
veljavnost, ki jo omreZje omogoca.

B Hitra sporoCila (pomenki)

Izberite Meni > Povezov. > Pomenki.

Pomenki (omreZna storitev) omogocajo pogovor z drugimi uporabniki in vklju¢evanje v skupine pomenkov (forume) z
doloCenimi temami. Razli¢ni ponudniki storitev vzdrZujejo streznike za pomenke, na katere se lahko prijavite, ko se registrirate
za storitev za pomenke. Ponudniki storitev lahko nudijo razlicno podporo ali funkcije.

(e vas ponudnik mobilnih storitev ne ponuja funkcije pomenkov, ta meni v napravi morda ne bo prikazan. Vet informacij o
cenah storitev pomenkov in narofanju nanje lahko dobite pri ponudniku storitev. Ce Zelite ve€ informacij o razpoloZljivosti
nastavitev za pomenke, se obrnite na mobilnega operaterja, ponudnika storitev ali prodajalca.

Nastavitve pomenkov boste morda prejeli od mobilnega operaterja oziroma ponudnika storitve v posebnem besedilnem
sporoCilu. Shranite nastavitve, potrebne za dostop do Zelene storitve. Nastavitve lahko vpiSete tudi rocno.

Vzpostavitev povezave s streZznikom pomenkov

(e se Zelite pogovarjati z drugimi uporabniki pomenkov in si ogledati ali urediti imenik za pomenke, se morate prijaviti v streznik
pomenkov. Odprite Pomenki in izberite MoZnosti > Prijava. Prijavite se tako, da vnesete ID uporabnika in geslo ter pritisnete
krmilno palcko. Uporabnisko ime, geslo in druge nastavitve za prijavo lahko dobite pri ponudniku, ko se registrirate za storitev.

:\é’: Nasvet: Ce Zelite, da se samodejno vzpostavi povezava s streznikom, ko odprete aplikacijo Pomenki, izberite
MozZnosti > Nastavitve > Nastavitve streZnika > Vrsta prijave v pom. > Ob zagonu apl..

Iskanje uporabnikov ali skupin pomenkov

(e Zelite iskati uporabnike pomenkov in njihove kode ID, izberite Im. za pomenke > Moznosti > Nova vizitka > Poisti. I5¢ete
lahko po naslednjih lastnostih: Ime uporabnika, ID uporabnika, Telefonska Stevilka in E-po$tni naslov.

(e Zelite poiskati skupine pomenkov in njihove kode ID, izberite Skupine > MoZnosti > Poii(i. I5¢ete lahko po naslednjih
lastnostih: Ime skupine, Tema in Clani (ID uporabnika).

Pomaknite se na najdenega uporabnika ali skupino pomenkov, izberite MoZnosti in eno od naslednjih moZnosti:

+ Novo iskanje — Izvedite novo iskanje.

« Vel rezultatov — Prikazite morebitne preostale najdene uporabnike ali skupine pomenkov.

* Prejdnji rezultati — PrikaZite uporabnike ali skupine pomenkov, ki ste jih nasli s prejSnjim iskanjem.
« Odpri pogovor — Zalnite pogovor z uporabnikom, ki je na zvezi.

+ Dodaj v Imenik za pom. — Uporabnika shranite v enega od imenikov za pomenke.

+ Poslji vabilo — Uporabnika povabite v skupino pomenkov.
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+ MoZnosti blokiranja — Prepreite ali dovolite prejemanje sporo€il uporabnika pomenkov.
* Pridruzi se — Pridruzite se skupini pomenkov.
 Shrani — Shranite skupino.

Pogovori z enim uporabnikom pomenkov

V prikazu Pogovori je seznam uporabnikov, s katerimi se trenutno pogovarjate. Aktivni pogovori se samodejno prekinejo, ko
zaprete aplikacijo Pomenki.

(e Zelite prikazati pogovor, poistite udeleZenca in pritisnite krmilno pal¢ko.

(e Zelite pogovor nadaljevati, vpisite sporof€ilo in pritisnite krmilno paltko.

(e se Zelite vrniti na seznam pogovorov, ne da bi kontali pogovor, izberite moZznost Nazaj. Ce Zelite kon¢ati pogovor, izberite
MoZnosti > Kontaj pogovor.

(e Zelite zaCeti nov pogovor, izberite Moznosti > Nov pogovor. Pogovor z novim sogovornikom lahko zatnete tudi, ¢e se e
pogovarjate z nekom, ne morete pa imeti dveh aktivnih pogovorov z istim sogovornikom.

(e Zelite pomenku dodati sliko, izberite Moznosti > Poslji sliko in sliko, ki jo Zelite poslati.
(e Zelite sogovornika shraniti v imenik za pomenke, izberite MoZnosti > Dodaj v Imenik za pom..

(e Zelite v prikazu pogovora shraniti pogovor, izberite MoZnosti > Shrani pomenek. Pogovor je shranjen v besedilni datoteki, ki
jo lahko odprete in preberete v aplikaciji Belezke.

(e Zelite, da naprava posilja samodejne odgovore na prejeta sporotila, izberite MoZnosti > Vklju¢i samod. odg.. Sporotila lahko
vseeno prejemate.

Skupine pomenkov

V prikazu Skupine je seznam skupin pomenkov, ki ste jih shranili ali ste jim trenutno pridruzeni.

Seznam Skupine je na voljo samo, Ce ste se prijavili v streznik pomenkov, ko ste odprli aplikacijo, in Ce streznik podpira skupine.
(e Zelite ustvariti skupino pomenkov, izberite MoZnosti > Nova skupina.

(e se Zelite pridruziti skupini pomenkov ali nadaljevati skupinski pogovor, se pomaknite na skupino in pritisnite krmilno palcko.
Vpisite sporoCilo in ga posljite s pritiskom na klicno tipko.

(e se Zelite pridruziti skupini, ki je ni na seznamu, vendar poznate njen ID, izberite MoZnosti > PridruZi se novi sk..

Skupino pomenkov zapustite tako, da izberete MoZnosti > Zapusti skupino.

Izberete lahko tudi MoZnosti in eno od naslednjih moznosti:

« Skupina — Izberite Shrani, da skupino shranite med skupine pomenkov, PrikaZi udelezence, da bi videli trenutne ¢lane
skupine, ali Nastavitve, e Zelite urediti nastavitve skupine. To moznost lahko izberete samo, ¢e imate pravice za urejanje
skupine.

* Prijava — Vzpostavite povezavo s streznikom pomenkov, Ce se niste prijavili, ko ste odprli aplikacijo.

+ Odjava — Prekinite povezavo s streZznikom pomenkov.

+ Nastavitve — Uredite nastavitve aplikacije ali streznika pomenkov.

Skupino pomenkov odstranite s pritiskom na vracalko.
Skupinski pogovori

(e se Zelite pridruziti pogovoru, izberite skupino.
Izberite MoZnosti in med temi moZnostmi:

- Vstavi smeska — V sporocilo vstavite smeska.

+ Poslji zasebno spor. — Enemu ali ve¢, vendar ne vsem, clanom skupine posljite zasebno sporoCilo.

« Odgovori — Sporotilo posljite samo posiljatelju odprtega sporocila.

 Posreduj — Odprto sporocilo posredujte drugi skupini ali uporabniku pomenkov.

* Poslji vabilo — V skupino povabite novega uporabnika pomenkov.

* Zapusti skupino — Kondcajte skupinski pogovor.

« Skupina — Izberite Shrani, da skupino shranite med skupine pomenkov, PrikaZi udeleZence, da bi videli trenutne ¢lane
skupine, ali Nastavitve, Ce Zelite urediti nastavitve skupine. To moznost lahko izberete samo, Ce imate pravice za urejanje
skupine.

+ Shrani pomenek — Shranite kopijo skupinskega pogovora.

Sporotilo posljite tako, da ga napisete in pritisnete klicno tipko.
Nastavitve skupin pomenkov

Izberite Skupine > MoZnosti > Skupina > Nastavitve.
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Nastavitve skupine pomenkov lahko uredite samo, ¢e imate pravice za urejanje te skupine.
Izberite med naslednjimi moZnostmi:

+ Ime skupine: — Vnesite ime za skupino pomenkov.

« 1D skupine — Koda ID skupine se ustvari samodejno in je ni mogoce dodati ali spremeniti.

+ Tema skupine — Vnesite temo za skupinski pogovor.

 Pozdrav — Vnesite pozdravno sporoCilo, ki se ob vkljucitvi v skupino prikaze uporabnikom pomenkov.

« Velikost skupine — Vnesite najve{je Stevilo uporabnikov pomenkov, ki se lahko pridruZijo skupini.

+ Dovoli iskanje — Izberite, ali lahko uporabniki pomenkov najdejo to skupino.

« Pravice spreminjanja — (e Zelite pravice za urejanje skupine dodeliti tudi drugim €lanom skupine, izberite Izbrani >
MoZnosti > Dodaj urejevalca. Uporabniki pomenkov, ki imajo pravice za urejanje, lahko urejajo nastavitve skupine ter vanjo
povabijo druge uporabnike ali jim prepovedo uporabo skupine.

« (lani skupine — (e Zelite zapreti skupino in pridruZitev vanjo omogotiti samo izbranim uporabnikom pomenkov, izberite
Samo izbrani > Moznosti > Dodaj ¢lana.

« Seznam zavrnjenih — (e Zelite nekaterim uporabnikom pomenkov prepreciti pridruZitev skupini, izberite MoZnosti > Dodaj
na sez.zavrn..

« Dovoli zasebna spor. — (e Zelite ¢lanom skupine prepretiti medsebojno posiljanje zasebnih sporodil, izberite Ne.

Pravice za urejanje skupine

(e Zelite ¢lanom skupine pomenkov dodeliti ali odvzeti pravice za urejanije, poistite skupino pomenkov in izberite MoZnosti >

Skupina > Nastavitve > Pravice spreminjanja > Izbrani.

:\é’: Nasvet: Uporabniki pomenkov, ki imajo pravice za urejanje, lahko urejajo nastavitve skupine ter vanjo povabijo druge
uporabnike ali jim prepovedo uporabo skupine.

(e Zelite tlanom skupine dodeliti pravice za urejanje, izberite MoZnosti > Dodaj urejevalca in eno od naslednjih moZnosti:

* |z Imenika za pomenke — Dodajte enega ali ve€ uporabnikov iz imenika za pomenke.

* Vpidi ID uporabnika — Vnesite ID uporabnika pomenkov.

(e Zelite ¢lanu skupine odvzeti pravice za njeno urejanje, izberite MoZnosti > Odstrani.

Prepoved uporabe skupin

Pomaknite se na skupino pomenkov in izberite Moznosti > Skupina > Nastavitve > Seznam zavrnjenih.

(e Zelite uporabnikom pomenkov prepreiti pridruZitev skupini, izberite MoZnosti > Dodaj na sez.zavrn. in eno od naslednjih
moznosti:

* Iz Imenika za pomenke — Zavrnite enega ali ve€ uporabnikov iz imenika za pomenke.
+ Vpidi ID uporabnika — Vnesite ID uporabnika pomenkov.

(e Zelite zavrnjenemu uporabniku dovoliti pridruZitev skupini, izberite MoZnosti > Odstrani.

Imenik za pomenke

Ko se prijavite v storitev pomenkov, se samodejno naloZi vas imenik za pomenke, ki ga uporabljate v tej storitvi. Ce imenik ni
na voljo, poCakajte nekaj minut in ga poskusite naloZiti ro¢no.

;‘é’: Nasvet: Znak poleg imena uporabnika oznaCuje njegovo stanje prijave v storitev.

(e Zelite ustvariti vizitko za pomenke, izberite MoZnosti > Nova vizitka. Vnesite ID uporabnika in vzdevek ter izberite Kontano.
Koda ID uporabnika lahko vsebuje najveC 50 znakov, ponudnik storitve pomenkov pa lahko zahteva, da je zapisana v obliki
imeuporabnika@domena.com. Vzdevek ni obvezen.

(e si Zelite ogledati drug imenik za pomenke, izberite MoZnosti > Zamenjaj imenik.
PoisCite uporabnika pomenkov, izberite MoZnosti in eno od naslednjih moZnosti:

« Odpri pogovor — Zacnite ali nadaljujte pogovor z uporabnikom.

» Podrobnosti vizitke — PrikaZite vizitko.

+ Moznosti urejanja — Uredite ali zbriSite vizitko, jo premaknite v drug imenik ali prejmite obvestilo, ko se spremeni stanje
prijave uporabnika.

* Pripada skupinam — PrikaZite skupine pomenkov, ki jim je uporabnik pridruzen.

 Nov seznam vizitk — Ustvarite imenik za dolo¢eno skupino uporabnikov.

+ Osvezi dostopn. upor. — Posodobite stanje prijave uporabnikov v imeniku.

+ MoZnosti blokiranja — Prepretite ali dovolite prejemanje sporoCil uporabnika.

* Prijava — Vzpostavite povezavo s streznikom pomenkov, Ce se niste prijavili, ko ste odprli aplikacijo.

» Odjava — Prekinite povezavo s streZznikom pomenkov.

+ Nastavitve — Uredite nastavitve aplikacije ali streznika pomenkov.

Morda ne bodo vedno na voljo iste moZnosti.
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Vizitko v imeniku za pomenke zbriSete s pritiskom na vracalko.
Blokirani uporabniki

Izberite Im. za pomenke > MoZnosti > MoZnosti blokiranja > PrikaZzi blokirane.
Blokiranega uporabnika pomenkov poisCete tako, da vpisete prve Crke njegovega imena. PrikaZe se seznam ujemajocih se imen.
Prejemanje sporoCil blokiranega uporabnika dovolite tako, da izberete MoZnosti > Odblokiraj.

Da bi prepretili prejemanje sporotil drugih uporabnikov pomenkov, izberite Moznosti > Blokiraj nove vizitke. Uporabnika
pomenkov izberite v imeniku za pomenke ali vpiSite njegovo kodo ID.

Pregledovanje vabil

Izberite Pogovori. Pomaknite se na vabilo in pritisnite krmilno paltko.
Izberite MoZnosti in med temi moZnostmi:

* Pridruzi se — Pridruzite se skupini pomenkov.

« Zavrni — Zavrnite vabilo in posiljatelju posljite sporotilo.

* Zbrisi — ZbriSite vabilo.

+ MoZnosti blokiranja — Prepretite prejemanje vabil tega poSiljatelja.

Shranjeni pogovori

Shranjeni pogovor si lahko ogledate tako, da izberete Shran. pomenki, se pomaknete na pogovor in pritisnete krmilno palcko.

Lahko se tudi pomaknete na shranjeni pogovor, izberete MoZnosti in eno od naslednjih moznosti:

* Poslji — Pogovor posljite zdruZljivi napravi.

« Prijava — Vzpostavite povezavo s streznikom pomenkov, Ce se niste prijavili, ko ste odprli aplikacijo. Povezavo prekinete s
pritiskom na Odjava.

+ Nastavitve — Uredite nastavitve aplikacije ali streznika pomenkov.

Pogovor zbriSete s pritiskom na vracalko.

Nastavitve

Izberite MoZnosti > Nastavitve > Nastavitve pomenkov.
Izberite med naslednjimi moznostmi:

« Uporabi vzdevek — (e Zelite spremeniti ime, ki ga uporabljate v skupinah pomenkov, izberite Da.

« Dovoli sporocila od — Izberite, ali Zelite prejemati sporo€ila vseh uporabnikov, samo uporabnikov v svojem imeniku ali
nobenih sporodil.

+ Dovoli vabila od — Izberite, ali Zelite prejemati vabila vseh uporabnikov pomenkov, samo uporabnikov v svojem imeniku ali
nobenih vabil.

« Hitrost nalag. sporo€. — Hitrost prikazovanja novih sporo€il zmanjsate ali poveCate tako, da se pomaknete levo ali desno.

» Razvrsti vizitke — Izberite, ali Zelite vizitke v imeniku za pomenke razvrstiti po abecedi ali stanju prijave.

+ Osvez. dostopnosti — Izberite Samodejno, da se bo stanje prijave uporabnikov v imeniku samodejno posodabljalo.

« Vizitke, ki niso na zvezi — Izberite, ali naj bodo vimeniku za pomenke prikazani tudi sogovorniki, ki niso prijavljeni v storitev.

Morda ne bo vedno mogoce urediti istih nastavitev. Vet informacij lahko dobite pri ponudniku storitev.
Nastavitve streznika pomenkov

Izberite MoZnosti > Nastavitve > Nastavitve streZnika.
PoisCite naslednje moznosti in pritisnite krmilno palcko, Ce Zelite konfigurirati streznik pomenkov:

« StreZniki — Dodajte nove, uredite ali zbrisite obstojele streznike.

+ Privzeti streznik — (e Zelite zamenjati streznik, v katerega se naprava samodejno prijavi, poistite Zeleni streZnik in pritisnite
krmilno palcko.

« Vrsta prijave v pom. — (e Zelite, da naprava samodejno vzpostavi povezavo s privzetim streznikom, izberite Samodejna.
Izberite Sam. vdom. omr., Ce naj se povezava samodejno vzpostavlja, ko ste v domaem omreZju. Izberite Ob zagonu apl., ¢e
naj se vzpostavi povezava s streznikom, ko odprete aplikacijo Pomenki. Izberite Rocna, Ce Zelite rotno vzpostavljati povezavo
s streznikom.

B Posebne vrste sporocil

Naprava lahko prejema razli¢ne vrste sporocil, ki vsebujejo podatke:

+ Logo operaterja — Ce Zelite shraniti logotip, izberite MoZnosti > Shrani.

+ Ton zvonjenja — (e Zelite shraniti ton zvonjenja, pritisnite MoZnosti > Shrani.

« Nastavitveno sporotilo — Od mobilnega operaterja, ponudnika storitev ali oddelka za informacijsko tehnologijo v podjetju
lahko prejemate nastavitvena sporotila. {e Zelite sprejeti nastavitve, odprite sporogilo in izberite MoZnosti > Shrani vse.
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+ Obvestilo 0 e-posti — SporoCilo te vrste vas obvesti, koliko novih e-postnih sporo€il imate v oddaljenem nabiralniku.
RazSirjeno obvestilo lahko vsebuje podrobnejSe informacije.

Posiljanje ukazov za storitve
Ponudniku lahko posiljate ukaze za storitve; tako zahtevate vklop dolotenih omreznih storitev.

(e Zelite svojemu ponudniku poslati zahtevo za storitev (omreZnastoritev), izberite Moznosti > Ukaz za storitev. Zahtevo napisite
kot besedilno sporocilo in izberite MoZnosti > Poslji.
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5. Klicanje

Tudi Ce je naprava zaklenjena, lahko kliCete Stevilko za klic v sili, ki je vprogramirana v va$o napravo.
(e je naprava v profilu za uporabo brez povezave, boste morda morali vnesti kodo za odklepanije in izbrati klicni profil, preden
boste lahko poklicali katero koli Stevilko, tudi tisto za klice v sili.

Da bi lahko Klicali in sprejemali klice, mora biti naprava vklopljena in v dosegu omreZnega signala, vanjo pa mora biti vstavljena
veljavna kartica SIM. Med glasovnimi klici je povezava GPRS zadrZana, razen Ce omreZje podpira nacin dvojnega prenosa ali
imate kartico USIM in ste znotraj dosega omrezja UMTS.

Vtipkajte telefonsko $tevilko, vkljutno z omreZno $tevilko, in pritisnite klicno tipko. (e vnesete napaten znak, ga zbrisite s
pritiskom na vracalko.

:\éf: Nasvet: Za mednarodne klice dodajte znak +, ki nadomesti mednarodno izhodno kodo, potem vnesite Se kodo drZave,
omrezno Stevilko (po potrebi brez prve nicle) in telefonsko Stevilko.

S pritiskom tipke za konec koncate klic ali prekinete poskus klica.

(e Zelite poklicati vizitko, shranjeno vimeniku, v pripravljenosti pritisnite Imenik. Vpisite prve ¢rke imena, pomaknite se na ime
in pritisnite klicno tipko. Glejte "Imenik", str. 40.

Pritisnite klicno tipko, Ce Zelite prikazati seznam zadnjih 20 klicanih Stevilk. Poiscite Zeleno ime ali Stevilko in pritisnite klicno
tipko, da bi poklicali. Glejte "Dnevnik", str. 35.

Glasnost aktivnega klica nastavite s tipkama za glasnost.
(e med klicem odprete pokrovéek naprave, s tem samodejno vkljutite zvotnik.

(e Zelite v pripravljenosti poklicati svoj telefonski predal (omreZna storitev), pridrzite tipko 1 ali pritisnite 1 in klicno tipko.

B Hitro klicanje

Hitro klicanje omogo(a, da kli¢ete s pridrzanjem Stevilske tipke.
Preden uporabite hitro klicanje, izberite Meni > Orodja > Nastavitve > Klic > Hitro klicanje > Vkljuceno.

(e Zelite telefonski Stevilki dodeliti $tevilsko tipko za hitro klicanje, izberite Meni > Orodja > Hitro klicanje. Pomaknite se na
Stevilsko tipko (od 2 do 9) na zaslonu in izberite MoZnosti > Doloci. V meniju Imenik izberite Zeleno $tevilko.

Telefonsko Stevilko, ki je dodeljena Stevilski tipki, odstranite tako, da se pomaknete na tipko za hitro klicanje in izberete
MozZnosti > Odstrani.

(e Zelite zamenjati telefonsko $tevilko, dodeljeno $tevilski tipki, se pomaknite na tipko za hitro klicanje in izberite MoZnosti >
Spremeni.

B Sprejemanje klicev

@ Opomba: Dejanski racun za klice in storitve, ki vam ga izstavi mobilni operater, se lahko razlikuje — odvisno od vrste
omreZja, zaokroZevanja, davkov in podobnega.

Klic sprejmete s pritiskom na klicno tipko.
(e Zelite klic zavrniti, pritisnite tipko za konec.
(e 7elite namesto sprejema klica izkljuciti zvonjenje, izberite Uti3aj.

(e Zelite med klicem sprejeti nov klic, ko je vklju¢ena funkcija CakajoEi klic, pritisnite klicno tipko. Prvi Klic se zadrZi. Aktivni klic
koncate tako, da pritisnete tipko za konec.

B MoZnosti med klicem
(e med klicem izberete MoZnosti, so na voljo te moZnosti:

« lzklju€i mikrofon — Poslusajte pogovor, sogovorniki pa ne bodo slisali vas.

« Vklju€i mikrofon — Znova vkljucite mikrofon, da vas bodo sogovorniki slisali.

* lzklju€i — IzloCite udeleZenca iz aktivnega klica.

+ Kon(aj aktivni klic — Koncajte aktivni klic.

» Meni — Prikazite meni aplikacij v napravi.

* ZadrZi — Zadrzite aktivni klic.

+ Prevzemi — Sprostite zadrzani klic.

+ Nov klic — Med klicem vzpostavite drug klic, Ce je na voljo funkcija konferentnega klica (omrezna storitev).
« Odgovori — Med klicem sprejmite dohodni klic, ¢e je vkljutena funkcija Cakajoti klic.
« Zavrni — Med klicem zavrnite dohodni klic, ¢e je vklju¢ena funkcija Cakajoti Klic.

« Zakleni tipkovnico — Med klicem zaklenite tipkovnico naprave.
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+ Konferenca — Aktivni in zadrzani klic zdruZite v konferen¢ni klic (omrezna storitev).

- Zasebno — Med konferen¢nim klicem se zasebno pogovarijajte z izbranim udelezencem (omrezna storitev).

« Zamenjaj — Preklapljajte med aktivnim in zadrZzanim klicem (omreZna storitev).

* Poslji DTMF — Posljite nize tonov DTMF (dual tone multi-frequency), na primer gesel. Vnesite zaporedje DTMF ali ga poisCite
v meniju Imenik in izberite DTMF.

- PreveZi — Zadrzani klic povezite z aktivnim in se izloCite iz klica (omreZna storitev).

Morda ne bodo vedno na voljo iste moznosti.

B Preusmeritev klicev

Izberite Meni > Orodja > Nastavitve > Preusmeritve.

Dohodne klice lahko preusmerite v telefonski predal ali na drugo telefonsko Stevilko. Podrobnosti lahko izveste pri ponudniku
storitev.

1. Izberite med temi vrstami klicev:

+ Glasovni klici — Dohodni glasovni Klici.
+ Podat. in video klici — Dohodni podatkovni in video Kilici.
* Faks klici — Dohodni faks klici.

2. lzberite eno od naslednjih moznosti preusmeritve:

« Vsi govorni klici, Vsi pod. in video kl. ali Vsi faks klici. — Preusmeritev vseh dohodnih glasovnih, podatkovnih, faks in video
klicev.

+ (e je telefon zaseden — Preusmeritev dohodnih klicev, ko Ze poteka klic.

« (e klic ni odgovorjen — Preusmeritev dohodnih klicev po dolotenem ¢asu zvonjenja. V polju Zakasnitev: dolotite ¢as
zvonjenja naprave, preden se klic preusmeri.

« (e nisem v dosegu — Preusmeritev klicev, ko je naprava izkljutena ali ni v dosegu omreZja.

« (e nisem na voljo — Vklop vseh treh zadnjih moZnosti. Ta moZnost omogota preusmeritev klicev, ¢e je naprava zasedena,
zunaj dosega omrezja ali Ce klica ne sprejmete.

3. lzberite VKljudi.
(e Zelite preveriti trenutno stanje preusmeritev, se pomaknite na moznost preusmeritve in izberite MoZnosti > Preveri stanje.

Preusmeritev glasovnih klicev izkljucite tako, da se pomaknete na moznost preusmeritve in izberete MoZnosti > Preklici.

B Zapore klicev

Funkciji za zaporo klicev in za preusmeritev klicev ne moreta biti vklju€eni isto¢asno.
(e je vkljuena zapora klicev, morda lahko kli¢ete nekatere $tevilke za klic v sili.
Izberite Meni > Orodja > Nastavitve > Zapore klicev.

Vkljucite lahko zaporo odhodnih in dohodnih klicev v napravo (omreZna storitev). Za to funkcijo potrebujete geslo za zaporo,
ki ga dobite pri ponudniku storitev. Zapore klicev veljajo za vse Klice, tudi podatkovne.

Zaporo klicev vkljucite tako, da izberete Zapora za mobilne klice in eno od naslednjih moZznosti:

« 0dhodni Klici — Ce Zelite prepreciti glasovno klicanje z napravo.

« Dohodni klici — Vkljutite zaporo dohodnih klicev.

+ Mednarodni klici — (e Zelite prepretiti klicanje v tujino.

+ Dohodni Klici v tujini — VkljuCite zaporo dohodnih klicev, ko ste v tujini.

+ Medn.kl., razen dom. — (e Zelite prepreiti klicanje v tujino, vendar dovoliti klicanje v domovino.

Stanje zapore glasovnih klicev preverite tako, da izberete ustrezno moznost zapore in MoZnosti > Preveri stanje.

Vse zapore glasovnih klicev prekli¢ete tako, da izberete moznost zapore in MoZnosti > Prekliti vse zapore.

Zapore internetnih klicev
(e Zelite vkljutiti zaporo internetnih klicev, izberite Meni > Orodja > Nastavitve > Zapore klicev > Zapora intern. klicev.
(e naj naprava zavrata internetne klice anonimnih klicalcev, izberite Anonimni klici > Vklju¢eno.

B Poidiljanje tonov DTMF

Med aktivnim klicem lahko posiljate tone DTMF (dual tone multi-frequency) za dostop do telefonskega odzivnika ali drugih
avtomatiziranih telefonskih storitev.

(e Zelite poslati zaporedje tonov DTMF, vzpostavite klic in potakajte, da ga druga stran sprejme. Izberite Meni > Moznosti >
Poslji DTMF. Izberite prednastavljeno zaporedje tonov DTMF ali pa ga vtipkajte sami.
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(e Zelite zaporedije tonov DTMF priloZiti vizitki, izberite Meni > Imenik. Odprite vizitko in izberite MoZnosti > Uredi > MoZnosti >
Dodaj podrobnost > DTMF. Vnesite zaporedie. (e Zelite med posamezne tone DTMF vstaviti p (pavzo, dolgo priblizno 2 sekundi),
trikrat pritisnite tipko *. Izberite Kontano. Ce Zelite napravo nastaviti tako, da bo poslala tone DTMF ele, ko boste med klicem
izbrali Poslji DTMF, Stirikrat pritisnite *, da vnesete znak za ¢akanje w.

B Video telefonija

(e Zelite vzpostaviti video klic, morate biti v dosegu omreZja UMTS. Vet informacij o razpolozljivosti in narotnini na video klice
dobite pri mobilnem operaterju ali ponudniku storitev. Med pogovorom lahko v zdruzljivi mobilni telefon sogovornika posljete
navadno sliko. Ce ima sogovornik zdruZljiv mobilni telefon s kamero, lahko vasa naprava prikazuje video, ki ga ta posilja. Video
klic lahko poteka le med dvema udelezencema.

& Opozorilo: Med uporabo zvocnika naprave ne drzite ob usesu, saj je lahko zelo glasna.

V meniju Orodja > Nastavitve > Klicne nast. > Slika v video klicu izberite sliko, ki jo Zelite poslati.

Video klic zanete tako, da vnesete telefonsko Stevilko oziroma v meniju Imenik izberete prejemnika, nato pa MoZnosti >
Poklici > Video klic. Video klica ne morete spremeniti v obitajen glasovni Klic.

Med klicem izberite MoZnosti in eno od naslednjih moznosti:

» Zvok — Govorite s sogovornikom.

» Up. video — Video prikaZite brez zvoka.

« Zvotnik — Uporabite zvocnik za dohodni zvok.

+ Slusalka — Izkljucite zvocnik in uporabite slusalko.

B Dnevnik

Izberite Meni > Dnevnik.
V meniju Dnevnik si lahko ogledate informacije o preteklih komunikacijskih dogodkih.

(e Zelite prikazati dnevnike za zadnje glasovne klice, njihovo pribliZzno trajanje in paketne podatkovne povezave, izberite Zadnji
klici, Trajanje klicev ali Paketni prenos in pritisnite krmilno palcko.

(e Zelite dogodke razvrstiti po vrsti ali smeri posiljanja, se pomaknite desno, da odprete splosni dnevnik, in izberite Moznosti >
Filter. Pomaknite se na ustrezni filter in pritisnite krmilno pal€ko. Izberite vrsto ali smer posiljanja in pritisnite krmilno palcko.

(e Zelite nastaviti, kako dolgo naj bodo komunikacijski dogodki shranjeni v dnevniku, izberite MoZnosti > Nastavitve > Trajanje
dnevnika, eno od moznosti in OK.

(e Zelite zbrisati neodgovorjene, sprejete in odhodne klice, izberite Zadnji klici > MoZnosti > Zbrisi zadnje klice.

(e Zelite klicalcu poslati sporocilo, izberite Zadniji klici > Neodg. klici > MoZnosti > Ustvari sporotilo. Posiljate lahko besedilna ali
velpredstavnostna sporoCila.

(e Zelite klicalca ali posiljatelja sporocila dodati v Imenik, ga izberite in nato Zadniji klici > Neodg. klici > MoZnosti > Dodaj v
Imenik.

Koli¢ino podatkov, poslanih in prejetih po povezavi GPRS, lahko preverite tako, da izberete Paketni prenos.
Stevce GPRS ponastavite tako, da izberete MoZnosti > Potisti Stevce. Vpisite kodo za zaklepanje in izberite OK.

Nastavitve dnevnika

(e Zelite dolofiti, kako stari komunikacijski dogodki naj bodo e prikazani v aplikaciji Dnevnik, izberite MoZnosti > Nastavitve >
Trajanje dnevnika, eno od moznosti na seznamu in OK.

(e naj naprava med klicem prikazuje njegovo trajanje, izberite MoZnosti > Nastavitve > PrikaZi trajanje klica > Da.

B Pritisni in govori
Izberite Meni > Povezov. > PG.

OmreZna storitev Pritisni in govori (PG) omogoca neposredno glasovno komunikacijo; povezava se vzpostavi ob pritisku tipke.
S to storitvijo lahko svojo napravo uporabljate kot voki-toki (walkie-talkie).

Z uporabo storitve Pritisni in govori se lahko pogovarjate z eno osebo ali skupino ali pa se pridruZite kanalu. Kanal je kot
klepetalnica: lahko ga pokliCete in preverite, ali je kdo na zvezi. Drugi udelezenci v kanalu niso opozorjeni na klic; uporabniki
se preprosto pridruzijo kanalu in se zalnejo pogovarjati med seboj.

V komunikaciji Pritisni in govori ena oseba govori, drugi udeleZenci pa poslusajo prek vgrajenega zvocnika. Uporabniki se pri
govoru izmenjujejo. Govori lahko samo po en uporabnik, zato je trajanje posameznega govora omejeno. Informacije o trajanju
govora Pritisni in govori v domaem omrezju lahko dobite pri ponudniku storitev ali mobilnem operaterju.

Copyright © 2006 Nokia. All Rights Reserved. 35



Klicanje

Med klici Pritisni in govori ne pozabite drzati naprave pred seboj, da boste videli zaslon. Govorite v mikrofon in ne prekrivajte
zvocnika.

Telefonski klici imajo vedno prednost pred Klici Pritisni in govori.

Pred uporabo storitve Pritisni in govori morate dolo€iti dostopno tocko in nastavitve. Nastavitve boste morda prejeli od
ponudnika storitve v posebnem besedilnem sporoCilu.

Uporabni3ke nastavitve

Izberite MoZnosti > Nastavitve > UporabniSke nastavitve.

DoloCite naslednje:

+ Dohodni klici PG — (e Zelite, da naprava prikazuje obvestila o dohodnih klicih, izberite Obvestaj. Izberite Samodejno
sprejmi, Ce Zelite, da naprava samodejno sprejema klice Pritisni in govori. Izberite Ni dovoljeno, Ce naj naprava samodejno
zavraca klice Pritisni in govori.

« Opozorilni ton PG — Izberite Doloten s profilom, €e naj se nastavitev opozarjanja na dohodne klice spreminja skladno z
vklju€enim profilom. Kadar je izbran tihi profil, drugim uporabnikom storitve Pritisni in govori niste dostopni, razen za
zahtevanje povratnega klica.

+ Ton zaht. za povr. klice — DoloCite ton zvonjenja za zahteve po povratnih klicih.

+ Zagon aplikacije — Izberite, ali naj se naprava ob vklopu prijavi v storitev Pritisni in govori.

* Privzeti vzdevek — Vpisite svoj privzeti vzdevek (najvec 20 znakov), ki je prikazan drugim uporabnikom.

+ Prikazi moj naslov PG — DoloCite, ali lahko klicalci vidijo va$ naslov Pritisni in govori. Vas$ naslov je lahko prikazan vsem
klicalcem, samo sogovornikom v individualnih klicih ali udelezencem kanalov ali pa je skrit pred vsemi uporabniki storitve.

« Prik. moje stan. prijave — Dolocite, ali je vase stanje prijave v storitev Pritisni in govori prikazano ali prikrito drugim
uporabnikom.

Nastavitve povezave
Izberite MoZnosti > Nastavitve > Nastavitve povezave.
DoloCite naslednje:

» Domena — VpiSite ime domene, ki ste ga dobili od ponudnika storitev.

« Ime dostopne tocke — Izberite dostopno toko za storitev Pritisni in govori.

+ Naslov streznika — Vpisite naslov IP ali ime domene streznika Pritisni in govori; te podatke dobite pri ponudniku storitev.
» Uporabnisko ime — VpiSite uporabnisko ime, ki vam ga je dodelil ponudnik storitev.

- Geslo — Vnesite geslo, Ce ga potrebujete za prijavo v storitev Pritisni in govori. Geslo dobite pri ponudniku storitev.

Prijava v storitev Pritisni in govori

Naprava se ob vklopu aplikacije Pritisni in govori samodejno prijavi v storitev, e ste v meniju Uporabniske nastavitve vkljudili
Zagon aplikacije. Drugate se morate prijaviti rocno.

(e se Zelite prijaviti v storitev Pritisni in govori, izberite MoZnosti > Nastavitve > Nastavitve povezave ter vnesite nastavitve
Uporabnisko ime, Geslo, Domena, Naslov streznika in Ime dostopne tocke. Izberite MoZnosti > Vkljuti PG.

(e je Vrsta zvonjenja v napravi nastavljena na Kratek pisk ali Tiho in kadar poteka telefonski pogovor, ne morete vzpostavljati
in prejemati klicev Pritisni in govori.

Klici Pritisni in govori

& Opozorilo: Med uporabo zvocnika naprave ne drzite ob usesu, saj je lahko zelo glasna.

Izberite MoZnosti > Imenik Prit. in govori.

Klic Pritisni in govori vzpostavite tako, da izberete eno ali ve€ vizitk na seznamu in pritisnete tipko PG. Med Klici Pritisni in govori
ne pozabite drzati naprave pred seboj, da boste videli zaslon. Ko ste na vrsti za govor, se prikaze obvestilo. Govorite v mikrofon
in ne prekrivajte zvocnika. Medtem ko govorite, ves Cas drZite tipko PG. Ko nehate govoriti, tipko spustite.

Ko Zelite klic Pritisni in govori kon€ati, pritisnite tipko za konec.

Ob dohodnem Klicu Pritisni in govori pritisnite klicno tipko, da klic sprejmete, ali tipko za konec, da ga zavrnete.

Zahteve po povratnih Klicih

Zahtevo po povratnem klicu posljete tako, da izberete MoZnosti > Imenik Prit. in govori, se pomaknete na vizitko Zelene osebe
in izberete MoZnosti > Po3lji zaht. za povr. klic.

(e Zelite odgovoriti na prejeto zahtevo po povratnem klicu, izberite PrikaZi, da jo odprete. Klic Pritisni in govori s posiljateljem
zahteve vzpostavite tako, da pritisnete tipko PG.
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Klicanje

Prikaz imenika
(e Zelite pregledati, dodati in spremeniti vizitke ali jih poklicati, izberite Moznosti > Imenik Prit. in govori. Odpre se seznam
imen iz aplikacije Imenik v napravi, ki vsebuje tudi informacije o stanju prijave uporabnikov.

(e Zelite poklicati izbrano vizitko, izberite MoZnosti > Vzpost. individualni klic. (e Zelite poklicati skupino, izberite MoZnosti >
Vzpost. skupin. klic PG.

Da bi vizitki poslali zahtevo po povratnem Klicu, izberite MoZnosti > Po3lji zaht. za povr. klic.

Ustvarjanje kanala

Kanal je kot klepetalnica: lahko ga poklicete in preverite, ali je kdo na zvezi. Drugi udeleZenci v kanalu niso opozorjeni na klic;
uporabniki se preprosto pridruzijo kanalu in se zacnejo pogovarjati med seboj.

Kanal ustvarite tako, da izberete MoZnosti > Nov kanal > Ustvari novega.
Izberite MoZnosti in dololite naslednje:

* Ime kanala — VpiSite ime kanala.

+ Zasebnost kanala — Izberite Zaseben ali Javen.

+ Vzdevek v kanalu — VpiSite svoj privzeti vzdevek (najvec 20 znakov), ki je prikazan drugim uporabnikom.
- Slitica kanala — Vstavite sliko, ki opisuje kanal.

(e Zelite zbrisati kanal, pritisnite vracalko.
Ob prijavi v storitev Pritisni in govori se naprava samodejno poveZe s kanali, ki so bili aktivni, ko ste aplikacijo nazadnje zaprli.

Registriranje kanalov Pritisni in govori
(e Zelite registrirati kanal v storitev Pritisni in govori, izberite MoZnosti > Registriraj.
(e zelite urediti podrobnosti kanala, izberite MoZnosti > Uredi.

Pridruzitev kanalu

Kanalu se pridruZite tako, da izberete MoZnosti > Kanali Pritisni in govori. Izberite kanal, ki ga Zelite poklicati, in pritisnite tipko
PG. Med Kilici Pritisni in govori ne pozabite drzati naprave pred seboj, da boste videli zaslon. Ko ste na vrsti za govor, se prikaze
obvestilo. Govorite v mikrofon in ne prekrivajte zvotnika. Medtem ko govorite, ves Cas drzite tipko PG. Ko nehate govoriti, tipko
spustite.

(e imate vet klicev hkrati, lahko med kanali preklapljate z izbiro moZnosti Preklopi. Aktivni kanal je oznaten.
(e si Zelite ogledati aktivne udeleZence kanala, izberite MoZnosti > Aktivni €lani.
(e Zelite udeleZenca povabiti v kanal, izberite MoZnosti > Podlji vabilo.

Dnevnik Pritisni in govori

Dnevnik Pritisni in govori odprete tako, da izberete MoZnosti > Dnevnik PG. V dnevniku so prikazani datum, ¢as, trajanje in druge
podrobnosti o klicih Pritisni in govori.

:\é’: Nasvet: Klic z enim sogovornikom lahko v meniju Dnevnik PG vzpostavite tako, da izberete Zeleni dogodek in pritisnete
tipko PG.

Izhod iz Pritisni in govori
Izberite MoZnosti > Izhod. Izberite Da, da se odjavite in zaprete storitev. Pritisnite Ne, da aplikacija ostane aktivna v ozadju.

B Internetni klici

Your device supports voice calls over the Internet (Internet calls).VaSa naprava podpira glasovne klice prek interneta (internetne
klice). Your device attempts emergency calls primarily over cellular networks.Klice v sili najprej poskusi vzpostaviti prek
mobilnega omreZja. If an emergency call using cellular networks is not successful, then your device attempts an emergency call
through your Internet call provider.Ce to ne uspe, poskusa klicati prek ponudnika internetne telefonije. Due to the established
nature of cellular telephony, you should use cellular networks for emergency calls, if possible.Ker je mobilna telefonija bolj
uveljavljena in zanesljiva, je priporocljivo klicanje v sili prek mobilnega omreZja. If you have cellular network coverage available,
please make sure that your cellular phone is switched on and ready to make calls before you attempt an emergency call.Ce ste
v dosegu signala mobilnega omreZja, pred klicanjem preverite, ali je vaSa naprava vklopljena in pripravljena za klice. The
capability for an emergency call using Internet telephony depends on the availability of a WLAN network and your Internet call
provider's implementation of emergency call capabilities.Moznost klicanja v sili prek internetne telefonije je odvisna od
razpoloZljivosti omreZja WLAN in podpore ponudnika za klicanje v sili. Contact your Internet call provider to check the Internet
telephony emergency call capability O moZnosti klicanja v sili prek interneta se lahko pozanimate pri svojem ponudniku
internetne telefonije.
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Klicanje

Tehnologija VolP (Voice over Internet Protocol) je niz protokolov, ki omogocajo telefonske klice v omrezjih, ki temeljijo na
internetnem protokolu (na primer internetu). Telefonski klici VoIP so mogo¢i med raCunalniki, med mobilnimi telefoni ter med
napravo VolP in obiajnim telefonom. Da bi lahko klicali ali sprejeli klic VoIP, mora biti naprava v dosegu omreZja WLAN.

Da bi lahko uporabljali internetno klicanje, morate ustvariti profil internetnega telefona. Ko je ta pripravljen, lahko vzpostavljate
internetne klice iz vseh aplikacij, ki podpirajo obitajne glasovne klice. Ce Zelite internetno poklicati naslov, ki se ne zatne s
Stevilko, v pripravljenosti pritisnite katero koli Stevilsko tipko, nato pa modro funkcijsko tipko, da se vsebina zaslona zbriSe in
naprava preklopi s Stevilskega na ¢rkovni nacin. Vnesite naslov in pritisnite klicno tipko.

V meniju Meni > Orodja > Nastavitve > Povezava > Nastavitve SIP doloCite nastavitve SIP, v meniju Meni > Orodja > Nastavitve >
Povezava > Nastavitve internet. tel. pa nastavitve VolP. Vel informacij in pravilne nastavitve lahko dobite pri ponudniku storitev.

Prednostni profil
Izberite Meni > Povezov. > Intern. tel., da bi spremenili nastavitve.

Preden izberete privzeti profil, morate ustvariti profile v meniju Meni > Orodja > Nastavitve > Povezava > Nastavitve internet.
tel..

Izberite Prednostni profil in pritisnite krmilno paltko, da bi izbrali privzeti profil, ki bo uporabljen pri internetnem klicanju.
PoisCite Zeleni profil in pritisnite krmilno palcko.

Registriranje profilov
Na seznamu so prikazani samo tisti profili, za katere ste v meniju Meni > Orodja > Nastavitve > Povezava > Nastavitve SIP izbrali
nastavitev Registracija > Po potrebi.

Pomaknite se na profil internetnega telefona, ki ga Zelite registrirati ali preklicati njegovo registracijo, in pritisnite krmilno
paltko. Znova pritisnite krmilno paltko, da izberete Registriran ali Ni registriran.

Nastavitve shranite z izbiro moznosti Nazaj.

B Glasovni ukazi

Izberite Meni > Orodja > Glasovni ukazi.
Z glasovnimi ukazi lahko klicete in vkljuCujete aplikacije, profile in druge funkcije naprave.

Naprava ustvari glasovne oznake za vnose v imeniku in funkcije, navedene v aplikaciji Glasovni ukazi. Ko uporabite glasovni
ukaz, naprava primerja izgovorjene besede s shranjenimi glasovnimi oznakami.

Glasovni ukazi niso odvisni od glasu uporabnika, vendar se prepoznavanje govora izboljSuje s prilagajanjem glasu osebe, ki
funkcijo najveckrat uporablja.

Klicanje
Glasovna oznaka se ustvari iz imena ali vzdevka osebe, shranjenega v vizitki v meniju Imenik. Glasovno oznako predvajate tako,
da odprete vizitko in izberete Moznosti > Predvajaj.

1. e Zelite poklicati z glasovnim ukazom, pridrZite glasovno tipko.
2. Ko zagledate obvestilo ali zasliite pisk, razlono izgovorite ime, shranjeno v vizitki.

3. Naprava predvaja sintetizirano glasovno oznako prepoznane osebe v izbranem jeziku ter prikaze ime in telefonsko Stevilko.
(ez nekaj Casa Stevilko pokliCe. Ce prepoznana oseba ni prava, izberite Naprej, da odprete seznam drugih ujemajocih se imen,
ali Koncaj, da prekli¢ete klicanje.

(e je pod enim imenom shranjenih vet stevilk, bo naprava izbrala privzeto $tevilko, e ste jo nastavili. Drugate bo v naslednjem
vrstnem redu poiskala prvo razpoloZljivo Stevilko: Mobilni telefon, Mobil. tel. (doma), Mob. tel. (sluzba), Telefon, Telefon
(doma) in Telefon (sluzba).

Zagon aplikacije
Naprava ustvari glasovne oznake za aplikacije, navedene v meniju Glasovni ukazi.

(e Zelite z glasovnim ukazom zagnati aplikacijo, pridrzite glasovno tipko in razlo¢no izgovorite ustrezni glasovni ukaz. Ce
prepoznana aplikacija ni prava, izberite Naprej, da odprete seznam drugih ujemajocih se aplikacij, ali Koncaj, da prekliCete
postopek.

(e Zelite na seznam dodati vet aplikacij, izberite MoZnosti > Nova aplikacija.

(e Zelite spremeniti glasovni ukaz, se pomaknite na aplikacijo in izberite MoZnosti > Spremeni ukaz. Vtipkajte novi ukaz in
izberite OK.

Menjavanje profilov

Naprava ustvari glasovno oznako zavsak profil. Ce Zelite z glasovnim ukazom vkljutiti profil, pridrZite glasovno tipko in izgovorite
ime Zelenega profila.
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(e Zelite spremeniti glasovni ukaz, se pomaknite na profil in izberite Profili > MoZnosti > Spremeni ukaz.

Nastavitve glasovnih ukazov

Sintetizator, ki predvaja prepoznane glasovne ukaze v izbranem jeziku naprave, izkljudite tako, da izberete Nastavitve >
Sintetizator > Izkljucen.

Ob zamenjavi lastnika naprave je z izbiro moznosti Ponast. prilagoditve mogoce odstraniti prilagoditve prepoznavanja govora
prejSnjemu uporabniku.
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6. Imenik

Izberite Meni > Imenik.

V tem meniju lahko urejate vse kontaktne informacije, kot so telefonske Stevilke in naslovi. Vizitkam dodajte osebne tone
zvonjenja, glasovne oznake ali sliCice. Kontaktne informacije lahko v obliki vizitk posiljate zdruzljivim napravam, jih od njih
prejemate in dodajate v svoj imenik.

Vizitko dodate tako, da izberete MoZnosti > Nova vizitka. Vnesite kontaktne informacije in izberite Kontano.
(e Zelite urediti informacije v vizitki, jo poistite ter izberite MoZnosti > Uredi. Izberite med naslednjimi moZnostmi:

« Dodaj slitico — Dodajte sli€ico, ki se prikaZze ob klicu dolofene osebe. Izberete lahko sliko, ki je shranjena v napravi ali na
pomnilniski kartici.

« Odstrani sli¢ico — Odstranite sliko iz vizitke.

» Dodaj podrobnost — V vizitko dodajte informacije, na primer Delovno mesto.

« ZbriSi podrobnost — Zbrisite podrobnosti, ki ste jih dodali vizitki.

« Uredi oznako — Uredite imena polj vizitke.

B Urejanje skupin vizitk

Ustvarite skupino vizitk, da boste besedilna ali e-poStna sporocila lahko posiljali vec prejemnikom hkrati.

1. Pomaknite se desno in izberite MoZnosti > Nova skupina.

Vnesite ime skupine ali uporabite privzeto ime in izberite OK.

Odprite skupino in izberite MoZnosti > Dodaj Clane.

Pomaknite se na vsako vizitko, ki jo Zelite dodati v skupino, in jo oznacite s pritiskom na krmilno palcko.

S N

Izberite OK, da bi v skupino dodali vse oznacene vizitke.
(e v prikazu skupin vizitk izberete MoZnosti, lahko storite naslednje:

» Moznosti PG — Vzpostavite klic Pritisni in govori z enim ali skupino sogovornikov oziroma poSljite zahtevo za povratni
klic.

« Odpri — Odprite skupino vizitk in si oglejte njene Clane.

« Ustvari sporocilo — Posljite sporoCilo.

* Nova skupina — Ustvarite novo skupino vizitk.

* Zbrisi — Zbrisite skupino vizitk.

+ Preimenuj — Preimenujte skupino vizitk.

+ Ton zvonjenja — Skupini vizitk dodelite ton zvonjenja.

* Info o Imeniku — Prikazite informacije o skupini vizitk.

« Nastavitve — DoloCite nastavitve prikaza imen ¢lanov v skupini.

(e Zelite neko vizitko odstraniti iz skupine vizitk, skupino odprite. Oznafite vizitko, ki jo Zelite odstraniti, in izberite MoZnosti >
Odstrani iz skupine > Da.

:‘é’: Nasvet: (e Zelite preveriti, kateri skupini pripada vizitka, izberite Meni > Imenik. Oznaite vizitko in izberite MoZnosti >
Spada v skupine.

(e Zelite prikazati ali urediti vizitko v skupini vizitk, skupino odprite. Pomaknite se na vizitko, ki jo Zelite odpreti ali urediti, in
izberite MoZnosti. Izberite med naslednjimi moZnostmi:

» Odpri — Odprite vizitko in si oglejte kontaktne informacije.

* Pokli¢i — Izberite Glasovni klic ali Video klic in pokli€ite osebo.

« Ustvari sporoCilo — Ustvarite in posljite besedilno ali vepredstavnostno sporocilo.
* Odstrani iz skupine — Vizitko odstranite iz skupine vizitk.

+ Spada v skupine — PrikaZite vse skupine, ki jim pripada vizitka.

B Urejanje privzetih informacij

Vizitki dodelite privzeto Stevilko ali naslov, da boste lahko preprosto klicali ali posiljali sporocila, Cetudi je v vizitki shranjenih
vec Stevilk ali naslovov.

(e Zelite spremeniti privzete informacije za vizitko, jo odprite in izberite MoZnosti > Privzete. Izberite Stevilko ali naslov, ki ga
Zelite doloditi za privzetega, in izberite OK.

Privzeta Stevilka ali naslov sta v vizitki podcrtana.
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Imenik

B Kopiranje vizitk med kartico SIM in pomnilnikom naprave

Informacije o razpoloZljivosti in uporabi storitev SIM lahko dobite pri izdajatelju kartice SIM, tj. pri ponudniku storitev, mobilnem
operaterju ali drugih prodajalcih izdelkov mobilne telefonije.

(e Zelite kopirati vizitke s kartice SIM v pomnilnik naprave, izberite MoZnosti > Imenik kartice SIM > Imenik SIM, da bi odprli
imenik SIM. Oznacite vizitke, ki jih Zelite kopirati, ali izberite Oznaci vse, da bi kopirali vse. Izberite MoZnosti > Kopiraj v
Imenik.

(e Zelite kopirati vizitke iz pomnilnika naprave na kartico SIM, izberite MoZnosti > Kopiraj v imenik SIM. Oznatite vizitke, ki jih
Zelite kopirati, ali izberite Oznadi vse, da bi kopirali vse. Izberite Moznosti > Kopiraj v imenik SIM.

Izberite MoZnosti > Imenik kartice SIM > Imenik SIM, da bi prikazali imena in Stevilke, shranjene na kartici SIM. V imeniku SIM
lahko $tevilke dodajate, urejate ali kopirate v Imenik in jih klicete.

B Izbira tonov zvonjenja za vizitke
Izberite ton zvonjenja za vizitko ali skupino vizitk. Ce ob klicu prejmete telefonsko $tevilko klicalca, ki jo naprava prepozna, se
predvaja izbrani ton.

(e Zelite izbrati ton zvonjenja za vizitko ali skupino vizitk, odprite vizitko ali skupino vizitk in izberite MoZnosti > Ton
zvonjenja. Odpre se seznam tonov zvonjenja. Izberite Zeleni ton in OK.

(e Zelite odstraniti ton zvonjenja, na seznamu tonov izberite Privzeta melodija.

W Vizitke

Izberite Meni > Imenik.
Vizitke v zapisih vCard ali Nokia Compact Business Card lahko poSiljate, prejemate, pregledujete in shranjujete.
Vizitke lahko zdruZljivim napravam posiljate v sporoCilih SMS in MMS, po e-posti in infrardei povezavi ali povezavi Bluetooth.

(e Zelite poslati vizitko, jo izberite na seznamu in MoZnosti > Poslji. Izberite Prek besed. sporotila, Prek vetpr. sporotila, Prek e-
poste, Prek Bluetooth ali Prek IR. Vnesite telefonsko Stevilko ali naslov oziroma dodajte prejemnika iz imenika. Izberite
MoZnosti > Poslji. Ce za natin posiljanja izberete storitev SMS, bodo vizitke poslane brez slik.

Da bi prikazali prejeto vizitko, v odprtem obvestilu izberite Odpri ali odprite ustrezno sporocilo v mapi Prejeto menija
SporoCila.

(e Zelite shraniti vizitko, ob prikazu prejetega sporotila izberite MoZnosti > Shrani vizitko.
Prejeto vizitko shranite tako, da izberete Moznosti > Shrani vizitko.
Prejeto vizitko zbriSete tako, da izberete MoZnosti > Zbrisi.
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7. Koledar

Izberite Meni > Pripomocki > Koledar.

Z aplikacijo Koledar lahko ustvarjate in pregledujete na¢rtovane dogodke in sestanke. Za koledarske vpise lahko nastavite tudi
opozorila.

Podatke v koledarju lahko s programsko opremo Nokia PC Suite sinhronizirate z zdruZljivim raunalnikom. Ve€ informacij o
sinhronizaciji lahko preberete v priro¢niku za programsko opremo PC Suite.

B Ustvarjanje koledarskih vpisov

V koledarju lahko ustvarjate razli¢ne vrste vpisov:
* Vpisi vrste Sestanek imajo doloCeno uro in datum.
« Vpisi vrste BeleZka veljajo za ves dan, ne za dolo€en ¢as dneva. BeleZke se ne pojavijo v tedenskem prikazu.

« Vpisi vrste Obletnica vas opomnijo na rojstne dneve in pomembne datume. Veljajo za doloCen dan, ne za dolocen ¢as dneva.
Vpisi za obletnice se ponovijo vsako leto.

* Vpisi vrste Opravilo vas opomnijo na opravilo z dolo¢enim rokom, ne z dolo€enim ¢asom dneva.

(e Zelite ustvariti koledarski vpis, se pomaknite na datum in izberite MoZnosti > Nov vpis. Izberite vrsto vpisa. RazpoloZljive
nastavitve za sestanek, belezko, obletnico in opravilo se razlikujejo.

Izberite med temi moznostmi:

+ Zadeva ali PriloZznost — Vnesite opis.

+ Kraj — Vnesite vse potrebne informacije o lokaciji.

« Zaletni {as — Vnesite uro zaCetka.

« Kon¢ni €as — Vnesite uro konca.

« Zaletni datum ali Datum — Vnesite datum zaletka ali datum dogodka.

« Kon¢ni datum — Vnesite datum konca.

 Opozorilo — Nastavite opozorilo za sestanek ali obletnico. Opozorilo je prikazano v nacinu Dnevni prikaz.

 Ponovitve — Dolocite lahko ponavljanje vpisa in kdaj naj se ponovi. DoloCite vrsto ponavljanja, pogostost in morebitni datum
konca.

« Sinhronizacija — Ce izberete Zasebna, boste koledarski vpis videli samo vi in ne bo prikazan drugim uporabnikom, ki imajo
spletni dostop do koledarja. Ce izberete Javna, bodo vpis videli tudi drugi uporabniki z dostopom do vasega koledarja. Ce
izberete Brez, se vpis ob sinhronizaciji ne bo kopiral v raunalnik.

- Nasvet: Prepricajte se, da ste v aplikaciji Ura izbrali pravo mesto. NaCrtovani koledarski vpisi se namre€ utegnejo
spremeniti, ko zamenjate trenutno mesto z mestom, ki je v drugem ¢asovnem pasu.

(e Zelite odpreti obstojet vpis in ga urediti, se pomaknite nanj in izberite MoZnosti > Odpri. Uredite podrobnosti v vet poljih.

:\é’: Nasvet: Ob urejanju ali brisanju ponavljajotega se vpisa izberite natin izvedbe spremembe. e izberete Vsi vpisi v
koledarju zbrisani, se zbriSejo vsi ponavljajoci se vpisi. Ce izberete Zbrisi vpis, se zbrise samo trenutni vpis.

B Opravila

Ustvarite in vodite lahko seznam opravil, ki jih morate narediti do nekega datuma. Vsakemu opravilu lahko dodelite datum roka
in opozorilo.

Seznam opravil odprete tako, da izberete MoZnosti > Sezn. opravil.

Opravilo dodate tako, da izberete MoZnasti > Nov vpis > Opravilo. Zatnite pisati v polje Zadeva. Opravilu lahko dolo€ite datum
roka in pomembnost ter zanj ustvarite opozorilo (opomnik). Ikoni pomembnosti sta (!) Visoka in (=) Nizka. Za pomembnost
Normalna ni ikone.

(e Zelite opravilo oznaciti kot kon¢ano, ga poistite na seznamu opravil in izberite MoZnosti > Oznati kot kon¢ano.

(e zelite opravilo znova oznaciti kot nedokontano, ga poistite na seznamu in izberite MoZnosti > Ozn. kot nekon&ano.

B Nastavitve koledarja

Izberite MoZnosti > Nastavitve, da bi spremenili Opozorilo koledarja, Privzeti prikaz, Prvi dan v tednu je in Oznaka tedna.

B Prikazi v koledarju

V katerem koli prikazu koledarja lahko med razli¢nimi prikazi preklapljate z izbiro MoZnosti. Na seznamu izberite vrsto prikaza.

:\é’: Nasvet: V katerem koli prikazu aplikacije Koledar lahko s pritiskom na modro funkcijsko tipko in tipko * hitro preklopite
na drug prikaz.
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Koledar

Privzeti prikaz v koledarju nastavite tako, da izberete MoZnosti > Nastavitve > Privzeti prikaz > Mesecni prikaz, Tedenski
prikaz, Dnevni prikaz ali Prikaz opravil.

(e Zelite v prikazu koledarja videti nek datum, izberite MoZnosti > Pojdi na datum. Vnesite datum in izberite OK.

V nalinu Mesetni prikaz lahko naenkrat prikaZete celoten mesec. Vsaka vrstica prikazuje en teden. Prikazan je aktivni mesec,
aktivni dan pa je danasnji oziroma zadnji prikazani dan. Aktivni dan je oznaen z barvnim kvadratom. Dneve z nacrtovanimi
dogodki oznaluje majhen trikotnik v spodnjem desnem kotu. Med dnevi meseca in vpisi zanje preklapljajte s krmilno palcko.

M Nasvet: V katerem koli prikazu aplikacije Koledar lahko s pritiskom na modro funkcijsko tipko in tipko * hitro preklopite
>g< . ¢

a drug prikaz.
Tedenski prikaz prikazuje dogodke izbranega tedna v sedmih okencih za posamezne dni. Danasnji datum je oznacen z barvnim
kvadratom. Belezke in obletnice so postavljene pred 8. uro.
Prvi dan v tednu zamenjate tako, da izberete Moznosti > Nastavitve > Prvi dan v tednu je.

V prikazu Dnevni prikaz so dogodki izbranega dne. Vpisi so glede na ¢as zatetka razvriteni v tasovne predele. (e si Zelite ogledati
prejdnji ali naslednji dan, se pomaknite levo ali desno.

V prikazu Prikaz opravil so opravila izbranega dne.

B Posiljanje koledarskih vpisov

Da bi koledarski vpis poslali zdruZljivi napravi, se pomaknite nanj in izberite MoZnosti > Poslji > Prek besed. sporoCila, Prek velpr.
sporoCila, Prek e-poste, Prek Bluetoothali Prek IR.

B Dodajanje prejetega vpisa v koledar
Koledarske vpise lahko prejemate v prilogah vecpredstavnostnih ali e-postnih sporocil.

Da bi prejeti vpis dodali v koledar, odprite prilogo sporoCila, ki vsebuje vpis, in izberite MoZnosti > Shrani v Koledar. Vpis se doda
v privzeti koledar.
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8. Ura

Izberite Meni > Ura.

:\é’: Nasvet: Samodejno posodabljanje ure in datuma (omrezna storitev) vkljuCite tako, da izberete Moznosti >
Nastavitve > Ura mobiln. operaterja > Samodejno posodablj..

Vrsto ure zamenjate tako, da izberete MoZnosti > Nastavitve > Vrsta ure > Analogna ali Digitalna.
Nastavitve ure in datuma

(e Zelite spremeniti datum in uro, zamenjati obliko prikaza datuma in ure, zamenjati ton budilke ali nastaviti samodejno
posodabljanje ure, izberite Moznosti > Nastavitve in eno od naslednjih moZnosti:

 Toten €as — Vnesite Cas in izberite OK.

« (asovni pas — Vnesite tasovni pas in izberite OK.

» Datum — Vnesite datum in izberite OK.

« Zapis datuma — Spremenite prikaz datuma. PoisCite Zeleni prikaz in izberite OK.

« Lo€ilo datuma — Spremenite loCilo med dnevi, meseci in leti. PoisCite Zeleno locilo in izberite OK.

* Zapis Casa — Izberite 24-urni ali 12-urni.

« Lodilo Casa — Izberite loCilo med urami in minutami.

+ Vrsta ure — Izberite Analogna ali Digitalna.

» Melodija budilke — Izberite Zeleno melodijo za budilko.

« Ura mobiln. operaterja — Samodejno posodabljanje ure, datuma in ¢asovnega pasu (omreZna storitev). Izberite Samodejno
posodablj., da moznost vkljudite. Ta storitev morda ni na voljo v vseh omrezjih.

Budilka

(e je naprava ob nastavljenem ¢asu za bujenje izkljutena, se vkljui in zatne opozarjati. Ce izberete Ustavi, naprava vprasa, ali
jo Zelite vkljuciti za klice. Izberite Ne, Ce Zelite napravo izklju€iti, ali Da, Ce jo Zelite vkljuCiti za klice. Ne izberite moZnosti Da,
kadar lahko mobilni telefon povzro€i interferenco ali nevarnost.

Bujenje lahko nastavite, Ce izberete MoZnosti > Nastavi budilko. Vnesite Cas bujenja in izberite OK.
(e si zelite ogledati nastavitve bujenja in jih spremeniti, izberite MoZnosti > Ponastavi budilko.
(e Zelite izkljutiti bujenije, izberite Moznosti > Izklopi budilko.

B Dodajanje in brisanje mest

(e Zelite dodati mesto, se pomaknite desno in izberite MoZnosti > Dodaj mesto. Pomaknite se na Zeleno mesto in izberite
MoZnosti > Izberi.

:\éf: Nasvet: Ce Zelite poiskati mesto na seznamu Mesta, izberite Moznosti > Dodaj mesto > MoZnosti > Poisti. Ime mesta
vnesite v iskalno polje.

(e Zelite zbrisati mesto, se pomaknite desno, izberite mesto in MoZnosti > Odstrani.
(e zamenjate mesto, kjer ste, se lahko spremeni sistemska ura naprave.
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9. Povezovanje

Zaradi zas(ite avtorskih pravic morda ne boste mogli kopirati, spreminjati, prenasati ali posredovati nekaterih slik, skladb
(vkljucno s toni zvonjenja) in druge vsebine.

Naprava ponuja ve¢ moznosti za povezovanije z internetom in intranetom podjetja ali raunalniki in drugimi napravami.
BrezzZitni nalini povezovanja so WLAN, Bluetooth in infrardeta povezava. Podpira tudi Zicno resitev — kabelsko povezavo USB
(Universal Serial Bus) — za programsko opremo Nokia PC Suite ali prehod IP. Vasa naprava omogoca tudi komunikacijo prek
storitev VolIP (internetni klici), Pritisni in govori ter pomenkov in povezav, ki temeljijo na modemu.

Nadz. nap.—Glejte "OmreZna storitev konfiguracije na daljavo", str. 69.

Intern. tel.—Glejte "Internetni klici", str. 37.

PG—Glejte "Pritisni in govori ", str. 35.

Pomenki—Glejte "Hitra sporoCila (pomenki)", str. 28.

Sinhroniz.—Glejte "Sinhronizacija podatkov", str. 69.

B Internetne dostopne tocke

Prek dostopne tocke se vasa naprava povezuje z omrezjem. Preden uporabite e-posto in veCpredstavnostna sporocila ali se
poveZete z internetom in brskate po spletnih straneh, morate za te storitve dolociti internetne dostopne tocke. Glede na strani,
ki jih Zelite obiskovati, boste morda morali nastaviti veC internetnih dostopnih tock. Za brskanje po spletnih straneh na primer
potrebujete eno dostopno totko, za dostop do intranetnih strani vaSega podjetja pa drugo. Pri povezovanju z internetom prek
storitve GPRS uporablja naprava prednastavljene, privzete nastavitve internetne dostopne tocke.

Ko napravo prvic vklopite, se dostopne tocke lahko konfigurirajo samodejno skladno z informacijami ponudnika storitev,
shranjenimi na kartici SIM. Nastavitve za internetno dostopno tocko lahko prejmete v sporocilu od svojega ponudnika storitev.
Tako vam ne bo treba vseh nastavitev vpisati rocno.

Morda ne bodo vedno na voljo iste moznosti. Ponudnik storitev je morda v vasi napravi Ze shranil nekaj dostopnih tock ali vse.
Morda jih ne boste mogli urediti, zbrisati ali dodati novih.

Vet informacij o dostopnih tockah in njihovih nastavitvah dobite pri ponudniku storitev in ponudniku e-po$tnih storitev.

Glejte "Nastavitve povezave", str. 85.

Nastavitev internetne dostopne tocke za podatkovne klice

1. Izberite Meni > Orodja > Nastavitve > Povezava > Dostopne tocke.

2. Izberite MoZnosti > Nova dostop. tocka. Da bi obstojeto dostopno tocko uporabili kot osnovo za novo, izberite Obstojece
nastavitve. Da bi zaCeli s prazno dostopno tocko, izberite Privzete vrednosti.

3. Dolotite naslednje nastavitve:

» Ime povezave — VpiSite opisno ime za povezavo.

+ Podatkovni nosilec — Izberite Podatkovni klic ali Hitri prenos (samo GSM).

+ St. omreZja na klic — Vpisite modemsko telefonsko $tevilko dostopne totke. Pred mednarodne Stevilke vpisite znak +.

« Uporabnisko ime — VpiSite uporabnisko ime, €e ga zahteva ponudnik storitev. Uporabniska imena pogosto razlikujejo
med velikimi in malimi €rkami in jih dobite pri ponudniku storitev.

« Zahtevaj geslo — Izberite Da, e Zelite vnesti geslo ob vsaki prijavi v streznik, ali Ne, da geslo shranite za samodejno
prijavljanje.

- Geslo — Vpisite geslo, Ce ga zahteva ponudnik storitev. Geslo pogosto razlikuje med velikimi in malimi ¢rkami in ga dobite
pri ponudniku storitev.

« Preverjanje — Izberite ZasCiteno, da se bo geslo vedno posiljalo Sifrirano, ali Normalno, da nastavite posiljanje Sifriranega
gesla, kadar bo to mogoce.

- Domacta stran — Vnesite spletni naslov strani, ki jo Zelite s to dostopno totko uporabljati kot domaco stran.

* Vrsta podatkov. klica — Izberite Analogno ali ISDN.

+ Najv. hitrost prenosa — Izberite mejno hitrost prenosa. (e izberete Samodejno, je hitrost prenosa podatkov odvisna od
omreZja in lahko nanjo vpliva obremenitev omrezja. Nekateri ponudniki storitev lahko za visje hitrosti zaraunajo vec.

4. Ko ste doloCili osnovne nastavitve, izberite MoZnosti > Dodatne nastavitve, da bi dolo€ili dodatne nastavitve, ali Nazaj, da
nastavitve shranite in zaprete aplikacijo.

Dodatne nastavitve internetne dostopne tocke za podatkovne klice

Ko ste doloCili osnovne nastavitve internetne dostopne totke za Podatkovni klic ali Hitri prenos (samo GSM), izberite MoZnosti >
Dodatne nastavitve in dolocite naslednje dodatne nastavitve.

» Nastavitve IPv4 — Vnesite naslov IP svoje naprave in naslove imenskih streznikov za internetni protokol IPv4.
» Nastavitve IPv6 — Vnesite naslov IP svoje naprave in naslove imenskih streznikov za internetni protokol IPv6.
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Povezovanje

Naslov posredn. str. — VpiSite naslov posredniSkega streznika.

St. vrat posr. strezn. — Vpisite $tevilko vrat posredniskega streznika. Posredniski strezniki so posredniki med storitvijo
brskanja in njenimi uporabniki; uporabljajo jih nekateri ponudniki storitev. Ti streZniki lahko omogo¢ajo dodatne varnostne
funkcije in pospesujejo dostop do storitve.

Uporabi povratni klic — Izberite Da, €e uporabljate storitev, ki pri vzpostavitvi internetne povezave pokliCe vaso napravo.
Vrsta povratnega kl. — Po navodilih ponudnika storitev izberite Uporabi 3t. streZ. ali Uporabi drugo 3t..

Stev. za povratni klic — Vpisite Stevilko za podatkovne klice svoje naprave, ki jo uporablja streznik za povratne klice.

Upor. stiskanje PPP — Izberite Da, da pospesite prenos podatkov, Ce to oddaljeni streznik PPP podpira.

Upor. prijavni skript — Izberite Da, Ce ponudnik internetnih storitev zahteva prijavni skript oziroma Ce Zelite, da se prijava
opravi samodejno. Prijavni skript je zaporedje navodil, ki jih sistem upoSteva med prijavo.

Prijavni skript — Vnesite prijavni skript. Nastavitev je na voljo samo, €e ste izbrali Upor. prijavni skript > Da.

Inicializacija modema — Vnesite niz ukazov za nastavitev povezave, Ce to zahteva ponudnik storitev.

Nastavitev internetne dostopne totke za paketno podatkovno povezavo (GPRS)

Izberite Meni > Orodja > Nastavitve > Povezava > Dostopne totke.

Izberite MoZnosti > Nova dostop. totka. Da bi obstojeto dostopno totko uporabili kot osnovo za novo, izberite Obstojete
nastavitve. Da bi zaCeli s prazno dostopno tocko, izberite Privzete vrednosti.

DoloCite naslednje nastavitve:

» Ime povezave — VpiSite opisno ime za povezavo.

+ Podatkovni nosilec — Izberite Paketni prenos.

« Ime dostopne totke — Vnesite ime za dostopno tocko. Ime ponavadi dobite od ponudnika storitev ali mobilnega
operaterja.

« Uporabnisko ime — VpiSite uporabnisko ime, ¢e ga zahteva ponudnik storitev. Uporabniska imena pogosto razlikujejo
med velikimi in malimi ¢rkami in jih dobite pri ponudniku storitev.

- Zahtevaj geslo — Izberite Da, Ce Zelite vnesti geslo ob vsaki prijavi v streZnik, ali Ne, da geslo shranite za samodejno
prijavljanje.

+ Geslo— Vpisite geslo, Ce ga zahteva ponudnik storitev. Geslo pogosto razlikuje med velikimi in malimi ¢rkami in ga dobite
pri ponudniku storitev.

* Preverjanje — Izberite ZasCiteno, da se bo geslo vedno posiljalo Sifrirano, ali Normalno, da nastavite posiljanje Sifriranega
gesla, kadar bo to mogoce.

 Domaca stran — Vnesite spletni naslov strani, ki jo Zelite s to dostopno totko uporabljati kot domaco stran.

Ko ste doloCili nastavitve, izberite MoZnosti > Dodatne nastavitve, da bi dolo€ili dodatne nastavitve, ali Nazaj, da nastavitve
shranite in zaprete aplikacijo.

Dodatne nastavitve internetne dostopne totke za paketno podatkovno povezavo (GPRS)

Ko ste doloCili osnovne nastavitve internetne dostopne totke za paketno podatkovno povezavo (GPRS), izberite MoZnosti >
Dodatne nastavitve in doloCite naslednje dodatne nastavitve.

Vrsta omreZja— Za vrsto internetnega protokola izberite IPv4 ali IPv6. Internetni protokol doloCa nacin prenasanja podatkov
vV napravo in iz nje.

Naslov IP telefona — Vnesite naslov IP svoje naprave. Izberite Samodejni, da vam bo naslov IP poslalo omreZje. Ta nastavitev
je prikazana samo, Ce izberete Vrsta omreZzja > IPv4.

Naslov DNS — Vnesite naslova IP za Primarni naslov DNS in Sekundarni nasl. DNS, e to zahteva ponudnik storitev ali mobilni
operater. Drugace se naslova imenskih streZznikov samodejno preneseta iz omreZja.

Naslov posredn. str. — Vnesite naslov posredniSkega streZnika. Posredniski strezniki so posredniki med storitvijo brskanja
in njenimi uporabniki; uporabljajo jih nekateri ponudniki storitev. Ti strezniki lahko omogoc¢ajo dodatne varnostne funkcije
in pospesujejo dostop do storitve.

Nastavitev internetne dostopne totke za omreZje WLAN

Izberite Meni > Orodja > Nastavitve > Povezava > Dostopne totke.

Izberite MoZnosti > Nova dostop. tocka. Da bi obstoje€o dostopno tocko uporabili kot osnovo za novo, izberite Obstojete
nastavitve. Da bi zaCeli s prazno dostopno tocko, izberite Privzete vrednosti.

Dolocite naslednje nastavitve:

+ Ime povezave — VpiSite opisno ime za povezavo.

» Podatkovni nosilec — Izberite OmreZje WLAN.

+ Ime omrezja WLAN — (e Zelite vnesti ime (SSID), po katerem bo mogote prepoznati omreZje WLAN, izberite Rotni vnos.
(e Zelite izbrati omreZje WLAN med tistimi, ki so v dosegu, izberite 15¢i imena omreZij.

« Stanje omreZja — Izberite Skrito, €e se povezujete v skrito omreZzje, aliJavno, ¢e omreZzje ni skrito.
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Povezovanje

+ NainomreZjaWLAN — (e izberete Infrastruktura, lahko naprave komunicirajo med seboj in z napravamiv zicnem omrezju
LAN prek dostopne tocke brezzitnega omreZja. Ce izberete Ad hoc, si naprave posiljajo in prejemajo podatke neposredno
med seboj; dostopna totka omrezja WLAN ni potrebna.

« Za3tita omreZja WLAN — Izbrati morate isti natin varnosti, ki se uporablja za dostopno totko omreZja WLAN. (e izberete
WEP (Wired Equivalent Privacy), 802.1x ali WPA (Wi-Fi Protected Access), morate konfigurirati tudi ustrezne dodatne
nastavitve.

« Nast. zasCite WLAN — Uredite varnostne nastavitve za izbrano vrsto Za3¢ita omreZja WLAN.

+ Domaca stran — Vnesite spletni naslov strani, ki jo Zelite s to dostopno totko uporabljati kot domaco stran.

Morda ne bo vedno mogoce urediti istih nastavitev.

Dodatne nastavitve internetne dostopne tocke za WLAN

Izberite Meni > Orodja > Nastavitve > Povezava > Dostopne totke.

Ko ste doloCili osnovne nastavitve internetne dostopne tocke za WLAN, izberite MoZnosti > Dodatne nastavitve in doloCite
naslednje dodatne nastavitve.

+ Nastavitve IPv4 — Vnesite naslov IP svoje naprave in naslove imenskih streznikov za internetni protokol IPv4.

» Nastavitve IPv6 — Izberite ali vnesite naslove imenskih streznikov za internetni protokol IPv6.

« Kanal 'ad-hoc' — Ce je izbran omrezni na€in ad hoc, izberite Dolo€i in vnesite Stevilko kanala (1-11).

» Naslov posredn. str. — VpiSite naslov posredniskega streznika.

« St. vrat posr. strezn. — VpisSite Stevilko vrat posredniSkega streznika.

Morda ne bo vedno mogoce urediti istih nastavitev. Vec informacij lahko dobite pri ponudniku storitev.

B Omrezje WLAN
Izberite Meni > Orodja > Nastavitve > Povezava > BrezZitni LAN.

(e Zelite, da naprava prikaZe razpoloZljiva omrezja WLAN, izberite Prik. razpoloZljivost.
;\é’: Nasvet: Lahko vkljucite tudi iskanje omreZij v dosegu.

Naslov MAC, po katerem bo usmerjevalnik WLAN prepoznal vaSo napravo, preverite tako, da v pripravljenosti vnesete
*#62209526%#. Naslov se izpiSe na zaslonu naprave.

B Kabelska povezava

Preden uporabite kabelsko povezavo z raCunalnikom, morate v racunalnik namestiti gonilnik podatkovnega kabla USB.
Aplikacijo Prenos podatkov lahko uporabite, tudi ¢e niste namestili gonilnikov podatkovnega kabla USB.

Izberite Meni > Povezov. > Pod.kabel.

Napravo lahko po podatkovnem kablu USB poveZete z zdruZljivim osebnim raunalnikom. Podatkovni kabel USB prikljuCite na
spodnjo stran naprave. (e Zelite zamenjati vrsto naprave, ki jo navadno s podatkovnim kablom povezete z mobilno napravo,
pritisnite krmilno palcko.

Izberite med temi mozZnostmi:

+ Vpra3aj ob povezavi — Izberite, ali Zelite ob vsakem priklopu podatkovnega kabla izbrati vrsto naprave.

» PC Suite — PC Suite po podatkovnem kablu povezite z napravo ali napravo uporabite kot modem.

« Prenos podatkov — Dostopajte do podatkov, kot so glasbene ali slikovne datoteke, in jih iz raunalnika prenasajte po
podatkovnem kablu. Ce Zelite uporabiti Prenos podatkov, v nastavitvah povezav v programski opremi Nokia PC Suite ne
izberite povezave USB. Vstavite v napravo pomnilnisko kartico in jo po podatkovnem kablu USB povezite z zdruzljivim
raCunalnikom. Ko naprava vprasa, kateri nalin Zelite uporabiti, izberite Prenos podatkov. Naprava je v tem nacinu zmogljiva
pomnilnidka naprava, ki jo lahko v ratunalniku vidite kot izmenljivi trdi disk. (e ga izberete, naprava preklopi na profil Brez
povezave. Prekinite povezavo z ratunalnikom (na primer v Carovniku za odklop ali odstranjevanje strojne opreme v
operacijskem sistemu Windows), da se pomnilniska kartica ne bi poSkodovala. Ko je povezava prekinjena, se naprava vrne
na profil, v katerem je bila pred prenosom podatkov.

 Prehod IP — Izberite dostopno tocko za prenos podatkov z uporabo internetnega protokola.

Izbiro shranite s pritiskom na Nazaj.

B Prehod IP

Izberite Meni > Povezov. > Podatk. kabel > MoZnosti > Spremeni > Prehod IP.

Aplikacija Prehod IP omogo(a povezavo naprave z omrezjem prek zdruzljivega osebnega ratunalnika, s katerim je povezana
po podatkovnem kablu.
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Nastavitev podatkovnega kabla za uporabo prehoda IP

Prehod IP uporabljajte tako kot druge internetne dostopne totke, na primer za brskanje ali sinhronizacijo na daljavo. Ce povezava
z brezzitnim omrezjem ni na voljo, lahko s prehodom IP dostopate do interneta ali omrezZja LAN. Prehoda IP ni mogoce
uporabljati hkrati s programom Nokia PC Suite. Ce v nastavitvah kabelske povezave izberete prehod IP, ne boste mogli vklju€iti
modema.

Napravo pripravite tako, da nanjo priklopite podatkovni kabel in za nalin povezave izberete Prehod IP. Drugi konec
podatkovnega kabla poveZite z zdruzljivim raunalnikom in pocakajte, da ta prepozna vaso napravo.

Dostopna tocka za prehod IP
Meni > Orodja > Nastavitve > Povezava > Dostopne totke.

(e Zelite konfigurirati osnovne nastavitve za prehod IP, izberite MoZnosti > Nova dostop. totka > Privzete vrednosti. V polje Ime
povezave vnesite ime za povezavo prehoda IP, v polju Podatkovni nosilec izberite Prehod IP in vnesite naslov v polje Domata
stran.

Dodatne nastavitve dostopne tocke prehoda IP

Meni > Orodja > Nastavitve > Povezava > Dostopne tocke.

(e Zelite uporabiti dodatne nastavitve, odprite dostopno totko prehoda IP, izberite MoZnosti > Dodatne nastavitve in eno od
naslednjih moznosti:

+ Nastavitve IPv4 — Vnesite Naslov IP telefona in Naslov DNS za internetni protokol IPv4.
» Nastavitve IPv6 — Vnesite Naslov DNS za internetni protokol IPv6.

» Naslov posredn. str. — VpiSite naslov posredniSkega streZnika.

+ St. vrat posr. strezn. — Vpisite Stevilko vrat posredniskega streZnika.

B Bluetooth

Ponekod je uporaba tehnologije Bluetooth lahko omejena. O tem se pozanimajte prilokalnih oblasteh ali pri ponudniku storitev.
Funkcije, ki uporabljajo tehnologijo Bluetooth ali omogocajo tem funkcijam, da delujejo v ozadju, poveCujejo izrabo baterije in
skrajSujejo njen Cas delovanja.

Ta naprava je zdruZljiva s specifikacijo Bluetooth 1.2 in podpira naslednje profile: Generic Access Profile, Serial Port Profile, Dial-
up Networking Profile, Headset Profile, Handsfree Profile, Generic Object Exchange Profile, Object Push Profile, File Transfer Profile
in Basic Imaging Profile. Da zagotovite delovanje z drugimi napravami, ki podpirajo tehnologijo Bluetooth, uporabljajte dodatno
opremo, ki jo je za uporabo s tem modelom odobrila druZba Nokia. O zdruZljivosti s to napravo se pozanimajte pri proizvajalcih
drugih naprav.

Tehnologija Bluetooth omogoca brezzitno povezovanje med elektronskimi napravami v dometu 10 metrov. Povezava Bluetooth
se lahko uporablja za posiljanje slik, video posnetkov, besedila, vizitk, koledarskih belezk ali za brezzZi¢no povezovanje z drugimi
napravami, ki imajo vmesnik Bluetooth, na primer racunalniki.

Naprave Bluetooth se sporazumevajo prek radijskih valov, zato ni treba, da so med seboj v neposrednem vidnem polju. Poskrbeti
morate le za to, da va$a in druga naprava ne bosta oddaljeni ve¢ kot 10 metrov, ¢eprav lahko povezavo motijo zidovi ali druge
elektronske naprave.

Zaletek uporabe povezave Bluetooth
Izberite Meni > Povezov. > Bluetooth.

Funkcijo Bluetooth vkljucCite tako, da hkrati pritisnete modro funkcijsko tipko in tipko Ctrl. Izkljulite jo tako, da znova pritisnete
modro funkcijsko tipko in tipko Ctrl. Ce Bluetooth vkljucite s to bliznjico, naprava ne bo zahtevala, da jo poimenujete.

1. Ko funkcijo Bluetooth vkljucite prvi¢, naprava zahteva, da ji dodelite ime. Izberite enolitno ime, po katerem jo bo mogoce
prepoznati, kadar bo v blizini ve€ naprav Bluetooth.

2. Izberite Bluetooth > Vklju€eno.
3. Izberite Vidnost telefona > Viden vsem.
Va3o napravo in njeno ime lahko zdaj vidijo tudi uporabniki drugih naprav s tehnologijo Bluetooth.

Nastavitve

Dolocite naslednje:

« Bluetooth — Izberite Vklju¢eno, da bi omogoili povezavo z drugo zdruzljivo napravo, ki podpira tehnologijo Bluetooth.

« Vidnost telefona — Izberite Viden vsem, da bodo druge naprave s tehnologijo Bluetooth lahko nasle vaso, €e ste nastavili
Bluetooth > Vkljuteno. (e ne Zelite, da bi uporabniki drugih naprav videli vaso, izberite moznost Skrit. (e izberete Skrit, lahko
seznanjene naprave vseeno najdejo vaso.
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+ Ime mojega telefona — Vnesite ime naprave. Ime je vidno drugim napravam, ki isCejo naprave Bluetooth v bliZini. Ime ima
lahko najvec 30 znakov.

« Nacin odd. kart. SIM — Izberite Vkljucen, da se bodo druge naprave, na primer zdruZljivi kompleti za vgradnjo v vozilo, lahko
prek kartice SIM vaSe naprave povezale v omreZje. Glejte "Profil dostopa do kartice SIM", str. 50.

(e se je funkcija Bluetooth izkljutila zaradi izbire profila Brez povezave, jo morate znova vkljuciti rotno.

Varnostni nasveti
Kadar povezovanja s tehnologijo Bluetooth ne uporabljate, izberite Bluetooth > Izklju€eno ali Vidnost telefona > Skrit.
Ne seznanjajte se z neznanimi napravami.

Posiljanje podatkov
Hkrati je lahko dejavnih vet povezav Bluetooth. Ce ste na primer povezani s slusalko, lahko hkrati prenadate datoteke v drugo
zdruZljivo napravo.

1. Odprite aplikacijo, v kateri je shranjen predmet, ki ga Zelite poslati.

2. Izberite predmet in MoZnosti > Poslji > Prek Bluetooth. Naprava poi$ce druge naprave s tehnologijo Bluetooth v dosegu in
jih prikaZe na seznamu.

:\é’: Nasvet: Ce ste Ze posiljali podatke prek povezave Bluetooth, se prikaZe seznam rezultatov prej$njega iskanja. Vet
naprav Bluetooth poisCete tako, da izberete Vet naprav.
3. Izberite Zeleno napravo in vzpostavite povezavo s pritiskom na krmilno paltko. Ce druga naprava pred prenosom podatkov
zahteva seznanitev, boste morali vpisati geslo.
4. Ko je povezava vzpostavljena, se prikaZze obvestilo Posiljam podatke.
Sporocila, poslana prek povezave Bluetooth, se ne shranijo v mapo Poslano v meniju Sporotila.

(e ste e posiljali predmete prek povezave Bluetooth, se prikaZe seznam prejsnjih rezultatov iskanja. Vet naprav Bluetooth
poislete tako, da izberete Vel naprav.

Da bi lahko uporabljali zvo¢no dodatno opremo Bluetooth, na primer opremo za prostoro¢no telefoniranje ali slusalke Bluetooth,
napravo seznanite z dodatno opremo. Geslo in dodatna navodila lahko najdete v priro¢niku za uporabo dodatne opreme. Da bi
vzpostavili povezavo z zvotno dodatno opremo, opremo vkljucite s pritiskom na tipko za vklop/izklop. Nekatere vrste zvocne
dodatne opreme se z napravo povezejo samodejno. Drugate odprite Seznanjene naprave, pomaknite se na dodatno opremo
in izberite MoZnosti > Povezi.

Znaki povezave Bluetooth
P Funkcija Bluetooth je vkljugena.

(B) Ko ikona utripa, se skusa naprava povezati z drugo napravo. (e je ikona vidna ves as, je povezava Bluetooth vzpostavljena.

Seznanjanje naprav

Izberite Meni > Povezov. > Bluetooth in se pomaknite desno, da odprete stran Seznanjene naprave.

Pred seznanjanjem ustvarite lastno geslo (1-16 mest) in se z uporabnikom druge naprave Bluetooth dogovorite, da naj uporabi
isto geslo. Naprave brez uporabniskega vmesnika imajo dolofeno geslo. Geslo potrebujete samo, ko prvic povezujete naprave.
Po seznanjanju lahko potrdite samodejno povezovanje. Glejte "Potrditev naprave", str. 50. Seznanjanje in potrjevanje
omogocata hitrejSe in preprostejSe povezovanje, saj vam povezave med seznanjenima napravama ni potrebno sprejeti vsakic,
ko vzpostavite povezavo.

Geslo za oddaljeni dostop do kartice SIM mora biti 16-mestno.
1. Izberite MoZnosti > Nova seznanj. napr.. Naprava zaCne iskati naprave Bluetooth v dosegu.

;\é’: Nasvet: Ce ste 7e posiljali podatke prek povezave Bluetooth, se prikaZe seznam rezultatov prej$njega iskanja. Vet
naprav Bluetooth pois€ete tako, da izberete Ve€ naprav.
2. lzberite Zeleno napravo in vnesite geslo. Isto geslo je treba vnesti tudi v drugo napravo.

3. lzberite Da za samodejno vzpostavljanje povezave med vaso in drugo napravo ali Ne za rono odobritev ob vsakem poskusu
vzpostavitve povezave. Po seznanitvi je naprava shranjena na strani seznanjenih naprav.

(e zelite seznanjeni napravi dodeliti vzdevek, ki je prikazan samo v vasi napravi, se pomaknite na seznanjeno napravo in izberite
Moznosti > Dolodi kratko ime.

(e Zelite zbrisati seznanitev, izberite Zeleno napravo in MoZnosti > Zbrii. Da bi zbrisali vse seznanitve, izberite MoZnosti > Zbrisi
vse.

- Nasvet: (e ste trenutno povezani z napravo in preklitete seznanitev z njo, se seznanitev takoj odstrani, povezava pa
se prekine.
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Potrditev naprave

(e zaupate seznanjeni napravi, ji lahko dovolite samodejno povezovanje z va$o napravo. Izbirate lahko med naslednjimi
moznostmi:

+ Nast. kot potrjeno — Povezave med vasSo in drugo napravo se lahko zdaj vzpostavljajo tudi brez vase vednosti. Dodatno
potrjevanje ni potrebno. To moznost uporabite za lastne naprave, kot so zdruZljive slusalke ali raCunalnik, ali za naprave ljudi,
ki jim zaupate.

» Nastavi kot nepotrj. — Zahteve za povezavo druge naprave je treba odobriti ob vsakem poskusu.

Prejemanje podatkov

(e Zelite prejeti podatke prek povezave Bluetooth, izberite Bluetooth > Vklju€eno in Vidnost telefona > Viden vsem. Ko prejmete
podatke prek povezave Bluetooth, naprava predvaja ton in vprasa, ali Zelite sporocilo sprejeti. (e ga sprejmete, se sporoCilo
shrani v mapo Prejeto menija Sporocila.

:‘é’: Nasvet: Do datotek v napravi ali na pomnilniski kartici lahko dostopate z zdruZljivo dodatno opremo, ki podpira profil
prenosa datotek (na primer s prenosnim racunalnikom).

Prekinitev povezave Bluetooth

Povezava Bluetooth se po poSiljanju ali prejemu podatkov samodejno prekine. Samo programska oprema Nokia PC Suite in
nekatere vrste dodatne opreme, kot so slusalke, ohranijo povezavo, tudi Ce ta ni dejavna.

Profil dostopa do kartice SIM

Ko je mobilna naprava v nacinu oddaljene kartice SIM, lahko klicete in sprejemate Klice le z zdruZljivo dodatno opremo, ki je z
njo povezana, na primer kompletom za vgradnjo v vozilo. Z napravo ni mogoce Klicati, razen programiranih Stevilk za klice v
sili. Ce Zelite klicati, morate najprej izkljuciti nacin oddaljene kartice SIM. Ce je naprava zaklenjena, vnesite kodo za odklepanije.

S profilom dostopa do kartice SIM lahko prek zdruZljivega kompleta za vgradnjo v vozilo dostopate do kartice SIM v napravi.
Tako za dostop do podatkov na kartici in povezavo z omrezjem GSM ne potrebujete dodatne kartice SIM.

(e Zelite uporabiti profil dostopa do kartice SIM, potrebujete:
 ZdruZljiv komplet za vgradnjo v vozilo, ki podpira tehnologijo Bluetooth.
 Veljavno kartico SIM v napravi.

Ve informacij o kompletih za vgradnjo v vozilo in zdruZljivosti z vaSo napravo lahko najdete na spletni strani
www.nokia.com ali v priro¢niku za uporabo kompleta.

Uporaba profila dostopa do kartice SIM

Izberite Meni > Povezov. > Bluetooth, da vkljuite vmesnik Bluetooth v napravi.

Oddaljeni dostop do kartice SIM omogocite tako, da se pomaknete na Nacin odd. kart. SIM in pritisnete krmilno palcko.
Vklju€ite vmesnik Bluetooth na kompletu za vgradnjo v vozilo.

S kompletom poistite zdruZljive naprave. Navodila lahko preberete v priroCniku za uporabo kompleta za vgradnjo v vozilo.
Na seznamu zdruZljivih naprav izberite svojo napravo.

V napravo vnesite geslo Bluetooth, prikazano na zaslonu kompleta za vgradnjo v vozilo, da se napravi seznanita.

Odobrite povezavo s kompletom. Izberite Meni > Povezov. > Bluetooth in se pomaknite na stran Seznanjene naprave. Izberite
komplet za vgradnjo v vozilo in vnesite geslo Bluetooth. Na vpraSanje, ali dovolite samodejno povezovanje, odgovorite Da.
Tako se bosta naprava in komplet lahko povezovala brez dodatnih odobritev. Ce izberete Ne, boste morali zahteve za
povezavo s to napravo potrditi vsakokrat znova.

N o gk wDNE

- Nasvet: Ce ste do kartice SIM Ze dostopali prek kompleta z aktivnim uporabniskim profilom, komplet samodejno poiste
napravo z vstavljeno kartico SIM. Ce je to vasa naprava in je vkljueno samodejno povezovanje, se komplet po vZigu
motorja vozila samodejno poveZe z omrezjem GSM.

Pri vklju¢enem profilu dostopa do kartice SIM lahko uporabljate tiste aplikacije naprave, ki ne potrebujejo omrezne povezave
ali storitev kartice SIM.

(e Zelite prekiniti oddaljeni dostop do kartice SIM, izberite Meni > Povezov. > Bluetooth > Natin odd. kart. SIM > Izkljucen.

B Infrardedi vmesnik

Ne usmerjajte infrardeih Zarkov nikomur v o&i in ne dovolite, da bi motili delovanje drugih infrardeCih naprav. Ta naprava je
laserski izdelek 1. razreda.

Prek infrardeCega vmesnika lahko poveZete dve napravi in med njima prenaSate podatke. Z zdruZljivo napravo lahko tudi
izmenjujete podatke, kot so vizitke, koledarske belezke in predstavnostne datoteke.
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Posiljanje in prejemanje podatkov
1. Prepricajte se, da sta infrardeta vmesnika obeh naprav obrnjena drug proti drugemu. PoloZaj naprav je pomembne;jsi od
kota ali oddaljenosti med njima.

2. lzberite Meni > Povezov. > Infrarde€ in pritisnite krmilno paltko, da vkljudite infrardedi vmesnik svoje naprave. Vkljudite Se
infrarde¢i vmesnik druge naprave.

w

Pocakajte nekaj sekund, da se vzpostavi povezava.

e

(e Zelite poslati datoteko, jo poisCite v aplikaciji ali nadzorniku datotek in izberite MoZnosti > Poslji > Prek IR.

(e se prenos podatkov ne zatne v manj kakor minuti po vklopu vmesnika, se povezava prekine in jo morate vzpostaviti znova.
Vsi predmeti, ki ste jih prejeli prek infrardeCe povezave, se shranijo v mapo Prejeto v meniju SporoCila.

(e napravi postavite predalet narazen, se povezava prekine, infrarde¢i vmesnik pa morate izkljuiti sami.

B Podatkovne povezave

Paketni podatki

Splosna paketna radijska storitev (GPRS) omogoca brezzitni dostop mobilnih telefonov do podatkovnih omreZij (omrezna
storitev). Med povezavo GPRS se podatki prenasajo po mobilnem omrezju v majhnih paketih. Prednost paketnega prenosa je,
da je omrezje zasedeno samo takrat, ko poteka posiljanje ali prejemanje podatkov. GPRS ucinkoviteje uporablja omrezna
sredstva ter omogoca hitro vzpostavljanje povezave in velike hitrosti prenosa.

Na storitev GPRS se morate naroCiti. VeC informacij o razpoloZljivosti storitve GPRS in naroCnini nanjo lahko dobite pri mobilnem
operaterju ali ponudniku storitev.

Storitev EGPRS (izboljsani GPRS) je podobna storitvi GPRS, vendar omogoca hitrej$e povezave. Ve€ informacij o razpolozZljivosti
storitve EGPRS in hitrostih prenosa lahko dobite pri mobilnem operaterju ali ponudniku storitev. Ce ste izbrali podatkovni nosilec
GPRS, bo naprava uporabila EGPRS, Ce bo ta v omrezju na voljo.

Med glasovnim klicem ni mogoce vzpostaviti povezave GPRS, obstojeca povezava GPRS pa je zadrZana, razen e omreZje ne
podpira dvojnega prenosa.

UMTS

UMTS (Universal Mobile Telecommunications System) je mobilni komunikacijski sistem tretje generacije. Poleg glasovnega in
podatkovnega prenosa omogoca tudi prenos zvoka in videa v brezZi¢ne naprave.

VaSa naprava lahko samodejno preklaplja med omrezjema GSM in UMTS.

Da bi izbrali, katero omreZje Zelite uporabljati, izberite Meni > Orodja > Nastavitve > OmreZje in omreZje v nastavitvi Omrezni
natin. Ce Zelite, da naprava samodejno preklaplja med omreZji, izberite Dvojni natin.

Omrezje GSM oznacuje ikona v omrezje UMTS pa 3G.

Kadar uporabljate napravo v omrezjih GSM in UMTS, je hkrati lahko aktivnih ve¢ podatkovnih povezav, ker si dostopne tocke

lahko delijo podatkovno povezavo. V omrezjih UMTS ostanejo podatkovne povezave aktivne tudi med glasovnimi Klici.
Omogocajo vam tudi na primer hitrejSe brskanje po spletu med pogovorom.

BrezzZi€no lokalno omreZzje (WLAN)

V nekaterih drzavah ali regijah, na primer v Franciji, je uporaba omreZzij WLAN omejena. Ve€ informacij lahko dobite pri pristojnih
sluzbah.

Funkcije, ki uporabljajo brezzitno omreZje LAN, ali omogoCenje tega, da te funkcije delujejo v ozadju, poveluje izrabo baterije
in skrajsuje njen Cas delovanja.

Naprava lahko zazna brezZitno lokalno omrezje in se z njim poveZze.

(e napravo premaknete na drugo mesto v omreZju WLAN ali zunaj dosega dostopne totke omreZja WLAN, se s funkcijo sledenja
lahko samodejno poveZe z drugo dostopno tocko istega omreZja. Dokler je naprava v dosegu dostopnih toCk istega omreZja,
bo ostala povezana z omrezjem.

:\éf: Nasvet: Brezzitna omrezna povezava se vzpostavi, kadar ustvarite podatkovno povezavo z uporabo internetne
dostopne totke WLAN. Povezava z omrezjem WLAN se konca ob prekinitvi podatkovne povezave.
Vasa naprava omogoca razli¢ne vrste komunikacije v omrezju WLAN. Deluje lahko v natinu infrastrukture in ad hoc.

* Infrastrukturni nain delovanja omogoca dve vrsti komunikacije: brezzi¢ne naprave se lahko prek dostopne totke omrezja
WLAN sporazumevajo med seboj ali z napravami v zicnem omreZzju LAN. Prednost tega nacina je vecji nadzor nad omreznimi
povezavami, saj te delujejo prek dostopne tocke. BrezzZicne naprave imajo dostop do storitev, ki so na voljo v obitajnem
Zitnem omrezju LAN: podatkovne zbirke podjetja, e-poste, interneta in drugih sredstev v omrezju.

« Vnacinu ad hoc lahko posiljate in prejemate podatke iz drugih naprav, ki podpirajo omreZje WLAN, na primer za tiskanje. Za
delovanije teh funkcij je morda potrebna dodatna aplikacija drugega proizvajalca. Dostopna totka omreZja WLAN ni potrebna.
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Preprosto doloCite ustrezne nastavitve in zacnite komunicirati. Vzpostavitev omrezja ad hoc je preprosta, vendar je
komuniciranje omejeno na naprave v dosegu, ki podpirajo zdruZljivo tehnologijo WLAN.

B Nadzornik povezav

Izberite Meni > Povezov. > Nadz. pov..
(e Zelite videti stanje podatkovnih povezav ali povezave prekiniti, izberite Akt.pod.povez..

Iskanje brezzi¢nih krajevnih omrezij (WLAN), ki so na voljo, zalnete z izbiro moZnosti Razpol. WLAN.

Prikaz in prekinitev aktivnih povezav
Q Opomba: Dejansko trajanje klicev, ki vam ga zaraCuna va$ mobilni operater, se lahko razlikuje — odvisno od vrste
omrezja, zaokroZevanja in podobnega.

V prikazu aktivnih povezav lahko vidite odprte podatkovne povezave: podatkovne klice, paketne podatkovne povezave in
povezave z omreZji WLAN.

(e Zelite videti podrobne informacije, izberite omreZno povezavo na seznamu in Moznosti > Podrobnosti. Vrsta prikazanih
informacij je odvisna od vrste povezave.

(e Zelite prekiniti omreZno povezavo, izberite povezavo na seznamu in Moznosti > Prekini.
Vse omrezne povezave prekinete tako, da izberete MoZnosti > Prekini vse.
Podrobne podatke o omrezju prikaZete tako, da pritisnete krmilno palcko.

Iskanje omrezij WLAN

(e Zelite poiskati razpoloZljiva brezzitna omreZja (WLAN) v dosegu, izberite Meni > Povezov. > Nadz. pov. > Razpol. WLAN. PrikaZe
se seznam najdenih omreZij.

Prikazani so seznam omreZij WLAN v dosegu, njihov omrezni nacin (infrastruktura ali ad hoc), kazalnik moci signala, kazalniki
Sifriranja v omreZzju in morebitna aktivna povezava naprave z omrezjem.

Podrobne podatke o omrezju prikazete tako, da pritisnete krmilno palcko.
(e Zelite ustvariti internetno dostopno tocko v omreZju, izberite Moznosti > Doloti dostop. totko.

B Modem

Izberite Meni > Povezov. > Modem.

Z zdruZzljivim racunalnikom lahko napravo uporabljate kot modem za dostop do spleta.

Preden uporabite napravo kot modem, poskrbite za naslednje:

* Pri ponudniku storitev ali ponudniku internetnih storitev se naroCite na ustrezne omrezne storitve.
 Potrebujete zdruZljiv racunalnik s podatkovnim kablom USB, vmesnikom Bluetooth ali infrarde¢im vmesnikom.
+ VraCunalniku morate imeti namesten programski paket Nokia PC Suite.

« Vratunalniku morate imeti namestene ustrezne gonilnike. Za kabelsko povezavo boste morda morali namestiti gonilnike,
ali pa boste morali namestiti ali posodobiti gonilnike za infrardeto povezavo ali povezavo Bluetooth. Po namestitvi paketa
Nokia PC Suite se ravnajte po navodilih na zaslonu ra¢unalnika, da namestite gonilnike in svojo mobilno napravo povezete
z raCunalnikom.

Po namestitvi paketa Nokia PC Suite in ustreznih gonilnikov za kabelsko povezavo v raCunalniku zaZenite Nokia PC Suite. Izberite
Connect to the Internet (Povezava z internetom) in se ravnajte po navodilih na zaslonu racunalnika.

Nekatere druge komunikacijske funkcije morda ne bodo dostopne med uporabo naprave kot modema.

B Mobilno navidezno zasebno omrezje

Izberite Meni > Orodja > Nastavitve > Povezava > NZO.

Mobilno navidezno zasebno omrezje (NZO) Nokia omogoca vzpostavitev zas€itene povezave z zdruZzljivim intranetom in
storitvami podjetja, kot je e-poSta. VaSa naprava se iz mobilnega omreZja po internetu poveze s prehodom NZO, ki deluje kot
vhodna vrata v zdruZljivo omreZje podjetja. Odjemalec NZO uporablja tehnologijo IP Security (IPSec). IPSec je skupek odprtih
standardov, ki zagotavljajo varno izmenjavo podatkov v omrezjih IP.

Pravilniki NZO doloCajo natin, ki ga odjemalec NZO in prehod NZO uporabljata za medsebojno preverjanje pristnosti, ter algoritme
Sifriranja za zasCito zaupnosti podatkov. Pravilnik NZO lahko dobite v svojem podjetju.

Aplikacija, s katero Zelite uporabljati NZO, mora biti povezana z dostopno totko NZO. Dostopno totko NZO sestavljata internetna
dostopna tocka in pravilnik NZO.
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Upravljanje NZO

V meniju Upravljanje NZO lahko delate s pravilniki NZO, strezniki pravilnikov, dnevniki NZO in geslom shrambe klju€ev. Pravilniki
NZO doloc€ajo nacin Sifriranja podatkov za prenos po nezas€itenih omreZjih. Geslo shrambe kljufev povetuje zascito zasebnih
kljucev.

Dostopnatocka je tocka, v kateri se naprava poveze zomrezjem z uporabo podatkovnega klica ali paketne podatkovne povezave.
Pred uporabo e-poste in velpredstavnostnih sporocil ali brskanjem po spletnih straneh morate doloCiti internetne dostopne
toCke za te storitve. Dostopne tocke NZO zdruZujejo pravilnike NZO z internetnimi dostopnimi to¢kami in tako omogocajo
ustvarjanje Sifriranih povezav.

(e Zelite upravljati navidezno zasebno omreZje, izberite Upravljanje NZO > MoZnosti > Odpri in eno od naslednjih moZnosti:

» Pravilnik NZO — Namestite, prikaZite ali posodobite pravilnike NZO.

« StreZniki praviln. NZO — Uredite nastavitve povezovanja s strezniki pravilnikov NZO, iz katerih lahko names€ate in
posodabljate pravilnike NZO.

» Dnevnik NZO — Prikazite dnevnik namestitev pravilnikov NZO, posodobitev in sinhronizacij ter drugih povezav NZO.

Upravljanje pravilnikov NZO

(e Zelite upravljati pravilnike NZO, izberite Upravljanje NZO > Pravilnik NZO > MoZnosti in eno od naslednjih moZnosti:

» Namesti pravilnik — Namestite pravilnik. Vnesite svoje uporabnisko ime in geslo za streZnik pravilnikov NZO. Uporabnisko
ime in gesla lahko dobite pri skrbniku sistema.

+ Doloti dost. to€. NZO — Ustvarite dostopno totko NZO, ki zdruZuje pravilnik NZO z internetno dostopno totko.

+ Posodobi pravilnik — Posodobite izbrani pravilnik NZO.

« Zbrisi pravilnik — Zbrigite izbrani pravilnik NZO. Ce zbrisete pravilnik NZO, se ta znova namesti med naslednjo sinhronizacijo
naprave s streznikom pravilnikov NZO, razen e je bil zbrisan tudi iz streznika. Tako se pravilnik NZO med sinhronizacijo zbrise
tudi iz naprave, Ce je bil zbrisan iz streznika.

(e Zelite upravljati streZnike pravilnikov NZO, izberite Strezniki praviln. NZO > MoZnosti > Odpri in eno od naslednjih moZnosti:

» Nov streZnik — Dodajte streznik pravilnikov NZO.
« Sinhr. s streznikom — Namestite novega ali posodobite izbrani pravilnik NZO.
« Zbrisi streznik — ZbriSite izbrani streznik pravilnikov NZO.

(e Zelite upravljati nastavitve streznikov pravilnikov NZO, izberite MoZnosti > Odpri > Nov streznik ali Uredi streznik in eno od
naslednjih moZnosti:

« Ime streZn. praviln. — Vnesite novo ime za streznik, ki ima lahko najve¢ 30 znakov.

+ Naslov strez. praviln. — Vnesite naslov streznika. Streznikovega naslova ni mogoce urejati, ko ste z njim povezani, da bi
namestili ali posodobili pravilnike NZO.

« Intern. dost. totka — Izberite internetno dostopno tocko za povezovanje s streznikom pravilnikov NZO.

« ZasC. geslo za kljute — Spremenite geslo za shrambo zasebnih kljucev. Geslo se ustvari samodejno, ko ga prvi€ potrebujete.

Prikaz dnevnika NZO

Izberite Upravljanje NZO > Dnevnik NZO > Odpri.

V dnevnik NZO se zapisujejo vasi obiski streznikov NZO za names€anje, posodabljanje in sinhroniziranje pravilnikov NZO ter vase
povezave NZO. Napake, opozorilain informacije oznatuje ikona na levi strani vpisa. Ce si Zelite podrobno ogledati vpis v dnevniku,
gaizberite. 0 kodah vzrokov v podrobnem prikazu porocajte skrbniku sistema; kode namre€ olaj$ajo iskanje vzrokov morebitnih
teZav s funkcijo NZO. Ko se dnevnik poveta na 20 KB, se najstarejsi vpisi zbrisejo in nadomestijo jih novi.

Izberite MoZnosti in eno od naslednjih moZnosti:

» OsveZi dnevnik — Posodobite dnevnik.
« Podisti dnevnik — Zbrisite vpise v dnevniku.

B E-postno podatkovno sledenje

Izberite Meni > Orodja > Nastavitve > Povezava > Skupine dostopnih tock.

Naprava omogocCa neopazno sledenje med tehnologijami brezzZitnega dostopa, kot sta WLAN in GPRS, ko uporabljate e-posto.
Podatkovno sejo lahko na primer zatnete doma in jo nadaljujete na poti do pisarne. Seja poteka neprekinjeno; naprava najprej
preklopi med omreZjema WLAN in GPRS, ko pa prispete v pisarno, zatne spet uporabljati omrezje WLAN.

Skupine dostopnih totk

(e Zelite ustvariti skupino dostopnih tock, izberite Skupine dostopnih totk > MoZnosti > Nova skupina. V polje Ime skupine
vpisite ime skupine. V polju Menjavanje povezave dolotite, ali naj bo na zaslonu naprave prikazan postopek zamenjave povezave.
V razdelku Dostopne totke izberite in uredite dostopne tocke, ki pripadajo tej skupini.
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Da bi dostopno totko dodali v izbrano skupino dostopnih tock, izberite Dostopne totke > MoZnosti > Dodaj dostopno tocko in
dostopno tocko, ki jo Zelite dodati.

Da bi uredili dostopno tocko v skupini dostopnih toCk, izberite dostopno totko in MoZnosti > Uredi.
Da bi dostopno tocko odstranili iz skupine dostopnih tock, izberite dostopno tocko in MoZnosti > Odstrani.

(e Zelite nastaviti, v kak$nem vrstnem redu naprava med neopaznim sledenjem i$te dostopne tocke, izberite skupino dostopnih
totk in Spremeni. Pomaknite se na Zeleno dostopno tocko in izberite MoZnosti > Povi$aj pomembnost ali ZniZaj pomembnost.

(e Zelite spremeniti nastavitve SMTP dostopne totke, izberite Zeleno dostopno totko v skupini, nato MoZnosti in eno od
naslednjih mozZnosti:

* Preglasi streznik SMTP — Spremenite trenutne nastavitve streznika SMTP.
* Streznik SMTP — Uredite ime streZnika ali naslov IP streznika.

« Varna povezava — lzberite, ali Zelite uporabljati zas€iteno povezavo.

» Uporabi overovitev — Izberite, ali Zelite uporabljati preverjanje pristnosti.
+ Uporabnisko ime — Uredite uporabnisko ime za streznik SMTP.

+ Geslo — Uredite geslo za streznik SMTP.

Konfiguracija skupin dostopnih totk za e-posto in sinhronizacijo

(e Zelite nastaviti skupino dostopnih totk za e-posto, izberite Meni > Sporotila > Nabiralnik > E-po$tne nastavitve > Nastavitve
povezave > Dohodna e-posta > Upor. dostopna totka > Moznosti > Spremeni in Zeleno skupino dostopnih tock.

(e Zelite nastaviti skupino dostopnih totk za sinhronizacijo, izberite Meni > Povezov. > Sinhronizacija > Profil > Moznosti >
Uredi > Nastavitve povezav > Dostopna totka > Spremeni in Zeleno skupino dostopnih tock.
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10.  Splet

Izberite Meni > Splet (omreZna storitev).

Splet je eden od dveh brskalnikov naprave. Z brskalnikom Splet lahko brskate po obi¢ajnih spletnih straneh. Te strani so napisane
v jeziku XHTML (Extensible Hypertext Markup Language) ali HTML (Hypertext Markup Language). Ce Zelite brskati po straneh
WAP, izberite Meni > Predstavn. > Storitve. Oba brskalnika uporabljata iste zaznamke. Povezave, prejete v sporoCilih, se odprejo
v brskalniku Storitve.

RazpoloZljivost storitev, njihovo ceno in tarife preverite pri svojem mobilnem operaterju oziroma ponudniku storitev. Ponudnik
storitev vam bo priskrbel tudi navodila za uporabo svojih storitev.

B Dostopne tocke

Da bi lahko brskali po spletnih straneh, konfigurirajte nastavitve internetne dostopne tocke. Da bi lahko uporabljali podatkovne
klice ali povezavo GPRS, mora mobilno omreZje podpirati ustrezno storitev, na kartici SIM pa mora biti vklju€ena storitev za
prenos podatkov. Naprava lahko glede na kartico SIM samodejno konfigurira nastavitve internetne dostopne tocke. Ce se to ne
zgodi, lahko pravilne nastavitve dobite pri ponudniku storitev.

:\é’: Nasvet: Nastavitve internetne dostopne totke boste morda prejeli od ponudnika storitev v posebnem besedilnem
sporocilu, mobilnega operaterja ali na spletni strani ponudnika storitev.

Nastavitve internetne dostopne toctko lahko vpisete tudi rocno. Glejte "Internetne dostopne tocke", str. 45.

B Brskanje po spletu

Po spletu lahko brskate tako, da izberete zaznamek in pritisnete krmilno paltko. Lahko pa tudi vnesete spletni naslov in pritisnete
krmilno paltko. Uporabljajte samo storitve, ki jim zaupate in ki zagotavljajo zadostno varnost in zas€ito pred skodljivo
programsko opremo.

:\é’: Nasvet: Ko zalnete vna3ati naslov, se izpisujejo naslovi iev obiskanih strani, ki ustrezajo vnesenemu besedilu. (e Zelite
odpreti spletno stran, jo izberite in pritisnite krmilno palcko.

Spletno povezavo odprete tako, da se pomaknete nanjo in pritisnete krmilno palcko. Na spletni strani so nove povezave

poddrtane in modre, Ze obiskane pa vijoli¢ne barve. Slike, ki vsebujejo povezave, so obdane z modrim okvirjem.

Naslovi obiskanih strani so shranjeni v mapi Samod. zaznamki.

Bliznjice na tipkovnici:

« Pritisnite 1, da bi odprli mapo Zaznameki.

* Pritisnite 2, da bi poiskali besedilo.

* Pritisnite 3, da se vrnete na prejSnjo stran.

= Stipko 5 preklapljate med odprtimi okni brskalnika.

* Pritisnite 8, da bi odprli pregled strani.

* Pritisnite 9, da bi odprli drugo spletno stran.

B Zaznamki

Na vasi napravi so lahko ob nakupu shranjeni zaznameki za strani, ki niso nikakor povezane s podjetjem Nokia. Nokia ne jamci
zavsebino teh straniin jih ne priporoca. Ce jih Zelite uporabljati, veljajo za njihovo vsebino in zas¢ito enaka varnostna priporo€ila
kot za druge strani.

Shranjen naslov spletne strani odprete tako, da izberete zaznamek in pritisnete krmilno palcko.

(e Zelite brskati po drugih spletnih straneh, izberite MoZnosti > Navigacijske mozn. > Pojdi na splet. nasl., vnesite naslov strani
in izberite Pojdi na.

Da bi zbrisali zaznamek, se pomaknite nanj in pritisnite vracalko.

Da bi dodali zaznamek, izberite Meni > Splet > MoZnosti > Upravit. zaznamkov > Dodaj zaznamek. Pomaknite se na Ime, da bi
vnesli opisno ime zaznamka, Naslov, da bi vnesli naslov spletne strani, Dostopna tocka, da bi zamenjali dostopno tocko za
povezavo s spletno stranjo in Uporabnisko ime, ali Geslo, da bi vnesli uporabnisko ime in geslo, Ce to zahteva ponudnik storitev.
Zaznamek shranite tako, da izberete Nazaj.

B Nalaganje predmetov

@ Pomembno: Names€ajte in uporabljajte samo aplikacije in drugo programsko opremo iz virov, ki zagotavljajo zadostno
varnost in za$€ito pred $kodljivo programsko opremo.
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NaloZite lahko razlitne predmete, kot so toni zvonjenja, slike, logotipi operaterja, teme in video posnetki. Ce Zelite naloZiti
predmet, ga izberite in pritisnite krmilno paltko. Ti predmeti so lahko brezplacni ali pa boste zanje morali platati. Nalozene
predmete prevzamejo ustrezne aplikacije naprave.

Ko zatnete s prenosom, se prikaZe seznam zatetih, zaustavljenih in dokon¢anih prenosov iz trenutne seje brskalnika. Ce si Zelite
ogledati seznam, lahko izberete tudi Moznosti > Orodja > Nalaganja. Izberite predmet na seznamu in nato Moznosti, da
zaustavite, nadaljujete ali prekinete zalete prenose oziroma odprete, shranite ali zbrisete dokonfane prenose.

Kupovanje predmetov:
1. (e Zelite naloZiti predmet, izberite povezavo in pritisnite krmilno pal¢ko.
2. lzberite ustrezno moznost za nakup izdelka.

3. Natan¢no preberite vse informacije. Da bi nadaljevali nalaganje, izberite Sprejmi. Da bi preklicali nalaganje, izberite
Preklici.

B Prekinjanje povezave

(e Zelite prekiniti povezavo in si stran v brskalniku ogledati brez povezave, izberite MoZnosti > Dodatne moZnosti > Prekini; te
pa Zelite prekiniti povezavo in zapreti brskalnik, pa izberite MoZnosti > Izhod.

Brisanje zaCasnega pomnilnika

Zatasni pomnilnik se uporablja za zatasno shranjevanje podatkov. Ce ste dostopali ali poskusili dostopiti do zaupnih podatkov,
za katere je potrebno geslo, izpraznite zacasni pomnilnik po vsaki uporabi. V njem se shranjujejo podatki ali informacije o
storitvah, do katerih dostopate.

(e Zelite poCistiti zatasni pomnilnik, izberite MoZnosti > Dodatne moZnosti > Potisti zat. pomniln..

B NoviCarski viri in spletni dnevniki

Izberite Meni > Splet > Spletni viri.

Viri so datoteke XML na razliCnih spletnih straneh, ki ponavadi vsebujejo naslove in ¢lanke o aktualnih novicah in drugih temah.
Na spletnih straneh se lahko narocite na zanimive vire. Izberite MoZnosti > Narodi.

:\é’: Nasvet: Spletni dnevnik je spletna stran, ki se nenehno posodablja. Avtorjeva osebnost je pogosto pomemben dejavnik
spletnega dnevnika.

Da bi naloZili spletni vir ali dnevnik, se pomaknite nanj in pritisnite krmilno paltko.
Da bi dodali spletni vir ali dnevnik, izberite MoZnosti > Upravljanje vira > Nov vir in vnesite informacije.

Da bi uredili spletni vir ali dnevnik, se pomaknite nanj, izberite MoZnosti > Upravljanje vira > Uredi in spremenite podatke.

B Nastavitve Splet

Izberite Meni > Splet > Moznosti > Nastavitve.
Dolocite naslednje:

« Dostopna totka — Da bi odprli spletne strani, se pomaknite na dostopno tocko in pritisnite krmilno paltko.

» NaloZi slike in zvoke — Da bi stran naloZili hitreje brez slik, izberite Ne. Med brskanjem po posameznih straneh se lahko Se
vedno odloCite za nalaganije slik. Izberite MoZnosti > PrikaZi slike.

* Privzeto kodiranje — Izberite pravilno kodiranje znakov za svoj jezik.

 Samodejni zaznamki — Izberite Vkljuteno, e Zelite, da se naslovi obiskanih spletnih strani samodejno shranjujejo v mapo
Samod. zaznamki. (e Zelite mapo skriti, izberite Skrij mapo.

 Velikost zaslona — Da bi spletne strani prikazali na celotnem zaslonu, izberite Celoten zaslon. Med brskanjem v
celozaslonskem nacinu lahko s pritiskom na levo izbirno tipko odprete MoZnosti in uporabite razpoloZljive moznosti.

 Domacta stran — Izberite stran, ki jo Zelite nastaviti za domaco stran. Izberite Privzeta, da bi uporabili domaco stran dostopne
tocke, Doloti uporabnik, da bi vnesli naslov domace strani, ali Upor. trenutno stran, da bi uporabili trenutno odprto spletno
stran.

+ Mini prikaz strani — Izberite, ali naj bo odprta stran prikazana pomanj$ano na vrhu zaslona.

+ Seznam obisk. strani — Izberite, ali naj bodo vidne pomanjSane obiskane strani, ko se boste v zgodovini brskanja Zeleli vrniti
nazaj.

« Piskotki — Izberite, Ce Zelite omogoCiti ali zavrniti poSiljanje in prejemanje piskotkov. Piskotki so informacije, ki jih omreZni
streZnik zbira o vasih obiskih razli¢nih spletnih strani. Potrebujete jih na primer pri spletnem nakupovanju, da do izvedbe
plaila ohranjajo informacije o izbranih izdelkih. Vendar lahko pride do zlorabe podatkov, kot je posiljanje neZelenih oglasov.

+ Skript Java/ECMA — Nekatere spletne strani lahko vsebujejo programske ukaze, ki vplivajo na njihov videz in delovanje v
razli¢nih brskalnikih. Da bi prepre(ili izvajanje teh skriptov, izberite Onemogocenao (¢e imate na primer teZave z nalaganjem).

« Varnostna opozorila — Izberite Prikazi ali Skrij, da omogoCite ali izklju€ite morebitna varnostna opozorila med brskanjem.
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+ Blokiraj pojav. okna — Izberite, ali dovolite pojavna okna. Nekatera pojavna okna so potrebna (na primer manjSa okna za
vpis e-postnega naslova), vendar lahko vsebujejo tudi nezelene oglase.

B Storitve

Izberite Meni > Predstavn. > Storitve (omreZna storitev).

Storitve je eden od dveh brskalnikov naprave. Aplikacija Storitve omogocta brsvkanje po straneh WAP, izdelanih za uporabo v
mobilnih napravah. Take strani lahko na primer ponujajo mobilni operateriji. Ce Zelite brskati po obi¢ajnih spletnih straneh,
odprite drugi brskalnik (v meniju Meni > Splet).

RazpoloZljivost storitev, njihovo ceno in tarife preverite pri svojem mobilnem operaterju oziroma ponudniku storitev. Ponudnik
storitev vam bo priskrbel tudi navodila za uporabo svojih storitev.

;\é’: Nasvet: Ce Zelite vzpostaviti povezavo, v pripravljenosti pridrZite tipko 0.
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11.  Aplikacije Pisarna

Izberite Meni > Pisarna.
Nekatere pisarniSke aplikacije niso na voljo v vseh jezikih.
Velikih datotek morda ne boste mogli odpreti ali pa bo odpiranje trajalo nekaj Casa.

B Nadzornik datotek

V aplikaciji Nadz. dat. lahko urejate vsebino ter lastnosti datotek in map. Nadzornik datotek omogoca odpiranje, ustvarjanije,
premikanje, kopiranje, preimenovanje ter iskanje datotek in map. Zaradi zascite avtorskih pravic nekaterih datotek morda ne
boste mogli posiljati.

Delo z datotekami

Odprite ustrezno mapo, poisCite Zeleno datoteko in izberite MoZnosti.

Izberite naslednje:

 Odpri — Odprite datoteko. PoisCite Zeleno datoteko in izberite OK.

+ Poslji — Posljite izbrane datoteke. PoisCite Zelene datoteke in izberite OK.

« Zbrisi — Zbrisite izbrane datoteke. Pois(ite Zelene datoteke in izberite PoCisti.

+ Premakni v mapo — (e Zelite premakniti datoteko ali mapo v drugo mapo, poisite Zeleno datoteko ali mapo ter izberite
OK. Premikanje ali brisanje privzetih map, kot sta Zvocni posnetki in Galerija, ni mogoce.

+ Kopiraj v mapo — Shranite kopijo datoteke ali mape v drugo mapo. PoisCite Zeleno datoteko ali mapo in izberite OK.

+ Nova mapa — Ustvarite mapo.

 0Oznaci/Opusti — Odprite podmeni.

* Preimenuj — Preimenujte datoteko ali mapo. PoisCite Zeleno datoteko ali mapo, vnesite novo ime in izberite OK.

« PoisCi — Poiscite doloCene datoteke ali mape. Izberite pomnilnik, v katerem Zelite iskati, in vnesite Zeleno besedilo.

« Sprejmi prek IR — Izberite, da naprava datoteko prejme prek infrardeCe povezave.

* Prikazi podrobnosti — Oglejte si informacije o datotekah.

+ Podrobnosti pomnil. — Preverite zasedenost pomnilnika naprave in pomnilniske kartice.

Iskanje datotek

1. (e Zelite iskati datoteke, izberite MoZnosti > Poisi.

2. lzberite pomnilnik, v katerem Zelite iskati.

3. Vpisite Zeleno besedilo in pritisnite krmilno palCko. PrikaZejo se datoteke in mape, ki vsebujejo iskano besedilo.
4. Izberite PoiCi, da bi iskanje ponovili.

B Dokumenti

Odpirate, urejate in shranjujete lahko dokumente, ustvarjene s programom Microsoft Word for Windows razliice 97 ali novejse.
Aplikacija ne podpira vseh funkcij in oblikovanja izvirnih datotek.

Izberite Meni > Pisarna > Docum..

(e Zelite odpreti obstojeti dokument, poistite mapo in dokument ter pritisnite krmilno paltko. Ce Zelite prebrati dokument,
izberite srednji prikaz.

;\é’: Nasvet: Zadnji uporabljeni dokument odprete tako, da izberete MoZnosti > Most recent files, izberete dokument in
pritisnete krmilno palcko.

Nov dokument ustvarite tako, da izberete MoZnosti > New file. Izberite Blank, Ce Zelite ustvariti nov dokument brez predloge,

ali Use template, da bi ustvarili dokument na podlagi obstojece predloge.

(e Zelite prebrati dokument, izberite srednji prikaz in MoZnosti. V dokumentu lahko poistete razlitne vrste predmetov, dokument
povecate ali pomanjsate, preklapljate med celozaslonskim in obicajnim prikazom ali prikazujete predmete, kot so slike. Lahko
tudi iSCete besedilo in urejate nastavitve aplikacije, kot so poveCava, drsenje in obravnava nevidnih znakov.

:\é’: Nasvet: (e berete vetji dokument in Zelite branje nadaljevati pozneje, izberite Nazaj, da bi dokument zaprli. Ne
preklopite na nacin urejanja.
Prikaz predmetov v dokumentu

(e Zelite prikazati vse predmete v dokumentu, kot so tabele, opombe, delovni zvezki in video posnetki, izberite srednji prikaz
in MoZnosti > Browse > Pages and objects.

(e Zelite odpreti tabelo ali opombo, se pomaknite na predmet ali njegovo ikono in dvakrat pritisnite krmilno paltko.
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e Zelite odpreti sliko, nadpovezavo ali sklic, se pomaknite na predmet in trikrat pritisnite krmilno palcko.
- Nasvet: Izberite MoZnosti > Back to reference, da bi se vrnili na povezavo predmeta.

Oblikovanje dokumentov
(e Zelite urediti dokument, vkljuite natin urejanja: izberite srednji prikaz in MoZnosti > Edit document.

(e Zelite urediti pisavo, izberite besedilo in MoZnosti > Format > Font. Spremenite lahko vrsto, velikost, barvo in ozadje pisave.
Izberite MoZnosti > Preview, da bi prikazali trenutno oblikovanje.

(e Zelite oblikovati slog pisave, izberite besedilo in MoZnosti > Format > Font formatting. Izberite ustrezno moZznost oblikovanja.
Dodate lahko krepko, lezece, pod€rtano in precrtano oblikovanje pisave ali prestavite besedilo v podpisani ali nadpisani polozaj.

(e Zelite oblikovati odstavek, ga izberite in MoZnosti > Format > Paragraph. Spremenite lahko poravnavo besedila, razmik med
vrsticami ter levi in desni rob.

(e Zelite vstaviti vrstitne oznake, vstavite kazalko v besedilo ali odstavek in izberite MoZnosti > Format > Bullets. Na strani z
vrsti¢nimi oznakami v nastavitvah oblikovanja lahko vrstitne oznake nastavite kot vidne.

(e Zelite spremeniti nastavitve obrob, izberite MoZnosti > Format > Borders. PrikaZe se trenutna obroba. Izberite obrobo, ki jo
Zelite spremeniti, in pritisnite krmilno palCko. Izberite slog in barvo obrobe. Izberite Nazaj > MoZnosti > Apply to in mesto. (e
na primer izberete Top, bodo nastavitve veljale za zgornjo obrobo.

(e Zelite v dokument vstaviti predmet, izberite Moznosti > Insert object. Pomaknite se na vrsto predmeta, ki ga Zelite vstaviti,
ter izberite MoZnosti > Insert new, da bi odprli ustrezni urejevalnik in ustvarili novo datoteko, ali Insert existing, da bi odprli
seznam obstojecih datotek.

(e Zelite spremeniti nastavitve sloga odstavka, izberite MoZnosti > Format > Style. Izberite slog, ki ga Zelite oblikovati, in
MozZnosti > Edit. I1zberite New style, da bi dodali nov slog. V prikazu urejanja sloga izberite MoZnosti > Format in Zeleni slog.
Spremenite lahko sloge pisave, oblikovanja, odstavkov, vrsti¢nih oznak in obrob.

(e Zelite shraniti dokument, izberite Moznosti > Saving options > Save as. Navedite ime datoteke in mesto, kamor jo Zelite
shraniti. Izberete lahko tudi vrsto datoteke.

Prikaz zgradbe dokumenta

(e Zelite videti oris dokumenta, izberite levi prikaz. Izberite MoZnosti > Expand ali Collapse, da bi prikazali samo glavna poglavja
ali vsa podpoglavja. Ce dokument vsebuje predmete, izberite MoZnosti > Display objects ali Display headings, da preklopite med
naslovi poglavij in seznamom predmetov.

:‘é’: Nasvet: (e Zelite odpreti poglavje v obitajnem prikazu, se pomaknite nanj in pritisnite krmilno paltko.

Predogled postavitve strani

Predogled postavitve strani odprete tako, da izberete prikaz na desni in MoZnosti.
DoloCite naslednje mozZnosti:

* Normal view — Prikaz odprte strani v obi¢ajnem prikazu.
« Pan and zoom — Povelanje prikaza postavitve strani.
« View — Izberite Full screen ali Normal screen, da bi preklopili med celozaslonskim in obi¢ajnim prikazom.

(e Zelite spremeniti velikost prikaza postavitve, izberite prikaz na desni, pomaknite se na Zeleno stran in izberite MoZnosti >
Pan and zoom. Nad postavitvijo strani se pojavi ¢rn izbirni okvir, ki prikazuje obmocje za povecavo. Izberite obmocje in
Moznosti > Zoom.

Izberite med naslednjimi moznostmi:

* Inali Out — Izberite In, da bi prikaz izbranega obmocja povecali za eno stopnjo, ali Out, da bi ga zmanjsali za eno stopnjo.
- Fit to screen — Stopnjo poveCave prilagodite tako, da bo stran ustrezala $irini zaslona.
* Ratio — Izberite stopnjo povelave, vnesite razmerje povetave med 10 in 999 ter izberite OK.

- Nasvet: Ko je prikazan izbirni okvir, se s krmilno paltko pomikajte levo, desno, gor ali dol po strani. Pritisnite tipko 5,
da izbirni okvir zmanjSate, in 0, da ga povecate. Pritisnite krmilno palko, da bi spremenili velikost prikaza izbranega
obmo(ja.

Iskanje besedila

(e Zelite poiskati del besedila v dokumentu, izberite MoZnosti > Find, vnesite besedilo v polje Find: in pritisnite krmilno paltko.

(e Zelite spremeniti moZnosti iskanja, kot sta razlikovanje velikih in malih ¢rk ter smer iskanja, izberite MoZnosti > Search
options.
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(e Zelite najti besedilni niz v dokumentu in ga zamenjati, v natinu urejanja izberite Moznosti > Find and replace. V polje Find:
vnesite besedilo, v polje Replace with: pa besedilo za zamenjavo. Izberite MoZnosti > Replace. Ko se prikaZe najdeno besedilo,
izberite Replace, da bi ga zamenjali in se pomaknili na naslednji zadetek, ali izberite Ignore, da bi presko(ili trenutni zadetek,
in Next, da bi se pomaknili na naslednjega.

:\éf: Nasvet: Ce Zelite preskotiti trenutni zadetek in se pomakniti na prej$njega ali naslednjega, se s krmilno paltko
pomaknite navzgor ali navzdol.

Urejevalnik tabel
Pregledujete lahko tabele, ustvarjene v aplikacijah, kot sta Dokumenti in MS Word.

Tabelo v datoteki prikazete tako, da se pomaknete na datoteko (okrog nje se prikaze prekinjena ¢rta) in premaknete krmilno
palcko.

(e Zelite zamenijati izbrano celico, se premaknite navzgor, navzdol, levo ali desno. (e je izbrana celica prevelika za vidno obmofje,
si lahko s pritiskom na krmilno paltko ogledate celo celico, preden jo zamenjate.

Besedilo v celici lahko uredite, Ce izberete celico in pritisnete krmilno palko. Urejanje koncate s ponovnim pritiskom krmilne
palcke.

Izberite MoZnosti in eno od naslednjih moznosti:

- Zoom — Povecajte ali pomanjsajte prikaz tabele ali uredite razmerje povecave.

« Format — Spremenite slog pisave, oblikovanja, odstavkov, vrsti¢nih oznak in obrob.
« Cell size — Spremenite velikost celic, vrstic in stolpcev.

+ Cells — Izberite moZnosti vstavljanja, brisanja, zdruZzevanja ali loCevanja celic.

« Copy table — Besedilo cele tabele kopirajte v odloZis¢e.

B Preglednice

Izberite Meni > Pisarna > Sheet.

Podatke lahko shranite v datoteko, ki ji pravimo delovni zvezek. Vsak delovni zvezek vsebuje vsaj en delovni list. Vsebuje lahko
tudi diagrame, ki temeljijo na podatkih z delovnega lista.

ObstojeCi delovni zvezek odprete tako, da poisCete mapo z datoteko in pritisnete krmilno palcko.

Nov delovni zvezek ustvarite tako, da izberete MoZnosti > New file. 1zberite Blank, da ustvarite novo datoteko brez uporabe
predloge, ali Use template, da bi ustvarili datoteko na podlagi obstojete predloge. V prikazu orisa izberite delovni list in pritisnite
krmilno paltko, da datoteko odprete.

:\é’: Nasvet: (e Zelite odpreti enega od zadnjih uporabljenih delovnih zvezkov, izberite MoZnosti > Most recent files.

Prikaz orisa

Prikaz orisa omogoCa odpiranje in pomikanje po delovnih listih, diagramih in poimenovanih celicah.

V prikazu orisaimavsak delovni list lastno ikono na glavni ravni. Pod glavno ravnijo so podelementi za diagrame in poimenovane
celice.

Prikaz orisa odprete tako, da se pomaknete na mapo in datoteko ter pritisnete krmilno palcko. Prikaz orisa se odpre. PrikaZe se
zadnji uporabljeni delovni list in nastavitve zan;.

(e zelite prikazati ali skriti diagrame in celice, se pomaknite na delovni list, pritisnite krmilno pal€ko in izberite MoZnosti >
Collapse ali Expand.

Delovne liste, diagrame ali poimenovane celice zbriSete ali preimenujete tako, da poistete predmet, izberete Moznosti >
Worksheet, Chart ali Named cell in ustrezno moZnost.

Nov delovni list, diagram ali poimenovano celico ustvarite tako, da poisCete mesto, kamor Zelite dodati nov predmet, in izberete
MoZnosti > Insert > Worksheet, Chart ali Named cell.

Upravljanje delovnih listov

(e Zelite v celice vnesti podatke, odprite prikaz delovnega lista. S krmilno paltko se pomaknite na celico in izberite Moznosti >
Show cell field > Edit cell field. Odpre se zgornje polje za urejanje. Vnesite podatke in izberite Kontano, da kontate urejanje.

Obseg celic izberete tako, da pridrzite dvigalko in se hkrati pomaknete desno.

Vrstice izberete tako, da premaknete kazalko na prvo celico v vrstici, pridrZite dvigalko in se pomaknete levo. Stolpce izberete
tako, da premaknete kazalko na prvo celico v stolpcu, pridrzite dvigalko in se pomaknete navzgor.

Cel delovni list izberete tako, da premaknete kazalko v celico A1, pridrzite dvigalko in se pomaknete navzgor in levo.
(e Zelite spremeniti prikaz delovnega lista, izberite Moznosti > View.
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Izberite med naslednjimi moznostmi:

 Pan worksheet — DoloCite velikost vidnega obmodja celega delovnega lista.

« Full screen — Preklopite na celozaslonski prikaz.

- Hide headers — Skrijte polje glave in tako sprostite vec prostora za mrezo delovnega lista.
« Hide gridlines — Skrijte mrezne Crte.

- Nasvet: Med celozaslonskim in obi€ajnim prikazom preklapljate s pritiskanjem tipke *. Pritisnite tipko 5, da poveCate
prikaz, ali 0, da ga zmanjSate.

(e Zelite v izbrano celico dodati opombo, izberite MoZnosti > Advanced options > Insert comment. Napisite opombo in izberite
OK. V desni zgorniji kot celice se doda majhen trikotnik, ki oznacuje opombo.

(e elite, da ostanejo vrstice med premikanjem vidne, izberite celico pod obmogjem, ki naj ostane vidno, in izberite MoZnosti >
Advanced options > Freeze panes. Ce Zelite, da ostanejo stolpci vidni, izberite celico na desni strani obmogja, ki naj ostane vidno,
in Moznosti > Advanced options > Freeze panes.

(e Zelite spremeniti velikost vrstic in stolpcev, izberite MoZnosti > Cell size > Row height ali Column width.

Da bi vrstice razvrstili od leve proti desni, izberite Zelene celice in MoZnosti > Advanced options > Sort rows. Izberete lahko
Stevilko vrstice, ki jo Zelite uporabiti za glavno merilo razvr§€anja. Spremenite lahko smer razvr§canja ter vkljucite ali izkljucite
razlikovanje velikih in malih ¢rk.

Da bi vrstice razvrstili od zgoraj navzdol, izberite Zelene celice in MoZnosti > Advanced options > Sort columns. Izberete lahko
stolpec, ki ga Zelite uporabiti za glavno merilo razvr§tanja. Spremenite lahko smer razvr§canja ter vkljudite ali izkljucite
razlikovanje velikih in malih ¢rk.

(e Zelite oblikovati slog pisave, izberite celice, v katerih bi radi spremenili slog pisave, in MoZnosti > Format > Font. Spremenite
lahko vrsto, velikost in barvo pisave ter barvo ozadja celice.

Da bi spremenili oblikovanje pisave, izberite Zelene celice in MoZnosti > Format > Font formatting. V celico lahko dodate krepko,
leZzeCe, podCrtano in precrtano oblikovanje pisave ali prestavite besedilo v podpisani ali nadpisani poloZa;.

(e Zelite poravnati vsebino celic, izberite Zelene celice in MoZnosti > Format > Alignment. Spremenite lahko vodoravno in
navpi¢no poravnavo in prelom vrstic ter visino prikazanih celic prilagodite tako, da bo prikazana celotna vsebina.

Da bi oblikovali obrobe celic, izberite Zelene celice in MoZnosti > Format > Borders. Spremenite lahko vse ali samo navpicne,
vodoravne, zgornje, spodnje, leve ali desne obrobe. Izberite MoZnosti > Spremeni, Ce Zelite urediti slog in barvo obrob.

Da bi spremenili obliko zapisa Stevilk, izberite Zelene celice in MoZnosti > Format > Numbers. Na seznamu izberite obliko zapisa
stevilk. Ce izbrana oblika zapisa vkljucuje decimalne vrednosti, vnesite Stevilo med 0 in 12, ki oznatuje Stevilo decimalnih mest.

/O Primer: (e Zelite primerjati in izratunati razlicne obrestne mere, lahko obliko zapisa tevilk nastavite na Percentage.

Delo s celicami

(e Zelite urediti celico, izberite Zeleno celico in MoZnosti > Show cell field > Edit cell field. Odpre se zgornje polje za urejanije.
Zalnite vnasati podatke. Ko urejanje koncate, izberite Koncano.

(e zelite vstaviti celice, izberite obmocje, kamor Zelite vstaviti nove celice, in MoZnosti > Cells > Insert. Celice lahko vstavite nad
izbranim obsegom (Shift cells down) ali levo od njega (Shift cells right). Ce izberete samo eno celico, se vstavi samo ena nova
celica. Ce izberete vet celic, se vstavi ustrezno Stevilo praznih celic. Vstavite lahko tudi novo vrstico ali stolpec.

Da bi zbrisali vsebino ali oblikovanje celic, izberite Zelene celice in MoZnosti > Cells > Clear. (e izberete Formats, se bo zbrisalo
samo oblikovanje izbranih celic, vsebina pa se bo ohranila. Uporabil se bo privzeti slog. Ce izberete Content, se bo zbrisala vsebina
izbranih celic, oblikovanje pa bo ostalo nespremenjeno. ZbriSete lahko oblikovanje in vsebino izbranih celic.

Da bi zbrisali celice, vrstice ali stolpce, izberite elemente, ki jih Zelite zbrisati, in Moznosti > Cells > Delete. ZbriSete lahko celo
vrstico ali stolpec. Ce izberete Shift cells left, se bodo izbrane celice zbrisale, celice na desni strani izbranih celic pa se bodo
pomaknile levo. Ce izberete Shift cells up, se bodo celice pod zbrisanimi celicami pomaknile navzgor.

:\é’: Nasvet: (e zbrisete podatke, na katerih temelji diagram, se odstranijo tudi podatki v diagramu.

Vstavljanje funkcij
Funkcije se uporabljajo za samodejne izraCune.

(e Zelite vstaviti funkcijo, najprej izberite celico. Izberite MoZnosti > Insert > Function in funkcijo na seznamu. Funkcija #MIN na
primer poisce najnizjo vrednost v Stevilski vsebini izbranega obsega celic, #AVERAGE izratuna povpretno vrednost v celicah,
#SUM pa sesteje vse vpisane vrednosti. Ko izberete funkcijo, pritisnite krmilno palko. Funkcija se vstavi v izbrano celico. Na
delovnem listu v oklepaje vnesite celice, ki jih Zelite vkljuditi v funkcijo, in pritisnite krmilno palcko.
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L Nasvet: Preden vstavite funkcijo, preverite, ali je moznost MoZnosti > Show cell field > Edit grid vkljuCena, izbrana celica

pa prazna ali je prvi znak v njej =.

\
~
—

Primer: (e Zelite na primer sesteti tevilke v celicah od C2 do C6 in vsoto prikazati v celici C7: Izberite celico C7 in
MoZnosti > Insert > Function. Izberite #SUM in pritisnite krmilno paltko. V oklepaje vnesite C2:C6 in pritisnite krmilno
palko. Vsota se prikaZe v celici C7.

(e si Zelite ogledati dodatne informacije o funkciji, izberite celico in MoZnosti > Insert > Function. Izberite funkcijo na seznamu
in MoZnosti > Description.

Spletne povezave
Spletno povezavo odprete tako, da izberete celico s spletno povezavo. Izberite MoZnosti > Link > Go to.

Spletno povezavo uredite tako, da najprej izberete celico s spletno povezavo. Izberite MoZnosti > Link > Edit. Uredite lahko
spletni naslov in ime povezave.

Ustvarjanje in spreminjanje diagramov
Ko spremenite podatke na listu, se diagram samodejno posodobi.

Da bi odprli diagram, odprite prikaz orisa, izberite delovni list in diagram ter pritisnite krmilno paltko. Ce diagrami niso vidni,
izberite MoZnosti > Expand.

(e Zelite ustvariti nov diagram, na delovnem listu izberite celice s podatki, ki jih Zelite vkljutiti v diagram, in izberite MoZnosti >
Insert > Chart. Da bi spremenili splo3ni videz obstojetega diagrama, odprite prikaz diagrama. Izberite MoZnosti > View >
Chart. Spremenite lahko ime diagrama in doloCite obmodje celic. Diagram lahko spremenite v dvo- ali tridimenzionalnega,
spremenite vrsto diagrama, barvo ozadja in osi. Pomaknite se desno, da bi diagramu in osi dodali ime.

(e Zelite diagram oblikovati podrobneje, odprite prikaz diagrama. Izberite MoZnosti > View in predmet, ki ga Zelite oblikovati.
Spremenite lahko niz ter nastavitve osi X in Y (na primer Crtice na oseh).

Iskanje besedila

(e Zelite poiskati besedilo, odprite prikaz delovnega lista in izberite MoZnosti > Poisti. V polje Find: vpisite besedilo in pritisnite
krmilno paltko. Ko najdete celico, ponovno pritisnite krmilno paltko, da poisCete naslednji zadetek.
Da bi spremenili vsebino in smer iskanja, izberite MoZnosti > Search options.

(e Zelite najti celico in zamenijati besedilo v njej, odprite prikaz delovnega lista in izberite MoZnosti > Poisi. V polje Find: vpisite
besedilo, ki ga Zelite zamenjati, v polje Replace with: pa novo besedilo in pritisnite krmilno pal¢ko. Ko je celica najdena, izberite
Replace, da zamenjate besedilo in se pomaknite na naslednji zadetek. Izberite Ignore, da preskocite trenutni zadetek, in Next,
da se premaknete na naslednjega.

:\é’: Nasvet: Ce Zelite preskoditi trenutni zadetek in se premakniti na prejsnjega ali naslednjega, se pomaknite navzgor ali
navzdol.

B Predstavitve

Odpirate, pregledujete, urejate in shranjujete lahko predstavitve, ustvarjene s programom Microsoft PowerPoint razliCice 97 ali
novejSe. Ustvarjate lahko tudi nove predstavitve. Aplikacija ne podpira vseh funkcij in oblikovanja izvirnih datotek.

Izberite Meni > Pisarna > Presentat..

ObstojeCo predstavitev odprete tako, da poiscete ustrezno mapo in datoteko ter pritisnete krmilno palcko.

;\é’: Nasvet: (e Zelite odpreti eno od zadnjih prikazanih predstavitev, izberite MoZnosti > Most recent files.

Novo predstavitev ustvarite tako, da izberete MoZnosti > New file. I1zberite Blank, da ustvarite predstavitev brez predloge, ali
Use template, Ce naj nova predstavitev temelji na obstojedi predlogi.

Obstojeco predlogo odprete tako, da poisCete ustrezno mapo in datoteko ter pritisnete krmilno paltko. I1zberite Open
template, Ce Zelite predlogo spremeniti, ali Use template, da bi na podlagi trenutne predloge ustvarili nov dokument.
Prikaz projekcij

Projekcijo zaZenete tako, da izberete Moznosti > Presentation.
Izberite med naslednjimi moznostmi:

- Manual — Roc¢no se premaknite z ene strani na drugo.

« Slide show—Z ene strani nadrugo se premaknite ro€no ali pa uporabite samodejno premikanje med stranmi. Dolociti morate
trajanje strani.

+ Manual looped — Po prikazu zadnje strani se projekcija zatne znova.
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+ Looped slide show — Po prikazu zadnje strani se projekcija samodejno zalne znova.

Med stranmi v projekciji se lahko premikate navzgor (na prejsnjo stran) ali navzdol (na naslednjo stran).
Projekcijo konCate tako, da pritisnete desno izbirno tipko.

Prikaz projekcij s podatkovnim projektorjem

Projekcije lahko prikaZete z zdruZljivim podatkovnim projektorjem ali drugim zdruZljivim sistemom za projekcijo.

(e si zelite ogledati projekcijo z zdruZljivim podatkovnim projektorjem, morate najprej namestiti gonilnike za projektor. Ce i
niso namesceni in napravi nista povezani, moznosti menija niso vidne. Za ve€ informacij se obrnite na proizvajalca projektorja
ali njegovega zastopnika.

(e Zelite prikazati projekcije s podatkovnim projektorjem, izberite predstavitev in MoZnosti > View > Data projector. Na seznamu
izberite Zeleno napravo. Izberite MoZnosti > Omogoti, da bi vkljucili prikazovanje vsebine zaslona. Projekcijo zazenete tako, da
izberete MoZnosti > Presentation > Slide show.

Prikazovanje projekcije s podatkovnim projektorjem kon€ate tako, da izberete MoZnosti > View > Disable data projector.

Delo z razli¢nimi prikazi
Aplikacijo Predstavitve sestavljajo razli¢ni prikazi, ki olajSujejo pregledovanje in ustvarjanje predstavitev.
Med razlinimi prikazi preklapljate tako, da premikate krmilno paltko desno in levo.

Prikaz postavitve

(e Zelite odpreti prikaz postavitve, izberite prikaz na sredini. Vidnost diagramov, opomb, tabel, slik in oblik omogo€ite ali
izkljucite tako, da izberete MoZnosti > Settings, se pomaknete na nastavitev in pritisnete krmilno palcko.

(e zelite delati v prikazu postavitve, izberite Moznosti. Urejate in vstavljate lahko nove strani, preklapljate med razli¢nimi prikazi,
zbrisete ali skrijete strani, prekliCete ali znova uveljavite zadnje spremembe in si ogledate predstavitev. Predstavitev lahko
shranite ali posljete drugi napravi. Morda ne bodo vedno na voljo iste moZnosti.

Prikaz orisa

Prikaz orisa je namenjen pomikanju po dolgih predstavitvenih dokumentih. Prikaz omogoca hitro pomikanje navzgor in navzdol,
prerazvr$tanje strani in urejanje predmetov.

Prikaz orisa odprete tako, da se pomaknete na levi prikaz. V tem prikazu ima vsaka stran svoj vnos na glavni ravni. Pod glavno
ravnijo je podraven za vsako besedilno polje in predmet.

(e si Zelite ogledati vsebino strani, izberite MoZnosti > Expand. Vsebino skrijete tako, da izberete Moznosti > Collapse. Vse vnose
strnete ali razSirite tako, da izberete MoZnosti > View > Collapse all ali Expand all.

(e Zelite spremeniti vrstni red strani, izberite stran, ki jo Zelite premakniti, in MoZnosti > Slide > Move. Pomaknite se navzgor
ali navzdol do novega mesta in izberite OK.

(e Zelite v predstavitev vstaviti nove strani, izberite MoZnosti > Insert new slide. Izberite predlogo za novo stran. Nova stran se
vstavi za trenutno izbrano stranjo.

(e Zelite kopirati, prilepiti ali odstraniti strani, izberite stran in MoZnosti > Slide > Kopiraj, Prilepi ali Delete.
V prikazu orisa prikazete ali skrijete strani tako, da izberete stran in Moznosti > Slide > Show ali Hide.

Prikaz opomb

V prikazu opomb lahko berete opombe, priloZzene stranem v predstavitvi. Dodajate lahko tudi svoje opombe.

(e Zelite odpreti prlkaz opomb, se pomaknite na desni prikaz. Vsaka stran ima svoj vnos na glavni ravni. Pod glavno ravnijo je
podraven za opombe. (e opombe niso vidne, izberite MoZnosti > View > Expand all. (e Zelite urediti opombo, se pomaknite
nanjo in pritisnite krmilno palcko.

Opombo dodate tako, da se pomaknete na stran brez opomb in izberete Moznosti > Create note.
(e Zelite zbrisati opombo, izberite opombo in Moznosti > Delete note.
Prikaz matrice strani

V prikazu matrice strani lahko vidite podrobnosti postavitve. (e uredite matrico strani, se spremembe uveljavijo navseh straneh
v predstavitvi.

Prikaz matrice strani odprete tako, da odprete prikaz postavitve in izberete Moznosti > View > Master slide. Matrico strani lahko
uredite, Ce pritisnete krmilno palcko.
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Urejanje predstavitev

(e Zelite urediti predstavitev, odprite prikaz postavitve in izberite MoZnosti > Edit slide. Naprej se pomikate s krmilno paltko
desno ali navzdol, nazaj pa levo ali navzgor. Izberite MoZnosti.

DoloCite naslednje moznosti:

« Add title, Add subtitle, Add text, Insert table, Insert image — V izbrano obmodcje dodajte novo besedilo ali predmet.

+ Edit text, Edit table, Edit document, Edit workbook — Uredite izbrani predmet.

« Edit object — Ce Zelite premakniti predmet, izberite Move, pomaknite se na Zeleni predmet in pritisnite krmilno pal¢ko.
Izberite Resize, da bi spremenili velikost predmeta. Pomaknite se desno in levo, da spremenite Sirino predmeta, ali navzgor
in navzdol, da spremenite viSino. Spremembe potrdite s pritiskom krmilne palke. Izberite Rotate, da predmet zavrtite.
Pomaknite se desno, da ga zavrtite v smeri urnih kazalcev, in levo, da ga zavrtite v nasprotni smeri. Spremembe potrdite s
pritiskom krmilne palcke. Izberite Properties, Ce Zelite urediti besedilo, ¢rto, obrobo ali ozadje predmeta.

+ Object — ZbriSite, kopirajte, prilepite ali dodajte povezavo do izbranega predmeta.

+ Object position — Spremenite poloZaj predmeta v predstavitvi glede na druge predmete: zgoraj, spodaj, spredaj ali zadaj.

» Insert — V predstavitev dodajte novo besedilno polje, sliko, obliko, tabelo ali opombo.

* Undo, Redo — Prekli€ite zadnje spremembe.

(e Zelite premakniti enega ali vet predmetov na strani, se pomaknite na vsak Zeleni predmet in pritisnite krmilno paltko. Izberite
MoZnosti > Marked objects > Move. Oznalene predmete premaknete tako, da se pomaknete navzgor, navzdol, levo ali desno.

Spremembe potrdite s pritiskom krmilne paltke. Oznacene predmete lahko tudi zbriSete, poravnate ali iz njih ustvarite skupino.
Skupina predstavlja nov predmet, ki ga lahko urejate. Oznatene predmete odznacite tako, da izberete MoZnosti > Unmark all.

(e Zelite dolotiti nastavitve pisave, odprite prikaz postavitve in izberite MoZnosti > Edit slide. Pomaknite se na besedilno polje
in izberite MoZnosti > Edit text > MoZnosti > Format > Font. Spremenite lahko vrsto, velikost in barvo pisave.

(e Zelite oblikovati slog pisave, odprite prikaz postavitve in izberite Moznosti > Edit slide. Pomaknite se na besedilno polje in
izberite Moznosti > Edit text > Moznosti > Format > Font formatting. I1zberite ustrezno moznost oblikovanja. Dodate lahko
krepko, leZzeCe, podCrtano in prertano oblikovanje pisave ali prestavite besedilo v podpisani ali nadpisani polozaj.

(e Zelite oblikovati odstavek, odprite prikaz postavitve in izberite MoZnosti > Edit slide. Pomaknite se na besedilno polje in
izberite MoZnosti > Edit text > MozZnosti > Format > Paragraph. Spremenite lahko poravnavo besedila, razmik med vrsticami in
Sirino levega roba.

(e Zelite spremeniti slog vrsti¢nih oznak, odprite prikaz postavitve in izberite MoZnosti > Edit slide. Pomaknite se na besedilno
polje in izberite Moznosti > Edit text > Moznosti > Format > Bullets. Vrstitne oznake lahko nastavite kot vidne, spremenite
njihovo vrsto ter dolodite velikost in barvo oznak.

(e zelite urediti nastavitve besedilnega polja, izberite prikaz postavitve in MoZnosti > Edit slide. Pomaknite se na besedilno polje
in izberite MoZnosti > Edit object > Properties. Spremenite lahko poloZaj besedila v polju in vkljucite ali izkljucite prelom vrstic.

(e Zelite spremeniti obrobe, izberite prikaz postavitve in MoZnosti > Edit slide. Poistite predmet, ki ima obrobe, in izberite
MoZnosti > Edit object > Properties. Spremenite lahko vse obrobe ali pa samo navpitno, vodoravno, zgornjo, spodnjo, levo ali
desno.

(e Zelite spremeniti oblikovanje ¢rt, izberite prikaz postavitve in MoZnosti > Edit slide. Poitite predmet, ki ima €rte, in izberite
Moznosti > Edit object > Properties. Spremenite lahko barvo Crte in slog elementov, kot so pike, Crtice ali debele Crte.

(e Zelite spremeniti nastavitve ozadja, izberite prikaz postavitve in MoZnosti > Edit slide. Pomaknite se na Zeleni predmet in
izberite MoZnosti > Edit object > Properties. Spremenite lahko barvo ozadja in vkljucite ali izkljucite vidnost preoblikovanega
ozadja.

Urejanje tabel

(e Zelite urediti tabelo, izberite prikaz postavitve in MoZnosti > Edit slide. Pomaknite se na tabelo in izberite MoZnosti > Edit
table. Aktivna celica je oznaCena. Ce Zelite zamenijati izbrano celico, se premaknite navzgor, navzdol, levo in desno. Izberite
Moznosti.

Izberite med naslednjimi mozZnostmi:

+ Edit text — Spremenite besedilo v izbrani celici.

» Insert — Dodajte vrstice ali stolpce v tabelo. Novi stolpec se vstavi levo od izbrane celice, nova vrstica pa nad izbrano celico.

+ Delete — Odstranite cele vrstice ali stolpce iz tabele.

 View — Povelajte ali pomanjajte prikaz tabele, prilagodite povetavo, da bo stran ustrezala Sirini zaslona, ali spremenite
stopnjo povetave.

 Undo in Redo — PrekliCite zadnje spremembe.

Iskanje besedila v predstavitvi

Besedilni niz lahko i$Cete v katerem koli prikazu predstavitve. Izberite MoZnosti > Pois¢i, vpisite besedilo v polje Find: in pritisnite
krmilno palcko.
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(e 7elite spremeniti nastavitve razlikovanja velikih in malih ¢rk ali iskanja celih besed, izberite MoZnosti > Search options.

Besedilni niz lahko poi$cete in zamenjate v katerem koli prikazu predstavitve. 1zberite MoZnosti > Pois¢i. V polje Find: vpisite

besedilo, ki ga Zelite zamenjati, v polje Replace pa novo besedilo in pritisnite krmilno paltko. Ko se prikaZe najdeno besedilo,
izberite Replace, da bi ga zamenjali in se pomaknili na naslednji zadetek, ali izberite Ignore, da bi preskotili trenutni zadetek,
in Next, da bi se pomaknili na naslednjega.

:\é’: Nasvet: (e Zelite preskofiti trenutni zadetek in se premakniti na prej$njega ali naslednjega, se pomaknite navzgor ali
navzdol.

B Izvoz vsebine zaslona

Vsebino na zaslonu naprave lahko prikaZete ve¢jemu Stevilu ljudi prek zdruZljivega podatkovnega projektorja ali drugega
zdruZljivega sistema za projekcijo. V podatkovni projektor jo lahko prenesete na primer prek povezave Bluetooth.

Izberite Meni > Pisarna > I1zvoz zaslona.

(e si Zelite ogledati vsebino zaslona z zdruZljivim podatkovnim projektorjem, morate najprej namestiti gonilnike za projektor.
Za veC informacij se obrnite na proizvajalca projektorja ali njegovega zastopnika.

Te funkcije ne podpirajo vse aplikacije. Prikazovanje vsebine na zunanjem zaslonu lahko vkljucite na dva nalina: v mapi
Pisarna ali aplikaciji, ki podpira to funkcijo.

Vklop prikazovanja vsebine na zunanjem zaslonu

(e Zelite vsebino zaslona prikazati s podatkovnim projektorjem, odprite aplikacijo lzvoz zaslona in izberite MoZnosti > Izberi
napravo. Na seznamu razpolozljivih naprav se pomaknite na Zeleno napravo in izberite OK. Izberite MoZnosti > Omogoti, da bi
vklju€ili prikazovanije vsebine zaslona.

Vsebino skrijete tako, da izberete MoZnosti > Skrij. Aplikacija I1zvoz zaslona se umakne v ozadje.

(e Zelite kontati prikazovanje vsebine zaslona, izberite MoZnosti > Onemogogi.

B Tiskanje

Z napravo lahko tiskate sporoCila ali datoteke. VkljuCite lahko predogled tiskalnega posla, doloCite moznosti postavitve strani,
izberete tiskalnik ali tiskate v datoteko.

Pred tiskanjem se prepricajte, da je vaSa naprava pravilno povezana s tiskalnikom.

(e Zelite natisniti sporoCilo ali datoteko, predmet odprite in izberite MoZnosti > Moznosti tiskanja.

DoloCite naslednje moznosti:

+ Tiskalnik — Na seznamu izberite tiskalnik.

» Natisni — Izberite obseg tiskanja — Vse strani, Sode strani ali Lihe strani.

« Obseg tiskanja — Izberite Vse strani v obsegu, Trenutna stran ali Dolo€ene strani.

+ Stevilo kopij — Izberite Stevilo kopij, ki jih Zelite natisniti.

+ Tiskanje v datoteko — Ce Zelite tiskati v datoteko, doloCite mesto datoteke.

Vseh sporocil morda ne boste mogli natisniti, na primer vecpredstavnostnih in drugih posebnih vrst sporocil.
(e si Zelite pred tiskanjem ogledati datoteko ali sporotilo, izberite Moznosti > Moznosti tiskanja > Predogled.
Spreminjanje postavitve strani pred tiskanjem

(e Zelite pred tiskanjem spremeniti postavitev strani, izberite MoZnosti > Moznosti tiskanja > Priprava strani in enega od

naslednjih zavihkov:

* Vel. papir. — Spremenite velikost in postavitev papirja ter prilagodite njegovo viSino in Sirino.

* Robovi — Spremenite Sirino levega, desnega, zgornjega in spodnjega roba.

« Glava — Glava lahko vsebuje najve¢ 128 znakov. Nastavite lahko razdaljo med glavo in besedilom ter vkljucite prikaz glave
na prvi strani dokumenta.

» Noga — Noga lahko vsebuje najvet 128 znakov. Nastavite lahko njeno razdaljo od besedila.

(e Zelite dodati ali zbrisati tiskalnik, izberite Meni > Pisarna > Tiskalniki > Moznosti > Dodaj ali Zbrisi.
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Izberite Meni > Pripomodki.
Meni Pripomotki vsebuje orodja, s katerimi lahko razvrs€ate in urejate podrobnosti o razli¢nih zasebnih in poslovnih dogodkih.
Koledar—Glejte "Koledar", str. 42.

M Belezke

Izberite Meni > Pripomotki > Belezke.

V aplikaciji BeleZke lahko ustvarjate belezke in jih posiljate drugim napravam ter shranjujete prejete datoteke z neoblikovanim
besedilom (v obliki .txt).

(e Zelite ustvariti novo belezko, izberite MoZnosti > Nova belezka, napisite besedilo in pritisnite Kon€ano.

V glavnem prikazu Belezke so lahko na voljo naslednje moZnosti:

* Odpri — Odpiranje izbrane belezke.

+ Poslji — Ce Zelite izbrano beleZko poslati, izberite enega od natinov posiljanja.

+ Nova belezka — Ustvarjanje nove belezke.

* Zbridi — Brisanje izbrane belezke.

 Oznali/Opusti — Izberite eno ali ve€ belezk in na njih uporabite Zeleni ukaz.

« Sinhronizacija— Izberite Zani, da bi zaCeli sinhronizacijo, ali Nastavitve, da bi dolodili sinhronizacijske nastavitve za belezko.

Med pregledovanjem belezke izberite MoZnosti > Poisti, da bi v njej poiskali telefonsko Stevilko, naslov internetnega telefona,
e-postni naslov ali spletni naslov.

B Kalkulator

@ Opomba: Ta kalkulator je namenjen preprostim izratunom; njegova natantnost je omejena.

Izberite Meni > Pripomocki > Kalkulator.

(e Zelite ratunati, vpisite prvo stevilko v izratunu. Pomaknite se na Zeleno funkcijo na seznamu, na primer setevanije ali
odStevanje, in jo izberite. Vnesite drugo Stevilo in izberite =. Decimalno vejico dodate s tipko #.

Kalkulator izvaja operacije v enakem vrstnem redu, kakor jih izberete. Rezultat izraCuna ostane v polju urejevalnika in ga lahko
uporabite kot prvo Stevilo novega izraCuna.

RezultatizraCunashranite tako, daizberete MoZnosti > Pomnilnik > Shrani. Shranjeni rezultat zamenja prejsnje shranjeno Stevilo
v pomnilniku.

(e Zelite rezultate v pomnilniku uporabiti pri izratunu, izberite Moznosti > Pomnilnik > Prikliti.
(e Zelite prikazati zadnji shranjeni rezultat, izberite Moznosti > Zadnji rezultat.

Z zapiranjem kalkulatorja ali izklopom naprave ne zbrisete vsebine pomnilnika. Ko naslednji¢ uporabljate kalkulator, lahko
prikliCete zadnji shranjeni rezultat.

B Pretvornik
Izberite Meni > Pripomocki > Pretvornik.
Natan¢nost pretvornika je omejena, pojavijo se lahko napake zaradi zaokrozevanja.

Pretvarjanje koli€in

1. Pomaknite se na polje Vrsta in izberite MoZnosti > Vrsta pretvorbe, da bi odprli seznam koli¢in. Pomaknite se na Zeleno
koli¢ino in izberite OK.

2. Pomaknite se na prvo polje Enota in izberite MoZnosti > Izberite enoto. Izberite mersko enoto, iz katere Zelite pretvarjati, in
OK. Pomaknite se na naslednje polje Enota in izberite mersko enoto, v katero Zelite pretvarjati.

3. V prvo polje Kolifina vnesite vrednost, ki jo Zelite pretvoriti. Drugo polje Kolitina se samodejno spremeni in prikaze
pretvorjeno vrednost.

Nastavitev osnovne valute in menjalnega tecaja
@ Opomba: Ko zamenjate osnovno valuto, morate vnesti nove menjalne te€aje, saj se vsi prej nastavljeni teaji zbrisejo.

Pred preratunavanjem valut morate izbrati osnovno valuto in vnesti menjalne tecaje. Te€aj osnovne valute je vedno 1.Z osnovno
valuto se ugotavlja menjalne tecaje za druge valute.

1. (e Zelite nastaviti menjalni tetaj za enoto valute, se pomaknite na polje Vrsta in izberite Moznosti > Tetaji.
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2. Odpre se seznam valut, osnovna valuta je prikazana na vrhu. Pomaknite se na valuto in vnesite Zeleni menjalni teaj za enoto
valute.

3. (e Zelite zamenjati osnovno valuto, se pomaknite na Zeleno valuto in izberite MoZnosti > Nastavi kot osn. val..
4. Izberite Kon€ano > Da, da bi shranili spremembe.
Ko vpisete vse potrebne menjalne tecaje, lahko zanete preracunavati valute.

B Telefonski predal
Izberite Meni > Pripomodki > Tel. predal.

Ko prvit odprete telefonski predal, vas naprava vprasa za Stevilko telefonskega predala. Ce Zelite $tevilko spremeniti, izberite
MoZnosti > Spremeni $tevilko. PokliCete jo tako, da izberete MoZnosti > Poklii telef. predal.

:‘é’: Nasvet: (e Zelite v pripravljenosti poklicati svoj telefonski predal (omreZna storitev), pridrzite tipko 1 ali pritisnite 1 in
klicno tipko.
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13.  Upravljanje podatkov in programske opreme

B Nadzornik aplikacij

Izberite Meni > Orodja > Nadzor.apl..

Ko odprete meni Nadzornik aplikacij, vidite vse namesCene programske pakete, njihovaimena, razlicice, vrste in velikosti. Oglejte
si podrobnosti namescenih aplikacij, odstranite jih iz naprave in doloCite nastavitve za namestitev.

Namestitev aplikacij in programske opreme

@ Pomembno: Aplikacije namescajte le iz virov, ki nudijo ustrezno zasCito proti Skodljivi programski opremi.

V napravo lahko namestite dve vrsti aplikacij in programske opreme:

+ Aplikacije in programsko opremo, ki so izdelane za va3o napravo oziroma so zdruZljive z operacijskim sistemom Symbian.
Te namestitvene datoteke imajo pripono sis.

» Aplikacije J2ME™, zdruZljive z operacijskim sistemom Symbian. Namestitvene datoteke aplikacij Java imajo pripono .jad ali .jar.

Namestitvene datoteke lahko v svojo napravo prenesete iz raunalnika ali z brskalnikom ali pa jih prejmete v
velpredstavnostnem sporoCilu, v prilogi e-postnega sporocila ali prek povezave Bluetooth. (e datoteko prenesete s programsko
opremo Nokia PC Suite, jo shranite v mapo C:\nokia\installs v napravi.

Med namestitvijo naprava preveri celovitost paketa, ki ga nameravate namestiti. PrikaZe tudi informacije o izvedenih
preverjanjih, vi pa lahko izberete, ali boste namestanje prekinili ali nadaljevali.

(e namestite aplikacije, za katere je potrebna omreZna povezava, bo morda naprava med uporabo teh aplikacij porabila vet
energije.

Pregled in odstranitev programske opreme
Pregledate lahko podrobnosti names€enih aplikacij ali jih odstranite iz naprave.
(e si Zelite ogledati podrobnosti namestenega programskega paketa, izberite aplikacijo in Moznosti > Prikazi podrobnosti.

(e Zelite odstraniti programsko opremo, odprite meni Nadzornik aplikacij in izberite Moznosti > Odstrani.

(e odstranite programsko opremo, jo lahko ponovno namestite samo, ¢e imate izvirni namestitveni paket ali varnostno kopijo,
ki vsebuje odstranjeni paket. (e programski paket odstranite, morda ne boste mogli vet odpirati datotek, ustvarjenih z njim.
(e je odstranjeni programski paket potreben za delovanje drugega programskega paketa, utegne ta paket prenehati delovati.
Podrobnosti najdete v dokumentaciji names€ene programske opreme.

Prikaz dnevnika namestitev

Da bi odprli dnevnik namestitev, izberite MoZnosti > PrikaZi dnevnik. Na seznamu so prikazani names¢ena in odstranjena
programska oprema ter datumi namestitve ali odstranitve. Ce imate po namestitvi programske opreme teZave z napravo, lahko
na tem seznamu poiscete programski paket, ki jih morda povzroca. S podatki na njem si lahko pomagate tudi pri odkrivanju
tezav zaradi nezdruZljivosti posameznih programskih paketov.

Nastavitve

Da bi spremenili nastavitve, izberite MoZnosti > Nastavitve in eno od naslednjih mozZnosti:

« Zbri&i — Po namestitvi se namestitvena datoteka programskega paketa zbrie iz naprave. Ce nalagate programske pakete v
spletnem brskalniku, je poraba pomnilnika manjsa. Ce Zelite namestitveni programski paket shraniti, da bi ga lahko znova
namestili, te moZnosti ne izberite ali pa njegovo kopijo shranite v zdruzZljiv ratunalnik ali na CD.

« Izberite jezik: — Ce programski paket vsebuije vet jezikovnih razlitic programske opreme, izberite tisto, ki jo Zelite namestiti.

- Vrsta— Dolocite, katere aplikacije Zelite namestiti. Lahko se odloCite samo za namestitev aplikacij s preverjenimi certifikati.
Ta nastavitev velja samo za aplikacije za operacijski sistem Symbian (datoteke .sis).

Dolocanje varnostnih nastavitev aplikacij Java

Da bi dolotili varnostne nastavitve aplikacij Java, izberite MoZnosti > Nastav. skupine apl..

DoloCite lahko, do katerih funkcij ima aplikacija dostop. Vrednost, dolotena za vsako funkcionalnost, je odvisna od varnostne
domene programskega paketa.

+ OmreZni dostop — Vzpostavitev podatkovne povezave z omrezjem.

« Sporo€ila — Posiljanje sporocil.

» Samodejni zagon apl. — Samodejno odpiranje aplikacije.

» Povezovanje — Vzpostavitev lokalne podatkovne povezave, kot je Bluetooth.
« Velpredstavnost — Snemanije slik, video posnetkov ali zvoka.
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+ Branje up. podatkov — Branje koledarskih vpisov, imenika ali drugih osebnih podatkov.
+ Urejanje up. podatk. — Dodajanje osebnih podatkov, kot so vpisi v imeniku.

DoloCite lahko, kako bo naprava zahtevala potrditev dostopa aplikacije Java do njenih funkcij. 1zberite eno od teh vrednosti:

« Vedno vprasaj — lIzberite, Ce Zelite, da aplikacija Java zahteva vaSo potrditev ob vsaki uporabi funkcije.

+ Vpradaj enkrat — Izberite, Ce Zelite, da aplikacija Java zahteva vaSo potrditev samo ob prvi uporabi funkcije.
+ Vedno dovoljeno — Dovolite, da aplikacija uporablja funkcije brez vaSe potrditve.

» Nidovoljeno — Izberite, da aplikacija ne bo mogla uporabljati funkcije.

Varnostne nastavitve napravo $(itijo pred nevarnimi aplikacijami Java, ki bi morda uporabljale funkcije naprave brez vasega
dovoljenja. Vedno dovoljeno izberite samo, ¢e poznate ponudnika in aplikaciji zaupate.

B OmreZna storitev konfiguracije na daljavo
Izberite Meni > Povezovanje > Nadz. nap..

Vzpostavite lahko povezavo s streznikom in prejmete konfiguracijske nastavitve za napravo. Profile streznikov in razli¢ne
konfiguracijske nastavitve boste morda prejeli od mobilnega operaterja, ponudnika storitev ali oddelka za informacijsko
tehnologijo v podjetju. Te nastavitve lahko vklju€ujejo nastavitve povezave in druge nastavitve, ki jih uporabljajo razlicne
aplikacije naprave. Morda ne bodo vedno na voljo iste mozZnosti.

Povezavo za konfiguracijo na daljavo navadno vzpostavi streznik, ko je treba posodobiti nastavitve naprave.

Nastavitve konfiguracije na daljavo

V glavnem prikazu aplikacije Nadz. nap. izberite MoZnosti in eno od naslednjih moznosti:

« Zatni konfiguracijo — Vzpostavite povezavo s streznikom in prejeli boste konfiguracijske nastavitve za napravo.

 Nov profil streznika — Ustvarite nov profil streznika.

« Uredi profil — Spremenite nastavitve profila.

* Zbrisi — Odstranite izbrani profil.

« OmogoCi nastavljan. — Omogocite prejemanije konfiguracijskih nastavitev od streznikov, za katere imate nastavljen profil,
in jim dovolite konfiguracijo.

« Onemogoti nastav. — Preprecite prejemanje konfiguracijskih nastavitev od vseh streznikov, za katere imate profile.

* PrikaZi dnevnik — Prikazite dnevnik konfiguracije za izbrani profil.

Ustvarjanje novega profila konfiguracije

(e Zelite ustvariti nov profil streznika konfiguracije, izberite MoZnosti > Nov profil streZnika in eno od naslednjih nastavitev.
Pravilne vrednosti lahko dobite pri ponudniku storitev.

+ Ime streZznika — Vnesite ime streznika konfiguracije.

+ ID streznika — Vnesite enolini ID, ki oznaluje streznik konfiguracije.

» Geslo streZnika — Vnesite geslo, po katerem bo streznik prepoznal vaso napravo.

« Nacin seje — Izberite Zeleno vrsto povezave.

« Dostopna totka — Izberite dostopno tocko, ki jo Zelite uporabiti za povezavo, ali ustvarite novo. Lahko tudi izberete, da vas
naprava ob vsakem zaletku povezovanja vprasa po dostopni tocki.

» Naslov gostitelja — Vnesite spletni naslov streznika konfiguracije.

» Vrata — Vnesite Stevilko vrat streZnika.

+ Uporabni3ko ime — Vnesite svoje uporabnisko ime za streznik konfiguracije.

+ Geslo — Vnesite svoje geslo za uporabo streznika konfiguracije.

+ Dovoli sprem. nastav. — Izberite Da, Ce Zelite streZniku dovoliti, da zatne konfiguracijsko sejo.

« Sprejmi vse zahteve — Izberite Da, ¢e noCete vsakokrat znova potrjevati, da lahko streznik zatne konfiguracijo.

B Sinhronizacija podatkov

Meni > Povezovanje > Sinhroniz..

Z moznostjo Sinhroniz. sinhronizirajte imenik, koledar ali belezke z ustreznimi aplikacijami v zdruZljivem racunalniku ali
internetnem strezniku. Sinhronizacijske nastavitve so shranjene v profilu za sinhronizacijo. Za sinhronizacijo na daljavo
aplikacija uporablja tehnologijo SyncML. Informacije o zdruzljivosti s SyncML dobite pri ponudniku aplikacij, s katerimi zelite
sinhronizirati podatke.

Morda ne boste mogli vedno sinhronizirati istih aplikacij. Za ve€ informacij se obrnite na svojega ponudnika storitev.
:\é’: Nasvet: Sinhronizacijske nastavitve lahko prejmete od ponudnika storitev v sporo€ilu.

Ustvarjanje profila za sinhronizacijo

(e Zelite ustvariti profil, izberite MoZnosti > Nov profil za sinhroniz. in eno od naslednjih moZnosti:
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Ime profila za sinhr. — Vnesite ime za profil.
Aplikacije — Izberite aplikacije za sinhronizacijo s profilom.
Nastavitve povezav — Dololite potrebne nastavitve povezave. Informacije lahko dobite pri ponudniku storitev.

(e Zelite urediti obstojet profil, izberite Moznosti > Uredi profil za sinh..

Profili za sinhronizacijo

V glavnem prikazu Sinhroniz. izberite MoZnosti in eno od naslednjih moznosti:

« Sinhroniziraj — Podatke v izbranem profilu sinhronizirajte z oddaljeno zbirko podatkov.

+ Nov profil za sinhroniz. — Ustvarite profil za sinhronizacijo. Za aplikacijo lahko ustvarite veC profilov za sinhronizacijo, kar
omogoca zamenjavo uporabljenega podatkovnega nosilca ali oddaljene zbirke podatkov, s katero sinhronizirate napravo.

+ PrikaZi dnevnik — Oglejte si Stevilo dodanih, posodobljenih in zbrisanih vpisov ob zadnji sinhronizaciji s profilom.

* ZbriSi — Odstranite izbrani profil.

Nastavitve povezave za sinhronizacijo

(e Zelite ustvariti nastavitve povezave novega profila, izberite Nov profil za sinhroniz. > Nastavitve povezav in eno od naslednjih
moznosti:

- Razlitica streZnika — Izberite razliCico protokola SyncML, ki jo lahko uporabljate s streznikom.

- ID streznika — Vpisite streznikovo kodo ID. Ta nastavitev je na voljo samo, Ce za razlicico protokola SyncML izberete 1.2.

 Podatkovninosilec— Izberite podatkovni nosilec, da bi med sinhronizacijo vzpostavili povezavo z oddaljeno zbirko podatkov.

+ Dostopna totka — Izberite dostopno tocko, ki jo Zelite uporabiti za povezavo za sinhronizacijo, ali ustvarite novo dostopno
tocko. Lahko tudi izberete, da vas naprava ob zacetku sinhronizacije vprasa po dostopni tocki.

» Naslov gostitelja — Vnesite spletni naslov streZnika, ki vsebuje zbirko podatkov, s katero Zelite sinhronizirati napravo.

+ Vrata — VpiSite Stevilko vrat streZnika oddaljene zbirke podatkov.

 Uporabnidko ime — Vnesite uporabnisko ime, s katerim bo streznik prepoznal vaSo napravo.

» Geslo — Vnesite geslo, s katerim bo streznik prepoznal vaso napravo.

« Dovoli sin. zahteve — (e Zelite, da se sinhronizacija za¢ne v streZniku oddaljene zbirke podatkov, izberite Da.

« Spr. vse sin. zahteve — (e Zelite, da vas naprava pred sprejetjem sinhronizacije iz streznika vpra$a za potrditev, izberite Ne.

+ Preverjanje omrezja — (e Zelite, da omreZje pred sinhronizacijo preveri pristnost naprave, izberite Da. Vnesite omrezno
uporabnisko ime in omrezno geslo.

DoloCite sinhronizacijske nastavitve za Imenik

Da bi dolotili sinhronizacijske nastavitve za aplikacijo Imenik, oznacite Zeleni profil ter izberite MoZnosti > Uredi profil za
sinh. > Aplikacije > Imenik > Uredi in eno od naslednjih moznosti:

« Vkljuti v sinhronizacijo — Izberite, ali Zelite imenik sinhronizirati s tem profilom za sinhronizacijo.

+ Oddaljena zbirka podat. — Vnesite pot do zbirke podatkov, s katero Zelite sinhronizirati imenik.

+ Lokalna pod. zbirka — Ce imate v napravi vet imenikov, izberite tistega, ki ga Zelite sinhronizirati s tem profilom za
sinhronizacijo.

« Vrsta sinhronizacije — Izberite imenik za sinhronizacijo. Pomaknite se na Obicajna, da bi podatke v napravi sinhronizirali z
oddaljeno zbirko podatkov in obratno, Samo v telefon, da bi podatke oddaljene zbirke sinhronizirali z napravo, ali Samo v
streZnik, da bi podatke v napravi sinhronizirali z oddaljeno zbirko podatkov.

DoloCite sinhronizacijske nastavitve za Koledar

Da bi dolotili sinhronizacijske nastavitve za aplikacijo Koledar, oznatite Zeleni profil ter izberite Moznosti > Uredi profil za
sinh. > Aplikacije > Koledar > Uredi in eno od naslednjih moznosti:

« Vkljudi v sinhronizacijo — Izberite, ali Zelite koledar sinhronizirati s tem profilom za sinhronizacijo.

» Oddaljena zbirka podat. — Vnesite ime do zbirke podatkov, s katero Zelite sinhronizirati koledar.

+ Lokalna pod. zbirka — Ce imate v napravi vet koledarjev, izberite tistega, ki ga Zelite sinhronizirati s tem profilom za
sinhronizacijo.

« Vrsta sinhronizacije — Izberite imenik za sinhronizacijo. Pomaknite se na Obi¢ajna, da bi podatke v napravi sinhronizirali z
oddaljeno zbirko podatkov in obratno, Samo v telefon, da bi podatke oddaljene zbirke sinhronizirali z napravo, ali Samo v
streZnik, da bi podatke v napravi sinhronizirali z oddaljeno zbirko podatkov.

DoloCite sinhronizacijske nastavitve za Belezke

Da bi dolotili sinhronizacijske nastavitve za aplikacijo Belezke, oznaCite Zeleni profil ter izberite Moznosti > Uredi profil za
sinh. > Aplikacije > BeleZke > Uredi in eno od naslednjih moznosti:

« Vkljudi v sinhronizacijo — Izberite, ali Zelite belezke sinhronizirati s tem profilom za sinhronizacijo.

» Oddaljena zbirka podat. — Vnesite ime do zbirke podatkov, s katero Zelite sinhronizirati belezke.

+ Lokalna pod. zbirka — Ce imate v napravi vet aplikacij Belezke, izberite tisto, ki jo Zelite sinhronizirati s tem profilom za
sinhronizacijo.
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« Vrsta sinhronizacije — Izberite imenik za sinhronizacijo. Pomaknite se na Obicajna, da bi podatke v napravi sinhronizirali z

oddaljeno zbirko podatkov in obratno, Samo v telefon, da bi podatke oddaljene zbirke sinhronizirali z napravo, ali Samo v
streznik, da bi podatke v napravi sinhronizirali z oddaljeno zbirko podatkov.
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14.  Orodja

Izberite Meni > Orodja.

Mapa Orodja vsebuje aplikacije, v katerih lahko nastavite napravo in druge aplikacije.
Nadzor.apl.—Glejte "Nadzornik aplikacij”, str. 68.

Pomnilniska kartica—Glejte "PomnilniSka kartica", str. 15.

Prenos—Glejte "PrenaSanje vsebine med napravami", str. 19.
Profili—Glejte "Profili", str. 82.

Teme—Clejte "Teme", str. 82.

Nastavitve—Glejte "Nastavitve", str. 84.

E-pos. tipka—Glejte "Nastavitev e-poStne tipke", str. 21.

Hitro klicanje—Glejte "Hitro klicanje", str. 33.
Glasovni ukazi—Glejte "Glasovni ukazi", str. 38.

B Katalogi Nokia
Izberite Meni > Katalogi ali Meni > Orodja > Katalogi. I1zberite OK, Ce se strinjate z izjavo.

Katalogi Nokia (omreZna storitev) je mobilna trgovina vsebin, ki vam je na voljo v vasi napravi. Omogoca vam odkrivanje,
predogled, kupovanje, nalaganje in posodobitev razlitne vsebine za vaso napravo, kot so igre, toni zvonjenja, ozadja, storitve
in aplikacije. RazpoloZljivost vsebine je odvisna od vaSega mobilnega operaterja in ponudnika storitev.

Aplikacija Katalogi Nokia za dostop do nazadnje posodobljene vsebine uporablja omreZne storitve. Informacije o dodatni
vsebini, ki je na voljo prek aplikacije Katalogi Nokia, lahko dobite pri svojem mobilnem operaterju ali ponudniku storitev.

Aplikacija Katalogi Nokia prejema trenutne posodobitve in vam posreduje najnovejso vsebino, ki jo za napravo ponuja vas
mobilni operater ali ponudnik storitev. Ce Zelite kataloge posodobiti rono, izberite MoZnosti > OsveZi seznam.

Odpiranje kataloga

Izberite Meni > Katalogi ali Meni > Orodja > Katalogi.

Ko se pomaknete na mapo kataloga, se na zaslonu prikaze opis vsebine.
Izberite MoZnosti in eno od naslednjih moznosti:

» Odpri — Odprite izbrani katalog.

* Prikazi podrobnosti — Oglejte si podrobnosti kataloga.

« Skrij — Izbrani katalog izkljulite s seznama katalogov.

+ Prikazi vse — Skrite kataloge ponovno vkljucite na seznam katalogov.

» Osvezi seznam — NalozZite posodobljeni seznam katalogov.

« Aplikacija — Izberite O izdelku, Ce si Zelite ogledati informacije o aplikaciji, ali I1zjava, Ce si Zelite ogledati izjavo ponudnika
kataloga.

 Domacta stran — Odprite glavni prikaz aplikacije Katalogi.

Odpiranje mape

Izberite Meni > Katalogi ali Meni > Orodja > Katalogi.
Mapa kataloga ima lahko ve¢ podmap.

Izberite MoZnosti in eno od naslednjih moznosti:

« 0dpri — Ce ste kupili in naloZili izbrani predmet, odprite vsebino mape.

+ Odpri — Odprite izbrano podmapo.

+ Prikazi podrobnosti — Oglejte si podrobnosti kataloga.

» Predogled — Oglejte si predogled izbranega predmeta.

 Prenesi — Nalozite kupljeni predmet, Ce tega Se niste storili.

 Kupi — Kupite izbrani predmet.

+ Nastavi za ozadje — (e je izbrani predmet ozadje, ga s to moznostjo nastavite za ozadje naprave.

« Upor. kot ton zvonj. — (e je izbrani predmet ton zvonjenja, ga nastavite za ton zvonjenja naprave.

+ Nastavi za temo — (e je izbrani predmet tema, jo nastavite za temo naprave.

« Spletne informacije — Odprite spletno stran z informacijami o izbranem predmetu, e je na voljo.

+ Podrobnosti o nakupu — Oglejte si podrobnosti kupljenega predmeta.

» OsveZi seznam — Nalozite posodobljeno mapo.

« Aplikacija — Izberite O izdelku, Ce si Zelite ogledati informacije o aplikaciji, ali Izjava, Ce si Zelite ogledati izjavo ponudnika
kataloga.

+ Domaca stran — Odprite glavni prikaz aplikacije Katalogi.
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Nastavitve aplikacije Katalogi
Izberite Meni > Katalogi ali Meni > Orodja > Katalogi.
V glavnem prikazu aplikacije Katalogi izberite MoZnosti in eno od naslednjih mozZnosti:

« Dostopna totka — Izberite privzeto dostopno tocko za aplikacijo Katalogi.

+ Samodejno odpiranje — Izberite, ali Zelite, da naprava samodejno odpre naloZeno aplikacijo.

+ Potrditev predogleda — Izberite, ali naj naprava prikaze potrditveno okno, preden nalozi predogled predmeta.
* Potrditev nakupa — Izberite, ali naj naprava pred nakupom predmeta prikaze potrditveno okno.

B Nast. Carov.

Nast. ¢arov. konfigurira vaso napravo za uporabo storitev (MMS, GPRS in internet), e-poste, storitve Pritisni in govori (omrezna
storitev) in nastavitve za souporabo video posnetkov (omreZna storitev), ki temeljijo na nastavitvenih informacijah, ki jih je
poslal vas mobilni operater.

Da bi te storitve lahko uporabljali, vam bo mobilni operater ali ponudnik storitev morda moral vkljuciti podatkovno povezavo
ali druge storitve.

(e Zelite urediti nastavitve, izberite Meni > Orodja > Nast. tarovn. in Zeleni nastavitveni niz.

E-posta

1. (e zelite ureditvi e-postne nastavitve, izberite Meni > Orodja > Nast. Carovn. > E-posta. Nast. arov. pois€e mobilne operaterije,
ki so na voljo. Ce naprava najde veC operaterjev, izberite enega in OK.
(e operaterja ne prepozna, morate izbrati nastavitvi Drzava in Operater.

2. Sseznama izberite svojega ponudnika e-postnih storitev.

3. Izberite streZnik za posiljanje poste. (e niste prepritani, uporabite privzeti streznik.

(e Nast. tarov. zahteva podrobnosti za E-postni naslov (vklju¢no z imenom domene), Uporabnisko ime in Geslo, izberite vsako
nastavitev in Moznosti > Spremeni. Vnesite podrobnosti in izberite OK.

1. Ko koncate, izberite MoZnosti > OK.
2. lzberite OK, da potrdite nastavitev nabiralnika za izbranega operaterja.
3. Izberite OK.

Da bi lahko posiljali in prejemali e-pos$to, morate imeti aktiven rafun za paketni prenos podatkov. Podrobnosti lahko dobite pri
mobilnem operaterju ali ponudniku storitev.

Pritisni in govori
OmreZna storitev Pritisni in govori (PG) omogo(a neposredno glasovno komunikacijo; povezava se vzpostavi ob pritisku tipke.
S to storitvijo lahko svojo napravo uporabljate kot walkie-talkie.

1. (e Zelite urediti nastavitve omrezne storitve Pritisni in govori (Prit. in govori), izberite Meni > Orodja > Nast. ¢arovn. > Prit.
in govori. Nast. Carov. poisCe mobilne operaterije, ki so na voljo. (e naprava najde ve€ operaterjev, izberite enega in OK.

(e operaterja ne prepozna, morate izbrati nastavitvi Drzava in Operater.

2. Zastoritve nekaterih operaterjev morate vnesti Uporabnisko ime, Geslo in Vzdevek. I1zberite vsako nastavitev posebej in
MozZnosti > Spremeni. Vnesite podrobnosti in izberite OK.

3. Ko koncate, izberite MoZnosti > OK.
4. Izberite OK, da potrdite nastavitev storitve Pritisni in govori za izbranega operaterja.

Da bi lahko uporabljali storitev PG, morate imeti aktiven racun za paketni prenos podatkov. Podrobnosti lahko dobite pri
mobilnem operaterju ali ponudniku storitev.

(e za izbranega operaterja 3e nimate nastavljene dostopne totke, morate ustvariti novo.

Souporaba videa

1. (e Zelite urediti nastavitve omreZne storitve Sk. raba videa, izberite Meni > Orodja > Nast. tarovn. > Skup. raba videa. Nast.
tarov. poiste mobilne operaterje, ki so na voljo. Ce naprava najde vet operaterjev, izberite enega in OK. Ce operaterja ne
prepozna, morate izbrati nastavitvi Drzava in Operater.

2. Zastoritve nekaterih operaterjev morate vnesti Naslov za sk. rabo videa, uporabnisko ime in geslo. Izberite vsako nastavitev
posebej in Moznosti > Spremeni. Vnesite podrobnosti in izberite OK.

3. Ko koncate, izberite MoZnosti > OK.
4. Izberite OK, da potrdite nastavitev souporabe videa za izbranega operaterja.

5. Ko ste ustvarili nastavitve souporabe videa, Nast. €arov. vprasa, Ce Zelite ustvariti ali posodobiti lastno vizitko. Izberite Da ali
Ne.
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Da bi lahko uporabljali souporabo videa, morate imeti aktiven raun za paketni prenos podatkov. Podrobnosti lahko dobite pri
mobilnem operaterju ali ponudniku storitev.

Operater

1. e Zelite urediti operaterjeve nastavitve (dostopno totko, spletni brskalnik, storitev za ve¢predstavnostna sporofila in
pretakanje), izberite Meni > Orodja > Nast. Carovn. > Operater. Nast. Carov. poiste mobilne operaterje, ki so na voljo.

2. (e naprava najde vet operaterjev, izberite enega in OK.
3. (e operaterja ne prepozna, morate izbrati nastavitvi Drzava in Operater.
(e imate teZave z aplikacijo Nast. ¢arov., obisite spletno stran Nokia za nastavitev telefona, www.nokia.com.

B Dol. poloz.

Sstoritvijo dolotanja poloZaja lahko na podlagi trenutne lokacije (omreZna storitev) od ponudnikov storitev prejemate obvestila
o razmerah v kraju, kjer ste, na primer vremenu ali prometu.

Izberite Meni > Orodja > Dol. poloZz..

Zeleni natin dolotanja poloZaja izberete tako, da se pomaknete nanj in izberete MoZnosti > Omogoti. Izkljutite ga z izbiro
MozZnosti > Onemogoci. Nacin dolo¢anja poloZaja Bluetooth vam omogoca uporabo dodatne opreme Bluetooth GPS za dolocanje
poloZaja. NaCin dolo¢anja poloZaja Omrezno ponuja mobilni operater ali ponudnik storitev. Hkrati lahko uporabljate oba natina
doloCanja polozZaja.

B Navigator
Ta funkcija ni namenjena zahtevam za informacije o poloZaju za povezane klice. Ve€ informacij o skladnosti telefona z drzavnimi
predpisi o storitvah za klice v sili z obve$tanjem o poloZaju lahko dobite pri ponudniku storitev.

Sistema GPS ne uporabljajte za natantne meritve poloZaja in se nikoli ne zanasajte samo na podatke o polozaju, ki jih dobite
od sprejemnika GPS.

Izberite Meni > Orodja > Navigator.

Navigator je aplikacija GPS, s katero si lahko ogledate svojo trenutno lokacijo, najdete pot do Zelene lokacije in ugotavljate
razlitne razdalje. Aplikacija za uporabo zahteva dodatno opremo GPS Bluetooth. Poleg tega morate imeti v nastavitvi Meni >
Orodja > Dolocanje poloZaja omogocen nacin dolo€anja poloZaja GPS Bluetooth.

Aplikacija mora prejemati podatke od vsaj treh satelitov, da jo lahko uporabljate kot pripomocek pri potovanju.

Aplikacija za uporabo zahteva dodatno opremo GPS Bluetooth.

Izberite med temi moZnostmi: Navigator Prikaz navigacijskih podatkov za cilj potovanja. Pozicija Prikaz informacij o vasem
trenutnem poloZaju. Razdalja Prikaz informacij, kot so razdalja in trajanje potovanja ter povprecna in najvegja hitrost.

Prikaz navigacije

Podatki v prikazu navigacije vas usmerjajo proti cilju potovanja. Crke v krogu oznacujejo strani neba, temnej$a barva pa priblizno
smer potovanja proti cilju.

Izberite med temi moZnostmi: Nastavi cilj Za cilj potovanja izberite neko tocko ali lokacijo ali pa vnesite koordinate zemljepisne
Sirine in dolZine. Ustavi navigacijo ZbriSite nastavljeni cilj potovanja. Shrani pozicijo Shranite poloZaj, kjer ste, kot lokacijo ali
totko. Stanje satelitov PrikaZite moC signala satelitov, ki posiljajo navigacijske podatke. Shranjene lokacije Prikazite poloZaje,
ki so zaCasno shranjeni v napravi in jih potrebujete pri navigaciji.

Prikaz PoloZaj

Vnesite podatke, kot so zemljepisna Sirina in dolZina ter nadmorska viSina trenutnega poloZaja. Preverite lahko tudi natan¢nost
vnesenih podatkov.

Izberite med temi moZnostmi: Shrani pozicijo Shranite polozaj, kjer ste, kot lokacijo ali totko. Stanje satelitov PrikaZite moc
signala satelitov, ki posiljajo navigacijske podatke. Shranjene lokacije PrikaZite poloZaje, ki so zatasno shranjeni v napravi in
jih potrebujete pri navigaciji.

Prikaz Razdalja

Merilnik potovanja izraCunava prepotovano razdaljo in Cas ter najvecjo in povprecno hitrost.

Izberite med temi moZnostmi: ZaZeni VkljuCite merilnik potovanja. Ustavi IzkljuCite merilnik potovanja. Izratunane vrednosti
ostanejo na zaslonu. Nadaljuj Ponovno vkljuite merilnik potovanja. Ponastavi Izratunane vrednosti v merilniku ponastavite na
nic in zaCnite znova. PoCisti Po kon€ani uporabi zbrisite vrednosti v merilniku. Shrani pozicijo Shranite poloZaj, kjer ste, kot

lokacijo ali tocko. Stanje satelitov PrikaZite moc signala satelitov, ki poSiljajo navigacijske podatke. Shranjene lokacije Prikazite
polozaje, ki so zaCasno shranjeni v napravi in jih potrebujete pri navigaciji.
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Delo z lokacijami
Izberite Pozicija > Moznosti > Shranjene lokacije.
V napravo lahko za€asno shranite lokacije, ki jih potrebujete pri navigaciji.

(e Zelite v prikazih Navigator, Pozicija ali Razdalja shraniti lokacijo, izberite MoZnosti > Shrani pozicijo.
Zatasno lokacijo shranite kot trajno tocko tako, da izberete MoZnosti > Shrani kot totko.

Lokacijo zbrisete tako, da se pomaknete nanjo in pritisnete MoZnosti > PoCisti.

Nastavitve Navigatorja

Izberite MoZnosti > Nastavitve.

Uporabljeni merski sistem zamenjate tako, da izberete Merski sistem > Metritne ali Angleske.

(e Zelite vnesti podatke za umerjanje nadmorske visine, da bi tako popravili prejete podatke satelitov, izberite Umerjanje n.
viSine.

B Tocke

Izberite Meni > Orodja > Tocke.

Tocke so koordinate zemljepisnih poloZajev; med uporabo razli¢nih storitev, ki temeljijo na dolo€anju polozajev, jih lahko
shranite v napravo in jih uporabite pozneje. ToCke lahko ustvarjate z dodatno opremo GPS z vmesnikom Bluetooth ali omreZjem
(omreZna storitev). Glejte "Navigator", str. 74.

Tocko ustvarite tako, da izberete MoZnosti > Nova totka. Izberite Trenutni poloZaj, da od omreZja zahtevate koordinate
zemljepisne Sirine in dolZine za lokacijo, kjer ste, ali Ro€ni vpis in vpiSite potrebne informacije o poloZaju, na primer ime,
kategorijo, naslov, zemljepisno Sirino, dolZino ter nadmorsko visino.

(e Zelite prikazati informacije o totki ali jih urediti, totko izberite in pritisnite krmilno paltko.
Da bi zbrisali tocko, se pomaknite nanjo in pritisnite vraCalko.
Za vsako tocko izberite MoZnosti in eno od naslednjih moZnosti:

« Dodaj kategoriji — Totko dodajte v skupino podobnih totk. Pomaknite se na Zeleno kategorijo in pritisnite krmilno palko.
Po kategorijah tock lahko brskate s pomikanjem levo in desno.

* Poslji — Tocko posljite zdruzljivim napravam.

+ Uredi kategorije — Dodajte, uredite ali zbriSite kategorije tock.

- lkona totke — Zamenjajte ikono, ki oznatuje tocko. Poiscite Zeleno ikono in pritisnite krmilno paltko.

Kategorije tock

Tocke si lahko ogledate v dveh nacinih prikaza: v enem so kategorije, ki Ze vsebujejo totke, v drugem pa vse kategorije v napravi.
(e vas zanimajo kategorije, ki Ze vsebujejo totke, izberite Meni > Orodja > Totke in se pomaknite desno.

(e si zelite ogledati totke, ki jih vsebuje neka kategorija, izberite kategorijo in pritisnite krmilno palcko.

Da bi premakanili toCko iz ene kategorije v drugo, se pomaknite levo. PoisCite Zeleno tocko in pritisnite MoZnosti > Dodaj
kategoriji. Pomaknite se na staro kategorijo in pritisnite krmilno paltko, da odstranite oznako poleg nje. Pomaknite se na Zzeleno
kategorijo oziroma vet kategorij, v katere Zelite to¢ko dodati, in pritisnite krmilno paltko. Izberite Sprejmi.

Za vsako tocko izberite MoZnosti in eno od naslednjih moZnosti:

+ Uredi— Spremenite informacije o tocki, na primer ime, kategorijo, naslov, zemljepisno Sirino in dolZino ter nadmorsko visino.
 Nova totka — Neposredno v kategoriji ustvarite novo tocko. Izberite Trenutni poloZaj, da od omreZja zahtevate koordinate
zemljepisne Sirine in dolZine za lokacijo, kjer ste, ali Ro¢ni vpis in vpiSite potrebne informacije o poloZaju, na primer ime,

kategorijo, naslov, zemljepisno Sirino, dolZino ter nadmorsko visino.
+ Dodaj kategoriji — Totko dodajte v skupino podobnih tock. Pomaknite se na Zeleno kategorijo in pritisnite krmilno paltko.
* Poslji — Tocko posljite zdruzljivim napravam.
« Uredi kategorije — Dodajte, uredite ali zbrisite kategorije tock.
« Ikona toctke — Zamenjajte ikono, ki ozna€uje tocko. Poistite Zeleno ikono in pritisnite krmilno palko.

Morda ne bodo vedno na voljo iste moZnosti.
Urejanje kategorij to¢k

Izberite Moznosti > Uredi kategorije.

Izberite MoZnosti in eno od naslednjih moznosti:

 Nova totka — Neposredno v kategoriji ustvarite novo tocko. Izberite Trenutni poloZaj, da od omrezja zahtevate koordinate
zemljepisne Sirine in dolZine za lokacijo, kjer ste, ali Ro¢ni vpis in vpiSite potrebne informacije o poloZaju, na primer ime,
kategorijo, naslov, zemljepisno Sirino, dolZino ter nadmorsko visino.

« Ikona totke — Zamenjajte ikono, ki ozna€uje tocko. Poiscite Zeleno ikono in pritisnite krmilno palko.
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Kategorijo tock, ki ste jo ustvarili sami, lahko zbriSete tako, da se pomaknete nanjo in pritisnete vraCalko. Vnaprej nastavljenih
kategorij ni mogoce zbrisati.

Urejanje tock

Izberite MoZnosti > Uredi ali Nova totka > RoCni vpis. Vnesite poloZaj in druge informacije, na primer ime, kategorijo, naslov,
zemljepisno Sirino in dolZino ter nadmorsko visino.

Za vsako tocko izberite MoZnosti in eno od naslednjih moZznosti:

* lzberi kategorije — ToCko dodajte v skupino podobnih tock. Izberite kategorijo in pritisnite krmilno paltko, da bi spremenili
informacije o tocki, na primer ime, kategorijo, naslov, zemljepisno $irino in dolZino ter nadmorsko visino.

« Trenutni poloZaj— Zahtevajte samodejni vnos koordinat zemljepisne Sirine in dolZine, da bi ustvarili tocko za trenutni poloZaj.

« Ikona toctke — Zamenjajte ikono, ki ozna€uje tocko. Poistite Zeleno ikono in pritisnite krmilno palko.

* Poslji — Tocko posljite zdruzljivim napravam.

Morda ne bodo vedno na voljo iste moZnosti.

Prejemanje tock

Izberite Meni > Sporo(ila. Odprite sporo€ilo s totko, ki ste ga prejeli od druge naprave. Pomaknite se na tocko in pritisnite krmilno
palcko.

Totko shranite v napravo tako, da izberete MoZnosti > Shrani.
(e Zelite totke posredovati zdruZljivim napravam, izberite Moznosti > Polji.

B Glasovna pomocC
Izberite Meni > Orodja > Glasovna pomot.

Aplikacija Glasovna pomoc bere besedilo na zaslonu in vam tako omogoca, da uporabljate osnovne funkcije naprave, ne da bi
gledali na zaslon.

Izberite med temi moZnostmi:

« Imenik — Poslusajte vnose v imeniku. Te moZznosti ne uporabite, ¢e imate shranjenih vec kot 500 vizitk.

+ Zadniji klici — PosluSajte informacije o neodgovorjenih, sprejetih in odhodnih klicih ter pogostih Stevilkah.

+ Telefon. predal — NaloZite glasovna sporoCila in jih poslusajte.

+ Klicanje — Poklicite telefonsko Stevilko.

« Ura— Predvajajte toen Cas in datum.

(e Zelite, da naprava predvaja vet moznosti, izberite MoZnosti.
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15.  Predstavnostne aplikacije

Zaradi za3Cite avtorskih pravic morda ne boste mogli kopirati, spreminjati, prenasati ali posredovati nekaterih slik, skladb
(vklju¢no s toni zvonjenja) in druge vsebine.

Izberite Meni > Predstavn..

Meni Predstavn. vsebuje razli¢ne predstavnostne aplikacije, s katerimi lahko shranjujete in pregledujete slike, snemate zvok in
predvajate zvotne datoteke.

B Galerija

Izberite Meni > Predstavn. > Galerija.

Meni Galerija omogoca dostop do razli¢nih vrst predstavnostnih datotek in njihovo uporabo, vklju¢no s slikami, video posnetki,
glasbo in zvoki. V mapo Galerija se samodejno shranijo vse slike in video posnetki, ki jih pregledujete, ter prejeta glasba in
zvolne datoteke. Po mapah lahko brskate, jih odpirate in ustvarjate ter oznacujete, kopirate in premikate predmete vanje.
Zvolni posnetki se odprejo v predvajalniku glasbe, video posnetki in povezave za pretakanje pa v aplikaciji RealPlayer.

Mapo ali datoteko odprete s pritiskom na krmilno palcko. Slike se odprejo v pregledovalniku slik.

(e Zelite z brskalnikom naloZiti datoteke v eno od glavnih map menija Galerija, izberite NaloZi slike, NaloZi video p., NaloZi
skladbe ali NaloZi zvoke. Ko se brskalnik odpre, izberite zaznamek strani, s katere Zelite nalagati, ali vnesite njen naslov.

(e Zelite poiskati datoteko, izberite MoZnosti > Poisti. Zatnite pisati iskalni niz (na primer ime ali datum iskane datoteke).
PrikaZejo se datoteke, ki ustrezajo vasi poizvedbi.

Slike

Izberite Meni > Predstavnost > Galerija > Slike.

Meni Slike ima dva razli¢na natina prikaza:

- Vslikovnem brskalniku lahko slike, shranjene v napravi ali na pomnilniski kartici, posiljate, razvrCate, brisete in preimenujete.

+ V prikazovalniku slik, v katerem se slika odpre, potem ko jo izberete v brskalniku, lahko prikazujete in poSiljate posamezne
slike. Slike lahko tudi nastavite za ozadje zaslona.

Podprti so naslednji zapisi datotek: JPEG, BMP, PNG in GIF 87a/89a. Naprava morda ne podpira vseh razliCic teh zapisov datotek.
(e Zelite sliko prikazati, jo izberite v slikovnem brskalniku in izberite MoZnosti > Odpri. Slika se odpre v prikazovalniku slik.
(e si Zelite ogledati prejsnjo ali naslednjo sliko, se v pregledovalniku slik pomaknite levo ali desno.

Prikazano sliko povetate tako, da izberete MoZnosti > Povetaj ali pa pritisnete tipko 5ali 7. Ce Zelite prikazano sliko pomanjsati,
izberite Pomanj3aj ali pritisnite 0.

(e Zelite sliko prikazati v celozaslonskem natinu, izberite MoZnosti > Cel zaslon ali dvakrat pritisnite 7 . (e se Zelite vrniti v
obicajni prikaz, izberite MoZnosti > Normalen zaslon.

(e Zelite zavrteti sliko, izberite sliko in MoZnosti > Zavrti. Izberite Desno, da sliko zavrtite za 90 stopinj v smeri urnega kazalca,
ali Levo, da jo zavrtite za 90 stopinj v nasprotni smeri.

Delo s slikovnimi datotekami

Zaradi zasCite avtorskih pravic morda ne boste mogli kopirati, spreminjati, prenasati ali posredovati nekaterih podob, tonov
zvonjenja in drugih vsebin.

(e si zelite ogledati podrobnejse podatke o sliki, izberite sliko in MoZnosti > PrikaZi podrobnosti. Prikazejo se velikost in oblika
zapisa datoteke, ura in datum zadnje spremembe ter locljivost v slikovnih pikah.

(e Zelite poslati sliko, izberite sliko, MoZnosti > Podlji in natin posiljanja.
(e Zelite preimenovati sliko, izberite sliko in MoZnosti > Preimenuj. Vpisite novo ime in izberite OK.
(e Zelite nastaviti ozadje na zaslonu, izberite sliko in MoZnosti > Nastavi za ozadje.

(e zelite vizitki v imeniku dodati sliko, izberite sliko in MoZnosti > Dodaj vizitki. Odpre se seznam, kjer lahko izberete Zeleno
vizitko.

Razvricanje slik

(e Zelite ustvariti mape za razvritanje slik, izberite MoZnosti > Razvrsti > Nova mapa. Poimenujte mapo in izberite OK.

(e Zelite kopirati ali premikati datoteke, izberite Zeleno datoteko in MoZnosti > Razvrsti > Premakni v mapo, Nova mapa, Prem.
na pomn. kart., Kopiraj na pomn.kart., Kopiraj v pomn. telef. ali Premakni v pomn. tel..
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B RealPlayer

Zaradi zas(ite avtorskih pravic morda ne boste mogli kopirati, spreminjati, prenasati ali posredovati nekaterih podob, tonov
zvonjenja in drugih vsebin.

Izberite Meni > Predstavn. > RealPlayer.

RealPlayer lahko predvaja video posnetke in zvotne datoteke, shranjene v pomnilniku naprave ali na pomnilniski kartici, prejete
po e-posti ali iz zdruZljivega raCunalnika ali pretoCene iz spleta.

RealPlayer podpira oblike zapisa MPEG-4, MP4 (ne za pretakanje), 3GP, RV, RA, AAC, AMR in Midi. RealPlayer ne podpira nujno vseh
razliCic teh zapisov predstavnostnih datotek.

;\é’: Nasvet: Pretakanje zvocnih in videodatotek pomeni predvajanje neposredno iz spleta, ne da bi jih prej nalozZili v
napravo.

Predvajanje video posnetkov in pretakanje povezav
(e Zelite izbrati zvok in video, da bi ju predvajali z aplikacijo RealPlayer, izberite MoZnosti > Odpri in se pomaknite na posnetek
v napravi ali na pomnilniski kartici.

(e Zelite pretakati predstavnostno vsehino, izberite spletno povezavo do posnetka in Predvajaj; ali pa se poveZite s spletom,
poisCite video posnetek ali zvotno datoteko in izberite Predvajaj. RealPlayer prepozna dve vrsti povezav: rtsp:// URL in http://
URL, ki kaZejo na datoteko RAM. Naprava se pred zatetkom pretakanja poveze s spletnim mestom in zatne predpomniti vsebino.
(e zaradi teZav z omreZno povezavo pride pri predvajanju do napake, se RealPlayer sku$a samodejno znova povezati z internetno
dostopno tocko.

Zvolne in videodatoteke v napravi ali na pomnilniski kartici predvajate tako, da izberete datoteko in Predvajaj.

(e Zelite kontati predvajanje ali pretakanje, izberite Ustavi. Medpomnijenije ali povezava s stranjo za pretakanje se prekine,
predvajanje posnetka se ustavi in posnetek se previje na zaletek.

(e si Zelite video posnetek ogledati v celozaslonski velikosti, izberite MoZnosti > Celozaslonski natin. Tako nastavite obmotje
za predvajanje na obicajno ali celozaslonsko velikost. V celozaslonskem natinu se velikost video posnetka poveta tako, da
prekrije najve¢jo mozno povrsino obmodja za predvajanje, medtem ko se razmerje med vi$ino in Sirino ohrani.

Posnetek shranite tako, da izberete MoZnosti > Shrani, se pomaknete na mapo v pomnilniku ali na pomnilniski kartici in izberete
Shrani. Ce Zelite shraniti povezavo do predstavnostne datoteke v spletu, izberite Shrani povezavo.

(e Zelite posnetek med predvajanjem previti naprej ali nazaj, se pomaknite navzgor ali navzdol.

:\é’: Nasvet: Posnetek med predvajanjem previjete naprej tako, da se s krmilno paltko pomaknete navzgor in jo pridrzite.
Nazaj ga previjete tako, da se s krmilno paltko pomaknete navzdol in jo pridrZite.

Med predvajanjem nastavite glasnost tako, da pritisnete eno od tipk za glasnost.

Posiljanje zvocnih in video posnetkov

Posnetek lahko posljete drugi napravi ali ga priloZite vecpredstavnostnemu sporocilu, dokumentu ali predstavitvi.

Posnetek posljete po infrardeCi povezavi ali povezavi Bluetooth tako, da izberete posnetek in MoZnosti > Poslji. Izberite natin
posiljanja izbranega posnetka drugi napravi.

(e Zelite poslati posnetek v sporotilu, ustvarite velpredstavnostno sporofilo, izberite Zeleno datoteko in Vstavi predmet > Video
posnetek ali Zvotni posnetek.

(e Zelite odstraniti vstavljeni posnetek, izberite MoZnosti > Odstrani > Da.

Prejemanje video posnetkov

Izberite Meni > Sporocila. Odprite sporoCilo, ki vsebuje video posnetek. Pomaknite se na posnetek in pritisnite krmilno palcko.
Izberite Prekini ali Ustavi, izberite MoZnosti in:

 Predvajaj — Posnetek predvajajte od zaletka.

« Celozaslonski nafin — OmogoCite predvajanje v celozaslonskem nacinu. Posnetki v lezedi postavitvi se bodo obrnili za 90
stopinj. V obi€ajni prikaz se vrnete tako, da pritisnete katero koli tipko.

» Nadaljuj — Nadaljujte predvajanje posnetka.

« Nadal. v celozasl. n. — Nadaljujte predvajanje v celozaslonskem nacinu.

* lzklopi zvok — IzkljuCite zvok video posnetka. Zvok spet vkljucite tako, da se pomaknete desno.

+ Shrani povezavo — Shranite spletno povezavo do posnetka.

» Podrobnosti posn. — PrikaZite informacije, kot sta trajanje in velikost posnetka.

+ Nastavitve — Spremenite nastavitve videa ali povezave.

Morda ne bodo vedno na voljo iste moznosti.
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Prikaz informacij o posnetku

(e si Zelite ogledati lastnosti video posnetka, zvotne datoteke ali spletne povezave, izberite posnetek in Moznosti > Podrobnosti
posn.. Informacije lahko vklju€ujejo bitno hitrost ali internetno povezavo za pretakanje.

(e Zelite vkljutiti zasCito datoteke, izberite posnetek in MoZnosti > Podrobnosti posn. > Stanje > Moznosti > Spremeni. Zasita
prepreCuje drugim, da bi datoteko spreminjali.

Nastavitve

Izberite Meni > Predstavn. > RealPlayer > MoZnosti > Nastavitve.

Nastavitve za video

Izberite Ponavljanje > Vkljuteno, da se bodo video posnetki po kontanem predvajanju samodejno predvajali znova.

Nastavitve povezave

Izberite Povezava, pomaknite se na naslednje nastavitve in pritisnite krmilno palcko, da bi zaceli urejanje:

+ Posred. strezn. — Izberite, ali Zelite uporabljati posredniski streznik ter vnesite njegov naslov IP in Stevilko vrat.
+ OmreZje — Zamenjajte dostopno totko za povezovanje z internetom in nastavite Stevilke vrat.

Nastavitve posredniskega streZnika

Posredniski strezniki (proxy) so posredniki med strezniki predstavnostne vsebine in njihovimi uporabniki. Nekateri ponudniki
storitev jih uporabljajo za izboljSanje varnosti ali pospeSevanje dostopa do strani, ki vsebujejo predstavnostne datoteke.

Pravilne nastavitve lahko dobite pri svojem ponudniku storitev.

Izberite Povezava > Posred. streZn., pomaknite se na naslednje nastavitve in pritisnite krmilno palko, da bi zaCeli urejanje:

« Uporabi posred. str. — Izberite Da, Ce Zelite uporabljati posredniski streznik.

+ Naslov posredn. str. — Vnesite naslov IP posredniskega streznika. Nastavitev je na voljo samo, Ce ste izbrali uporabo
posredniSkega streznika.

« Vrata posredn. strez. — Vpisite Stevilko vrat posredniskega streznika. Nastavitev je na voljo samo, Ce ste izbrali uporabo
posrednidkega streZnika.

OmreZne nastavitve

Pravilne nastavitve lahko dobite pri svojem ponudniku storitev.

Izberite Povezava > OmreZje, pomaknite se na naslednje nastavitve in pritisnite krmilno paltko, da bi zaCeli urejanje:

* Privzeta dost. totka — Pomaknite se na dostopno totko za povezavo z internetom in pritisnite krmilno palcko.

« (as povezave — Nastavite ¢as, po katerem RealPlayer prekine povezavo z omreZjem, kadar zatasno ustavite pretakanje
posnetka. Izberite Uporab. dolo€eno in pritisnite krmilno pal€ko. Vnesite €as in izberite OK.

» NajniZja vrata UDP — Vnesite najmanjSo Stevilko vrat streznika. Izbrati morate najmanj 1024.

« Najvisja vrata UDP — Vnesite najvecjo Stevilko vrat streZnika. Izberete lahko najvec 65535.

Dodatne omreZne nastavitve
(e Zelite urediti pasovno irino za razlitna omreZja, izberite Povezava > OmreZje > Moznosti > Dodatne nastavitve.

Pasovno $irino za eno od prikazanih omrezij izberete tako, da se pomaknete nanjo in pritisnete krmilno paltko. Poiscite Zeleno
vrednost in izberite OK.

(e Zelite pasovno $irino vpisati sami, izberite Uporab. doloceno.
Pravilne nastavitve lahko dobite pri svojem ponudniku storitev.

Nastavitve shranite z moznostjo Nazaj.

B Predvajalnik glasbe
& Opozorilo: Med uporabo zvocnika naprave ne drZite ob usesu, saj je lahko zelo glasna.

Izberite Meni > Predstavnost > Predv.glasbe.

S predvajalnikom lahko predvajate glasbene datoteke ter ustvarjate in posluSate sezname skladb. Predvajalnik glasbe podpira
datoteke s kontnicami, kot sta MP3 in AAC.

Poslu3anje glasbe

& Opozorilo: Glasho poslusajte pri zmerni glasnosti. Dolgotrajnejsa izpostavljenost mocni glasnosti lahko poskoduje vas
sluh. Med uporabo zvocnika naprave ne drzite ob usesu, saj je lahko zelo glasna.

(e Zelite izbrati skladbo, izberite MoZnosti > KnjiZznica glasbe. Na seznamu Vse skladbe so vse skladbe v napravi. Skladbe lahko
razvrstite po merilih Albumi, Izvajalci, Zvrsti ali Skladatelji. Ce Zelite predvajati neko skladbo, se pomaknite nanjo in izberite
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MoZnosti > Predvajaj. Med predvajanjem in zaasno ustavitvijo preklapljate s pritiskom na p in | . Predvajanje koncate tako,
da pritisnete na i}

Potem ko dodate glasbene datoteke ali jih odstranite iz naprave, posodobite seznam Knjiznica glasbe. Izberite MoZnosti >
Posod. Knjiznico glasbe. Predvajalnik pois¢e glasbo v pomnilniku naprave in jo doda na seznam KnjiZnica glasbe.

(e Zelite izbrati prej$njo ali naslednjo skladbo, premaknite krmilno paltko navzgor ali navzdol.

(e Zelite vedno znova predvajati skladbe, izberite MoZnosti > Ponavljanje. Izberite Vse skladbe, ¢e naj se ponavljajo vse skladbe
v trenutni mapi, Ena skladba, Ce Zelite ponavljati izbrano skladbo, ali Izkljuteno, da ponavljanje izkljucite.

(e Zelite glasbo predvajati v nakljutnem vrstnem redu, izberite mapo in MoZnosti > Naklju¢no zapor..

(e si Zelite ogledati informacije o skladbi, se pomaknite nanjo in izberite MoZnosti > PrikaZi podrobnosti.

Prilagajanje glasnosti

Glasnost glasbe nastavite s pritiskanjem tipk za glasnost. Ce Zelite zvok izkljuiti, pritiskajte tipko za zmanj$anje glasnosti, dokler
glasba ne utihne.

Seznami skladb
Ustvarite lahko nov seznam in nanj dodate skladbe ali pa izberete enega od shranjenih seznamov.

Nov seznam skladb ustvarite tako, da izberete Moznosti > Knjiznica glasbe > Seznami skladb > Moznosti > Nov seznam
skladb. VpisSite ime novega seznama in izberite OK.

(e Zelite na seznam dodati skladbo, ga odprite in izberite MoZnosti > Dodaj skladbe.

IzenaCevalnik

Izberite Meni > Predstavn. > Predv.glasbe > MoZnosti > Izenalevalnik.

S funkcijo Izenacevalnik lahko prilagodite zvok predvajanja glasbe. Uporabite lahko vnaprej dolo€ene frekventne nastavitve, ki
temeljijo na zvrsteh, na primer klasi¢ni glasbi ali rocku. Ustvarite lahko tudi prilagojene nastavitve, ki ustrezajo vasim Zeljam.

Kadar je odprt IzenaCevalnik, ni mogoce uporabljati drugih funkcij aplikacije Predv.glasbe.

IzenaCevalnik omogoca okrepitev ali oslabitev frekvenc in s tem prilagoditev zvoka predvajanja glasbe. V napravi so vnaprej
doloCene frekventne nastavitve, na primer Rock.

(e Zelite med predvajanjem glasbe uporabiti vnaprej nastavljene frekvence, se pomaknite na Zeleno frekven¢no nastavitev in
izberite Moznosti > Vklju€i.

Ustvarjanje lastne frekventne nastavitve
1. Lastno frekvencno nastavitev ustvarite tako, da izberete MoZnosti > Nova prednastav..
2. Poimenuijte jo in izberite OK.

3. Pomikajte se med frekvennimi pasovi in nastavite frekvenco za vsak pas. Med pasovi se pomikate tako, da krmilno paltko
premikate levo ali desno.

4. Izberite Nazaj, da bi novo frekventno nastavitev shranili, ali MoZnosti > Povrni privzete, da bi nastavili pasove na nevtralno
frekvenco in zaceli znova.

(e Zelite urediti vnaprej doloteno frekventno nastavitev, izberite MoZnosti > Nova prednastav. ali Moznosti > Uredi.

(e Zelite spremeniti vnaprej dolotene frekvence, izberite frekvenéne pasove ter se pomikajte navzgor in navzdol, da povetate
ali zmanjSate vrednosti. Pri predvajanju boste takoj opazili spremenjeno frekvenco.

Frekvenine pasove ponastavite na prvotne vrednosti tako, da izberete MoZnosti > Povrni privzete.
Nove ali urejene nastavitve shranite tako, da izberete Nazaj.

B Snemalnik

Izberite Meni > Predstavn. > Snemalnik.

Snemalnik vam omogoca, da posnamete zvotno belezko, dolgo najvec 60 sekund, jo shranite kot zvoCni posnetek in posnetek
predvajate. Snemalnik podpira datoteke v zapisu AMR.

Snemalnik vkljutite s pritiskom na tipko Snemalnik/Pritisni in govori. Ce ste se prijavili za storitev Pritisni in govori, tipka
Snemalnik deluje kot tipka PG, zato z njo ne morete vklju€iti aplikacije Snemalnik.

Zvotno beleZko posnamete tako, da izberete MoZnosti > Posnemi zvot, posn.. Ce Zelite snemanje zatasno ustaviti, izberite
Prekini; ko ga Zelite nadaljevati, izberite Snemaj. Snemanje konCate tako, da izberete Ustavi. Zvocni posnetek se samodejno
shrani.
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DolZina zvoCnega posnetka je omejena na 60 sekund, vendar je odvisna tudi od razpoloZljivega pomnilnika v napravi ali na
pomnilniski kartici.

Predvajanje zvotnega posnetka
(e Zelite poslusati pravkar posneti zvotni posnetek, izberite ikono za predvajanje (). Izberite Ustavi, da preklicete predvajanje.

Vrstica stanja prikazuje, kako dolgo se posnetek Ze predvaja, poloZaj v posnetku in njegovo skupno dolzZino.

Predvajanje zvotnega posnetka lahko zatasno ustavite s pritiskom na Prekini. Predvajanje se nadaljuje, ko izberete Predvajaj.
Zvolni posnetki, ki jih prejmete ali posnamete, so zatasne datoteke. Datoteke, ki jih Zelite obdrzati, morate shraniti.

B Predvajalnik Flash

Izberite Meni > Predstavn. > Pr. Flash.
Pr. Flash omogoca pregledovanije, predvajanje in interaktivno uporabo datotek Flash, izdelanih za mobilne naprave.
(e Zelite odpreti mapo ali predvajati datoteko Flash, poi$tite mapo oziroma datoteko in pritisnite krmilno pal¢ko.

Da bi poslali datoteko Flash zdruzljivi napravi, jo pois€ite in pritisnite klicno tipko. Zaradi zasCite avtorskih pravic morda nekaterih
datotek Flash ne boste mogli posiljati.

(e Zelite preklapljati med datotekami Flash, shranjenimi v pomnilniku naprave ali na pomnilniski kartici, se pomaknite levo ali
desno.

Morda ne bodo vedno na voljo iste moZnosti.
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B Profili

& Opozorilo: Kadar je vkljucen profil za uporabo brez povezave, ne morete klicati ali sprejemati klicev, tudi Stevilke za
klice v sili ne, ali uporabljati drugih funkcij, za katere je potrebna povezava z omrezjem. Ce Zelite klicati, morate najprej
zamenjati profil in tako vkljuiti telefonsko funkcijo naprave. (e je naprava zaklenjena, vnesite kodo za odklepanje.

Izberite Meni > Orodja > Profili.

S profili lanko nastavite tone zvonjenja, opozorilne tone in druge zvoke naprave ter jih prilagodite razli¢nim dogodkom, okoljem
in skupinam klicalcev.

(e Zelite prilagoditi profil, se pomaknite na Zeleni profil na seznamu in izberite Moznosti > Prilagodi.
DoloCite naslednje:

» Ton zvonjenja— S seznama izberite ton zvonjenja ali Nalaganje tonov, da odprete mapo s seznamom zaznamkov za
nalaganje tonov iz spleta. (e Zelite poslusati izbrani ton, izberite Predvajaj. Ce uporabljate dve telefonski liniji, lahko doloCite
ton zvonjenja za vsako linijo posebej.

 Ton za videoklic — DoloCite ton zvonjenja za videoklice.

« lzgovori klicatelj. ime — VkljuCite funkcijo pretvarjanja besedila v zvok za tone zvonjenja. Ko vas pokli¢e nekdo iz imenika,
naprava predvaja ton zvonjenja, ki je kombinacija izgovorjenega imena klicalca in izbranega tona zvonjenja.

+ Vrsta zvonjenja — Izberite nalin opozarjanja za ton zvonjenja.

+ Glasnost zvonjenja — Nastavite stopnjo glasnosti tona zvonjenja.

« Opozor. na sporoCilo — Izberite ton za prejeta besedilna sporocila.

+ Opozorilo na e-poto — lIzberite ton za prejeta e-poStna sporodila.

+ Opoz. ton pomenkov — Izberite ton za prejeta hitra sporodila.

 Opoz. z vibriranjem — Izberite, e Zelite, da naprava ob dohodnem Klicu vibrira.

+ Toni tipk — Nastavite stopnjo glasnosti zvokov tipk.

« Opozorilni toni — Vkljucite ali izkljuCite opozorilne tone.

+ Zvoni za— OmogoCite lahko zvonjenje le za dohodne klice, katerih Stevilke so v izbrani podskupini. Naprava ne bo zvotno
opozarjala na klice s Stevilk, ki ne spadajo v izbrano podskupino.

« Ime profila— DoloCite ime novemu profilu ali preimenujte enega od obstojecih. Profilov Splo$no in Brez povezave ne morete
preimenovati.

Profil Brez povezave preprecuje nenameren vklop naprave, uporabo povezave Bluetooth ter posiljanje in prejemanje sporocil.
Ko ga izberete, se kontajo tudi vse morebitne povezave z internetom. Profil Brez povezave ne preprei poznejse vzpostavitve
povezave zomrezjem WLAN, zato pri povezovanju zomrezji WLAN in njihovi uporabi upoStevajte ustrezne varnostne predpise
in omejitve.

(e Zelite zamenjati profil, poistite Zeleni profil na seznamu in izberite Moznosti > Vkljui. Ce izberete profil Brez povezave, lahko
posiljate in prejemate sporoCila ali uporabljate omreZje WLAN za branje e-postnih sporoCil.

(e Zelite ustvariti nov profil, izberite MoZnosti > Ustvari nov in dolotite nastavitve.

Izbiranje tonov zvonjenja

(e Zelite vkljutiti ton zvonjenja, se pomaknite na profil in izberite Moznosti > Prilagodi > Ton zvonjenja. S seznama izberite ton
zvonjenja ali izberite Nalaganje tonov, da odprete mapo, v kateri je seznam zaznamkov za nalaganje tonov iz spleta. NaloZeni
toni se shranijo v meni Galerija.

(e Zelite ton vkljutiti samo za klice z nekaterih $tevilk, se pomaknite na profil, izberite Moznosti > Prilagodi > Zvoni zain Zeleno
skupino. Naprava ne bo zvocno opozarjala na klice s Stevilk, ki ne spadajo v izbrano podskupino.

(e Zelite poiskati ton za sporotila, se pomaknite na profil in izberite MoZnosti > Prilagodi > Opozor. na sporotilo.

(e Zelite slisati ton zvonjenja, ga izberite na seznamu in pocakajte, da se predvaja.

Spreminjanje nastavitev dodatne opreme

Pomaknite se na Zeleno vrsto opreme in izberite MoZnosti > Odpri.
Zamenjajte privzeti profil za dodatno opremo.

(e Zelite urediti nastavitve dodatne opreme, izberite opremo in MoZnosti > Odpri.

Bl Teme

Izberite Meni > Orodja > Teme.
Videz zaslona naprave lahko spreminjate.
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(e Zelite spremeniti videz zaslona, oznacite temo, ki jo Zelite uporabiti, in izberite MoZnosti > Uporabi.

(e Zelite urediti temo, jo oznatite in izberite MoZnosti > Uredi. Izberite Ozadje, da bi zamenijali sliko za ozadje v stanju
pripravljenosti, ali Varevanje energije, da bi v varevalnem ohranjevalniku zaslona, ki se vkljudi, ko nekaj ¢asa ne pritisnite
nobene tipke, uporabili besedilo ali datum in uro.

(e Zelite naloZiti teme, vzpostavite omreZno povezavo z zdruZljivo internetno storitvijo, ki omogota nalaganje tem za va$o
napravo.

Temo naloZite tako, da izberete Nalaganje tem. Vnesite povezavo za nalaganje teme. NaloZeno temo lahko odprete v predogledu,
jo vkljudite ali uredite.

(e Zelite odpreti predogled teme, oznatite Zeleno temo in izberite MoZnosti > Predogled. Ce Zelite novo temo uporabiti, izberite
Uporabi.
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Izberite Meni > Orodja > Nastavitve.

Dolocate in spreminjate lahko razli¢ne nastavitve naprave. Spreminjanje teh nastavitev vpliva na delovanje naprave v Stevilnih
aplikacijah.

Nekatere nastavitve naprave so morda Ze dolocene ali pa vam jih ponudnik storitev ali mobilni operater lahko poslje v
nastavitvenem sporocilu. Mogoce jih ne boste mogli urejati.

Pomaknite se na nastavitev, ki jo Zelite urediti, in pritisnite krmilno paltko, da bi storili naslednje:
* Preklapljajte med dvema vrednostma, kot sta vklop in izklop.

* lIzberite vrednost s seznama.

» Odprite urejevalnik besedila, da bi vnesli vrednost.

- Odprite drsnik, da bi vrednost povecali ali zmanjsali s pomikanjem levo ali desno.

B Nastavitve naprave

V meniju Telefon lahko spremenite nastavitve jezika, stanja pripravljenosti in zaslona.

Nastavitve za Splo3no

Izberite Splosno in med temi moZnostmi:

+ Jezik telefona — Na seznamu izberite Zeleni jezik. Zamenjava jezika vpliva na vse aplikacije v napravi. Ob zamenjavi jezika
se naprava znova zazene.

+ Jezik pisanja—Naseznamu izberite Zeleni jezik. Zamenjava jezika za pisanje vpliva tudi na znake, ki so na voljo med urejanjem
besedila.

+ Pozdrav ali logotip — Izberite Privzeto, da bi uporabili privzeto sliko, Besedilo, da bi napisali lastno sporoCilo, ali Slika, da bi
izbrali sliko iz Galerije. Pozdravno sporoCilo ali slika se na kratko prikaZe ob vsakem vklopu naprave.

» Tov. nastavitve telef. — Obnovite izvirne tovarniske nastavitve naprave. Za to potrebujete kodo za zaklepanje naprave. Po
ponastavitvi utegne zagon naprave trajati dlje. To ne vpliva na dokumente, podatke vimeniku, koledarske vpise in datoteke.

Nastavitve stanja pripravljenosti

Izberite Pripravljenost in med temi moznostmi:

« Aktiv. pripravljenost — Izberite Vklju€eno, da bi vkljucili aktivno pripravljenost; v tem stanju so na zaslonu prikazane bliznjice
do razli¢nih aplikacij.

+ Leva izbirna tipka, Desna izbirna tipka — Zamenjajte bliZnjice, ki jih lahko v pripravljenosti odprete z levo in desno izbirno
tipko. Pritisnite krmilno pal€ko, izberite funkcijo na seznamu in OK.

+ Navigac. tipka desno, Navigac. tipka levo, Navigac. tipka dol, Navigac. tipka gor, Izbirna tipka — Zamenjajte bliZnjice, ki jih
lahko odprete s premikanjem krmilne palCke v razlitne smeri. Te nastavitve niso na voljo, e ste izbrali Aktiv.
pripravljenost > Vkljuteno.

« Aplikacije v priprav. — Izberite aplikacije, do katerih Zelite dostopati v aktivni pripravljenosti.

+ Nabiralnik v aktivni pripravljenosti — Izberite mapo s prejetimi sporoCili ali nabiralnik, ki naj bo prikazan v aktivni
pripravljenosti.

« Viti€niki v aktivni pripravljenosti — Izberite vtiCnike, ki naj bodo prikazani v aktivni pripravljenosti. Vidite lahko na primer,
koliko je sporocil v telefonskem predalu. Tudi €e izkljucite obvestanje v aktivni pripravljenosti o neodgovorjenih klicih in
sporocilih, se bodo vseeno prikazala privzeta obvestila. Morda ne bodo vedno na voljo isti vticniki.

Nastavitve zaslona

Izberite Zaslon in med temi moznostmi:

 Senzor za svetlobo — Prilagodite kolifino svetlobe, potrebne za osvetlitev zaslona naprave.

« (asdovartevanja— Izberite zakasnitev, po kateri naj se vkljuti ohranjevalnik zaslona. Vklop ohranjevalnika zaslona podaljsa
Cas delovanja naprave.

« (as osvetlitve — Izberite, kako hitro po zadnjem pritisku katere koli tipke naj zaslon potemni.

B Klicne nastavitve

Izberite Klic in med temi moznostmi:

+ Posiljanje lastne $t. — Izberite Da, da bodo klicane osebe videle vaso telefonsko Stevilko, ali Privzeto, ¢e naj vklop ali izklop
posiljanja Stevilke dololi omrezZje.
« Pogdlji lastni internet. ID — Vkljucite to funkcijo, e Zelite, da bodo prejemniki internetnih klicev videli vaso kodo ID.
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« (akajoti klic — Izberite Vkljuti, te Zelite biti med Ze vzpostavljenim klicem opozorjeni na nov dohodni klic, ali Preveri
stanje, da bi preverili, ali je ta funkcija Ze vklju€ena.

« (akajoti internetni klic — Vkljuite to funkcijo, ¢e Zelite, da vas omreZje med Ze vzpostavljenim internetnim klicem opozori
na nov dohodni Klic.

+ Opoz. na internet. kl. — (e vkljutite to moZnost, bo naprava obvestila klicalca, da ste zasedeni. Kadar je moznost izkljutena,
naprava predvaja klicalcu ton zasedene linije in prikaze obvestilo 0 neodgovorjenem Klicu.

« Privzeta vrsta klica — Izberite Mobilni klic, Ce Zelite telefonsko Stevilko klicati obicajno, ali Internetni klic, da bi Stevilko ali
naslov klicali prek internetnega protokola.

« Zavrni klic z SMS — Izberite Da, Ce Zelite, da naprava ob zavrnitvi klica klicalcu samodejno poslje besedilno sporocilo s
pojasnilom, zakaj klica niste mogli sprejeti.

+ Besedilo sporo€ila — Vnesite besedilo sporoCila, ki bo poslano ob zavrnitvi klica.

* Slika v video klicu — Izberite Uporabi izbrano in sliko, ki bo med video klicem prikazana namesto videa v Zivo, ali Brez, da
posiljanje slike izkljuCite.

« Samod. ponovni klic — Izberite Vkljuteno, da bo naprava samodejno znova poklicala Stevilko, ki je bila ob prvem poskusu
klicanja zasedena. Po neuspelem klicu bo naprava poskusila $e najve¢ desetkrat.

 Povzetek po klicu — Izberite Vkljueno, e Zelite, da naprava na kratko prikaze priblizno trajanje zadnjega klica.

« Hitro klicanje — Izberite Vklju€eno, da omogoCite funkcijo hitrega klicanja. Telefonsko Stevilko lahko hitro pokli€ete tako, da
pridrzite tipko za hitro klicanje (od 2 do 9), ki ste jo doloCili zanjo.

Glejte "Hitro klicanje"”, str. 33.

« 0Odg. s katerok. tipko — Izberite Vkljueno, Ce Zelite dohodne klice sprejemati s kratkim pritiskom katere koli tipke, razen
tipke za konec.

« Uporabljena linija— Izberite Linija 1 ali Linija 2, Ce Zelite zamenjati telefonsko linijo za odhodne klice in posiljanje besedilnih
sporoCil (omreZna storitev). Nastavitev je na voljo samo, Ce kartica SIM podpira dve narocniski Stevilki in ste na to storitev
narodeni.

« Menjava linije — Izberite Onemogoti, da bi prepretili menjavo linije (omreZna storitev). (e Zelite spremeniti to nastavitev,
potrebujete kodo PIN2.

 Opoz. na internet. kl. — Izberite Izkljuteno, da bo naprava zasedena za dohodne internetne klice, ali Vkljueno, ce Zelite
sprejemati internetne klice.

B Nastavitve povezave

Izberite Meni > Orodja > Nastavitve > Povezava in eno od naslednjih moZnosti:

« Dostopne totke — Ustvarite nove ali uredite obstojece dostopne tocke. Ponudnik storitev je lahko v vasi napravi nastavil
nekatere ali vse dostopne tocke, ki jih morda ne boste mogli urediti, odstraniti ali ustvariti novih.

« Skupine dostopnih totk — Dolocite nove ali uredite obstojee skupine dostopnih tock, ki jih Zelite uporabiti za samodejno
vzpostavitev povezave in e-poStno sledenje.

« Paketni prenos — Dolocite, kdaj naj se uporablja paketna podatkovna povezava, in vnesite dostopno totko, ¢e napravo
uporabljate kot racunalniski modem.

 Nastavitve internet. tel. — DoloCite nastavitve za internetne klice.

+ Nastavitve SIP — Preglejte obstojete profile SIP za zatenjanje sej ali ustvarite nove.

- Podatkovni klic — Izberite zakasnitev, po kateri se podatkovni klici samodejno kon¢ajo.

» NZO — Namestite in upravljajte pravilnike NZO, upravljajte streZnike pravilnikov NZO, prikaZite dnevnik NZO, ustvarite in
upravljajte dostopne tocke NZO.

« BrezZitni LAN — Dolodite, ali naj naprava prikaZze znak, ko je na voljo omrezje WLAN, in kako pogosto naj is¢e omrezja.

» Nastavitve — Preglejte ali zbriSite zaupanja vredne streznike, od katerih lahko naprava prejme konfiguracijske nastavitve.

Informacije o omrezjih WLAN in naroCanju paketnih podatkovnih storitev ter ustrezne nastavitve povezave in konfiguracije

lahko dobite pri mobilnem operaterju ali ponudniku storitev.

Morda ne bo vedno mogoce urediti istih nastavitev.

Dostopne tocke
Izberite Meni > Orodja > Nastavitve > Povezava > Dostopne totke.

Vasa naprava prek dostopne tocke vzpostavlja podatkovne povezave z omrezjem. Pred uporabo e-poste in vepredstavnostnih
sporodil ali brskanjem po spletnih straneh morate doloCiti dostopne tocke za te storitve.

Skupina dostopnih tock se uporablja za zdruZevanje in razvr$€anje dostopnih to¢k po pomembnosti. Aplikacija lahko za nacin
povezave namesto ene dostopne tocke uporablja skupino dostopnih tock. V tem primeru je za vzpostavitev povezave
uporabljena najprimernej$a dostopna tocka v skupini, pri uporabi e-poste pa tudi za sledenje.

Ponudnik storitev je lahko v vasi napravi nastavil nekatere ali vse dostopne tocke, ki jih morda ne boste mogli urediti, odstraniti
ali ustvariti novih.

Glejte "Internetne dostopne tocke", str. 45.
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Skupine dostopnih tock

Izberite Meni > Orodja > Nastavitve > Povezava > Skupine dostopnih tock.

Skupina dostopnih tock se uporablja za zdruZevanje in razvr$tanje dostopnih to¢k po pomembnosti. Aplikacija lahko za nacin
povezave namesto ene dostopne tocke uporablja skupino dostopnih tock. V tem primeru je za vzpostavitev povezave

uporabljena najprimernej$a dostopna totka v skupini, pri uporabi e-poste pa tudi za sledenje. Glejte "Skupine dostopnih
toCk", str. 53.

Paketni podatki
Izberite Meni > Orodja > Nastavitve > Povezava > Paketni prenos.

VaSa naprava podpira paketne podatkovne povezave, kakrsna je v omrezjih GSM storitev GPRS. Kadar uporabljate napravo v
omrezjih GSM in UMTS, je hkrati lahko dejavnih ve¢ podatkovnih povezav; dostopne tocke si lahko delijo podatkovno povezavo
in podatkovne povezave se ohranijo tudi na primer med glasovnimi Klici. Glejte "Nadzornik povezav", str. 52.

Nastavitve paketne povezave

Nastavitve paketnega prenosa podatkov vplivajo na vse dostopne tocke, ki uporabljajo paketno podatkovno povezavo.
Izberite med temi moznostmi:

« Povez. za paketni pr. — Izberite Ko je na voljo, e Zelite napravo nastaviti tako, da se ob vklopu v omreZzju, ki to funkcijo
podpira, samodejno prijavi vomrezje za paketni prenos podatkov. Izberite Po potrebi, ¢e naj se paketna podatkovna povezava
vzpostavi samo, kadar jo potrebuje ena od aplikacij ali funkcij.

« Dostopna totka — Vnesite ime dostopne tocke, ki ste ga dobili od ponudnika storitev, Ce Zelite napravo uporabljati kot
raCunalniski modem za paketni prenos podatkov.

Te nastavitve vplivajo na vse dostopne tocke, ki uporabljajo paketno podatkovno povezavo.

Nastavitve internetnih klicev
Izberite Meni > Orodja > Nastavitve > Povezava > Nastavitve internet. tel.. Izberite MoZnosti > Nov profil ali Moznosti > Uredi.
Pomaknite se na Ime, pritisnite krmilno palcko, vpisite ime profila in izberite OK.

Pomakanite se na Profili SIP, pritisnite krmilno palCko, izberite profil in OK. Protokoli SIP se uporabljajo za ustvarjanje,
spreminjanje in zaklju€evanje komunikacijskih sej z enim ali ve¢ udeleZenci, na primer internetnih klicev. Profili SIP vklju€ujejo
tudi nastavitve teh sej.

Nastavitve shranite s pritiskom na tipko Nazaj.

Nastavitve protokola SIP

Izberite Meni > Orodja > Nastavitve > Povezava > Nastavitve SIP.

Protokoli za zacenjanje sej (SIP) se uporabljajo za ustvarjanje, spreminjanje in zaklju€evanije nekaterih vrst komunikacijskih sej
z enim ali ve€ udelezenci (omrezna storitev). Profili SIP vklju€ujejo tudi nastavitve teh sej. Privzeti profil SIP za komunikacijsko
sejo je prikazan podCrtano.

(e Zelite ustvariti profil SIP, izberite MoZnosti > Dodaj novega > Uporabi privzeti profil ali Uporabi obstojeti profil.

Profil SIP lahko uredite, Ce se pomaknete nanj in pritisnete krmilno palcko.

(e Zelite izbrati privzeti profil SIP za komunikacijske seje, se pomaknite na Zeleni profil in izberite MoZnosti > Privzeti profil.
Profil SIP zbriSete tako, da se pomaknete nanj in pritisnete vratalko.

Urejanje profilov SIP

Izberite Meni > Orodja > Nastavitve > Povezava > Nastavitve SIP > Moznosti > Dodaj novega ali Uredi.
Izberite med temi moZnostmi:

+ Ime profila— Vnesite ime za profil SIP.

* Profil storitve — Izberite IETF ali Nokia 3GPP.

« Privzeta dostopna totka — Izberite dostopno tocko za povezavo z internetom.

« Javno uporabnisko ime — VpiSite uporabniSko ime, ki vam ga je dodelil ponudnik storitev.
« Uporabi stiskanje — Dolocite, ali naj se uporablja stiskanje.

* Registracija — Izberite natin registracije.

+ Uporabi zasCito — Izberite, ali naj se uporablja postopek zasCite.

 Posredniski streZnik — Vnesite nastavitve posredniskega streznika za ta profil SIP.

+ Registrski streZnik — Vnesite nastavitve registracijskega streZnika za ta profil SIP.

Morda ne bo vedno mogoce urediti istih nastavitev.

Urejanje posredniskih streznikov SIP
Izberite Meni > Orodja > Nastavitve > Povezava > Nastavitve SIP > MoZnosti > Dodaj novega ali Uredi > Posredniski streZnik.
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Posredniski strezniki so posredniki med storitvijo spletnega brskanja in njenimi uporabniki; uporabljajo jih nekateri ponudniki
storitev. Ti strezniki lahko omogocajo dodatne varnostne funkcije in pospesujejo dostop do storitve.

Izberite med temi mozZnostmi:

+ Naslov posredn. strezn. — Vnesite gostiteljsko ime ali naslov IP uporabljenega posredniskega streznika.

« Domena — Vnesite domeno posrednisSkega streznika.

» Uporabnisko ime in Geslo — VpiSite svoje uporabnisko ime in geslo za povezavo s posredniskim streznikom.

» Dovali ohl. preusm. — Izberite, ali je dovoljeno ohlapno preusmerjanje.

 Vrsta prenosa — Izberite UDP ali TCP.

+ Vrata — VpiSite Stevilko vrat posredniSkega streZznika.

Urejanje registracijskih streznikov

Izberite Meni > Orodja > Nastavitve > Povezava > Nastavitve SIP > MoZnosti > Dodaj novega ali Uredi > Registrski streZnik.
Izberite med temi moznostmi:

+ Naslov registr. strezn. — Vnesite gostiteljsko ime ali naslov IP uporabljenega registracijskega streznika.

« Domena — Vnesite domeno registracijskega streznika.

» Uporabnisko ime in Geslo — Vpisite svoje uporabnisko ime in geslo za povezavo z registracijskim streznikom.
 Vrsta prenosa — Izberite UDP ali TCP.

» Vrata — Vnesite Stevilko vrat registracijskega streznika.

Nastavitve za podatkovne klice
Izberite Meni > Orodja > Nastavitve > Povezava > Podatkovni klic.

(e Zelite nastaviti zakasnitev, po kateri se podatkovni klici samodejno kontajo, ¢e ni prenosa podatkov, izberite Trajanje
povezave in pritisnite krmilno paltko. Izberite Uporabni$ko dolo€eno, Ce Zelite ¢as vnesti sami, ali Neomejeno, da bo povezava
vzpostavljena, dokler ne izberete Moznosti > Prekini.

NzO
Dostopne totke NZO

Da bi upravljali dostopne totke NZO, izberite NZO > Dostopne totke NZO > MoZnosti in eno od naslednjih moznosti:

+ Uredi — Uredite izbrano dostopno totko. Ce je dostopna totka v uporabi oziroma so njene nastavitve zatitene, je ne morete
urejati.

+ Nova dostop. totka — Ustvarite novo dostopno totko NZO.

« Zbri8i — Zbrisite izbrano dostopno tocko.

Nastavitve dostopne totke NZO

Pravilne nastavitve dostopne totke dobite pri ponudniku storitev.

(e Zelite urejati nastavitve dostopne totke NZO, izberite dostopno totko in MoZnosti.

Izberite med temi moznostmi:

+ Ime povezave — Vnesite ime za povezavo NZO. Ime ima lahko najvet 30 znakov.

* Pravilnik NZO — Izberite pravilnik NZO za to dostopno totko.

« Intern. dostop. totka — Izberite internetno dostopno tocko, ki jo Zelite uporabljati s to dostopno tocko NZO.
« Naslov posredn. str. — Vnesite naslov posredniskega streZnika za to dostopno tocko NZO.

« St. vrat posr. strezn. — Vnesite Stevilko vrat posredniskega streznika.

Omrezje WLAN

Izberite Meni > Orodja > Nastavitve > Povezava > BrezZitni LAN.

(e naj naprava prikaze znak, kadar je na voljo omreZje WLAN, izberite Prik. razpoloZljivost > Da.

(e Zelite izbrati Casovni interval, v katerem naj naprava iste omreZja WLAN in posodobi ustrezni znak, izberite Iskanje
omrezij.

Dodatne nastavitve WLAN

Izberite Meni > Orodja > Nastavitve > Povezava > BrezZitni LAN > MoZnosti > Dodatne nastavitve. Dodatne nastavitve za omreZja

WLAN se navadno dolocijo samodejno; spreminjanje nastavitev ni priporocljivo.

(e Zelite rotno urediti nastavitve, izberite Samod. konfiguracija > Onemogotena in dolotite naslednje:

+ Dolga omejitev posk. — Vnesite najvecje Stevilo poskusov prenosa, Ce naprava ne dobi potrditvenega sprejemnega signala
od omrezja.

« Kratka omej. posk. — Vnesite najvedje Stevilo poskusov prenosa, ¢e naprava od omreZzja ne dobi potrditvenega signala za
posiljanje.
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+ Prag RTS — Dolocite velikost paketa podatkov, pri kateri naprava dostopne tocke omreZja WLAN pred posiljanjem paketa
izda zahtevo za posiljanje.

« Stopnja moci oddaj. — DoloCite, s kaksno modjo naj naprava posilja podatke.

+ Radijske meritve — OmogoCite ali preprecite radijske meritve.

« VarCevanje z energijo — lIzberite, ali naj naprava varuje z energijo baterije.

Vse nastavitve ponastavite na prvotne vrednosti tako, da izberete MoZnosti > Obnovi privzeto.

Varnostne nastavitve za dostopne totke WLAN

Izberite Meni > Orodja > Nastavitve > Povezava > Dostopne tocke. Izberite MoZnosti > Nova dostop. tocka in zacnite ustvarjati
dostopno totko WLAN ali pa izberite dostopno totko WLAN in MoZnosti > Uredi.

Varnostne nastavitve WEP

V nastavitvah dostopne tocke izberite Zastita omrezja WLAN > WEP.

Nacin Sifriranja WEP (Wired Equivalent Privacy) Sifrira podatke pred prenosom. Uporabniki, ki nimajo ustreznih klju¢ev WEP, ne
morejo dostopati do omreZja. Ko je vkljuen varnostni nacin WEP, bo vasa naprava zavrgla prejete podatkovne pakete, ki niso
Sifrirani s klju€i WEP.

V omrezju Ad hoc morajo vse naprave uporabljati isti klju¢ WEP.

Izberite Nast. zasCite WLAN in med temi moZnostmi:

« Uporablj. klju¢ WEP — Izberite Zeleni klju¢ WEP.
* Vrsta potrjevanja — Izberite Odprto ali Skupno.
+ Nastavit. kljutev WEP — Uredite nastavitve klju¢a WEP.

Nastavitve klju¢a WEP

V nastavitvah dostopne tocke izberite Zastita omrezja WLAN > WEP.

V omreZju Ad hoc morajo vse naprave uporabljati isti klju¢ WEP.

Izberite Nast. zasCite WLAN > Nastavit. klju€ev WEP in eno od naslednjih moznosti:

+ Sifriranje WEP — Izberite Zeleno dolZino Sifrirnega kljuca WEP.
« Zapis kljuta WEP — Izberite, ali Zelite vpisati podatke kljuta WEP v besedilni (ASCII) ali Sestnajstiki obliki.
« Kljut WEP — Vpisite podatke klju¢a WEP.

Varnostne nastavitve 802.1x
V nastavitvah dostopne toCke izberite ZasCita omrezja WLAN > 802.1x.

Standard 802.1x omogota overjanje naprav in odobritev njihovega dostopa do brezZitnega omreZja. Ce odobritveni postopek
ne uspe, je napravam dostop onemogocen.

Izberite Nast. zasCite WLAN in med naslednjimi moZnostmi:

» Nadin WPA — Izberite prvotokol EAP (Extensible Authentication Protocol) ali Klju€ PSK (tajni kljuc za identifikacijo naprav).
* Nastav. vti¢nikov EAP — Ce ste izbrali Natin WPA > EAP, doloCite vtitnike EAP v napravi, ki naj se uporabljajo z dostopno totko.
« Klju€ PSK — Ce ste izbrali Na€in WPA > Kljuc PSK, vnesite zasebni kljug, po katerem bo omrezje WLAN prepoznalo vaso napravo.

Morda ne bo vedno mogoce urediti istih nastavitev.

Varnostne nastavitve WPA

V nastavitvah dostopne totke izberite Zastita omrezja WLAN > WPA/WPA2.
Izberite Nast. zasCite WLAN in med naslednjimi moZznostmi:

« Nadin WPA — Izberite prvotokol EAP (Extensible Authentication Protocol) ali Klju€ PSK (tajni kljuc za identifikacijo naprav).

« Nastav. vti¢nikov EAP — (e ste izbrali Nacin WPA > EAP, doloCite vti¢nike EAP v napravi, ki naj se uporabljajo z dostopno tocko.
+ Kljut PSK— Ce ste izbrali Nacin WPA > Kljut PSK, vnesite zasebni klju¢, po katerem bo omreZje WLAN prepoznalo va$o napravo.
Morda ne bo vedno mogoce urediti istih nastavitev.

EAP

(e si Zelite ogledati vticnike EAP (Extensible Authentication Protocol), ki so trenutno namesteni v napravi (omrezna storitev),
izberite Meni > Orodja > Nastavitve > Povezava > Dostopne totke. Izberite MoZnosti > Nova dostop. tocka, doloite dostopno
tocko, ki za podatkovni nosilec uporablja omreZje WLAN, in izberite varnostni nacin 802.1x ali WPA/WPA2. Izberite Nast. zasCite
WLAN > Nacin WPA > EAP, pomaknite se na Nastav. vti€nikov EAP in pritisnite krmilno palcko.

Vticniki protokola EAP (Extensible Authentication Protocol) se uporabljajo v brezzicnih omrezjih za preverjanje pristnosti
brezzitnih naprav in streznikov. Razli¢ni vti¢niki EAP omogocajo uporabo razli¢nih nacinov EAP (omreZna storitev).

(e Zelite pri povezovanju z omreZjem WLAN prek dostopne totke uporabljati vticnik EAP, izberite Zeleni vti¢nik in MoZnosti >
Omogodi. Poleg vti¢nikov EAP, ki ste jim omogoCili uporabo s to dostopno tocko, so prikazane kljukice. Ce vti¢nika ne Zelite
uporabljati, izberite Moznosti > Onemogoci.

(e Zelite urediti nastavitve vticnika EAP, izberite Moznosti > Konfiguriraj.
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(e Zelite spremeniti nastavitve prednosti vticnika EAP, izberite MoZnosti > Povi$aj pomembnost, da bo naprava pri povezovanju
z omrezjem prek dostopne tocke skusala ta vti¢nik uporabiti pred drugimi, ali MoZnosti > ZniZaj pomembnost, da bo naprava
pri preverjanju pristnosti uporabila ta vti¢nik po poskusu uporabe drugih.

Morda ne bodo vedno na voljo iste moznosti.

Konfiguracije

(e Zelite prikazati ali zbrisati konfiguracije za zaupanja vredne streZnike, izberite Meni > Orodja > Nastavitve > Povezava >
Nastavitve.

Od mobilnega operaterja, ponudnika storitev ali skrbnika informacijskega sistema v podjetju lahko prejemate sporocila s
konfiguracijskimi nastavitvami za zaupanja vredne streznike. Te nastavitve se samodejno shranijo v meni Nastavitve. Prejmete
lahko konfiguracijske nastavitve za dostopne tocke, vepredstavnostna sporoCila, e-postne storitve in hitra sporocila ali
sinhronizacijske nastavitve.

Konfiguracijo zaupanja vrednega streZnika zbriSete tako, da se pomaknete na streznik in pritisnete vracalko. Zbrisejo se tudi
konfiguracijske nastavitve, ki temeljijo na tem strezniku, za druge aplikacije.

B Nastavitve ure in datuma
Glejte "Ura", str. 44.

B Varnostne nastavitve
Glejte "Dolocanje varnostnih nastavitev", str. 90.

B OmreZne nastavitve

Izberite Meni > Orodja > Nastavitve > Omrezje.
Dolocite naslednje:

« OmreZni natin (moZnost je prikazana samo, Ce jo operater podpira) — Izberite vrsto omrezja. Izberete lahko GSM ali UMTS;
Ce vkljucite Dvojni nacin, bo naprava samodejno preklapljala med obema vrstama. Ta nastavitev je morda v napravi ze
dolotena in je ni mogote urejati. (e napravo nastavite tako, da uporablja samo omreZje GSM ali samo UMTS, izbrano omreZje
pa ni na voljo, ne boste mogli klicati, niti v sili, ali uporabljati drugih funkcij, ki potrebujejo povezavo z omrezjem.

* lzbira operaterja— Izberite Rotno in eno od omrezij ali Samodejno, Ce Zelite, da naprava sama poisce eno od omreZzij, ki so
na voljo v danem obmocgju.

« Informacije o celici — Ce izberete Vkljuteno, vas naprava obvesti, kdaj uporablja celitno omreZje tehnologije MCN.

B Nastavitve dodatne opreme

Izberite Meni > Orodja > Nastavitve > Dodat. oprema.

& Opozorilo: Uporaba slusalk lahko vpliva na sposobnost zaznavanja zvokov iz okolice. SluSalk ne uporabljajte, kadar bi
to lahko ogrozilo vaSo varnost.

Pri veCini dodatne opreme lahko izbirate med naslednjimi nastavitvami:

« Privzeti profil — Izberite profil, ki se vkljuci ob priklopu dodatne opreme na napravo.

« Samodejni sprejem — Nastavite napravo tako, da bo med priklopom na dodatno opremo samodejno sprejemala telefonske
klice. Izberite Vklju€eno, e Zelite, da naprava po petih sekundah samodejno sprejme dohodni klic. (e je opozarjanje na
dohodni klic v meniju Profili nastavljeno na Kratek pisk ali Tiho, je samodejno sprejemanije klicev onemogoceno.

« Osvetlitev — Izberite Vkljucena, Ce Zelite, da je zaslon osvetljen, medtem ko je naprava povezana z dodatno opremo.

Nastavitve za Besedilni telefon

(e uporabljate besedilni telefon (TTY), ga morate pred spreminjanjem nastavitev in uporabo povezati z napravo. Izberite med
naslednjimi mozZnostmi:

* Privzeti profil — Izberite profil, ki naj se vklju€i ob priklopu besedilnega telefona (terminala TTY) na napravo.
« Upor. besed. telefon — Izberite Da, Ce Zelite zaleti uporabljati besedilni telefon.
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B Varnost naprave

Izberite Meni > Orodja > Nastavitve > Varnost > Telefon in SIM.

Uredite lahko varnostne nastavitve za kodo PIN, samodejno zaklepanje in zamenjavo kartice SIM ter spremenite kode in gesla.
Ne uporabljajte kod, podobnih stevilkam za klice v sili, da tako prepretite nenamerno klicanje Stevilke za klice v sili.

Kode so prikazane z zvezdicami. Ko spreminjate kode, vpisite najprej trenutno kodo in nato dvakrat novo kodo.

Dolotanje varnostnih nastavitev

(e Zelite dolotiti nastavitve za napravo in kartico SIM, izberite nastavitev in MoZnosti > Spremeni.

Stevilko za klice v sili, ki je vprogramirana v napravo, lahko morda poklitete, tudi ¢e so klici omejeni na zaprto uporabnisko
skupino.

DoloCite naslednje:

« Zahteva po kodi PIN — (e izberete Vkljuteno, bo naprava ob vsakem vklopu zahtevala, da vnesete kodo PIN. Te nastavitve ni
mogode spremeniti, Ce je naprava izklju€ena. Nekatere kartice SIM ne dovoljujejo, da se izklopi zahtevanje kode PIN.

+ KodaPIN — Spremenite kodo PIN. Koda PIN mora biti 4- do 8-mestna. Varuje kartico SIM pred nepooblasteno uporabo, dobite
jo s kartico. Po treh zaporednih napacnih vnosih se koda PIN blokira. Da bi lahko spet uporabljali kartico SIM, jo morate
odblokirati z vnosom kode PUK.

+ Koda PIN2 — Spremenite kodo PIN2. Koda PIN2 mora biti 4- do 8-mestna. Koda PIN2, ki je priloZzena kartici SIM, je potrebna
za dostop do nekaterih funkcij naprave. Po treh zaporednih napacnih vnosih se koda PIN2 blokira. Da bi lahko spet uporabljali
kartico SIM, jo morate odblokirati z vnosom kode PUK2.

« Zakasn.samod. zakl. — DoloCite Cas, po katerem se naprava samodejno zaklene. Zaklenjeno napravo lahko uporabljate samo,
Ce vpisete pravilno kodo za zaklepanje. Vpisite Cas zakasnitve v minutah ali izberite Brez, da samodejno zaklepanje izkljudite.
Tudi Ce je naprava zaklenjena, boste morda lahko klicali Stevilko za klice v sili, ki je programirana v napravi.

+ Koda za zaklepanje — Spremenite kodo za zaklepanje. Nova koda mora biti 4- do 256-mestna. Uporabite lahko Stevilke ter
male in velike ¢rke. Naprava vas obvesti, Ce izbrana koda ni veljavna. Koda za zaklepanje je tovarnisko nastavljena na 12345.
(e Zelite prepreciti nepoobladteno uporabo naprave, jo morate spremeniti. Kodo hranite na skrivnem in varnem mestu, pro¢
od naprave.

 Zakleni ob zam. SIM— Nastavite napravo tako, da bo ob vstavitvi nove, neznane kartice SIM zahtevala vnos kode za zaklepanje.
Naprava hrani seznam Ze znanih in potrjenih kartic SIM.

+ Dovoli zaklep. na dalj. — Ce vkljutite to moZnost, lahko zaklenete napravo tako, da iz drugega telefona posljete vnaprej
pripravljeno besedilno sporocilo. Ce vkljutite to moZnost, morate vpisati besedilo sporocila za zaklepanje na daljavo in potrditi
besedilo. Sporotilo mora vsebovati vsaj 5 znakov.

« Zaprta skupina upor. (omrezna storitev) — DoloCite skupino ljudi, ki jih lahko kli€ete in ki lahko kliCejo vas.

+ Potrjevanije stor. SIM (omrezna storitev) — Napravo nastavite tako, da bo med uporabo storitve kartice SIM prikazovala
potrditvena sporotila.

Spreminjanje gesla za zaporo

(e Zelite spremeniti geslo za zaporo glasovnih, faks in podatkovnih klicev, izberite Meni > Orodja > Nastavitve > Zapore
klicev > Zapora za mobilne klice > MoZnosti > Sprem. geslo zapor. VpiSite trenutno geslo in nato dvakrat novo geslo. Geslo za
zaporo mora biti tirimestno. Ve informacij lahko dobite pri svojem ponudniku storitev.

Omejeno klicanje
Stevilko za klice v sili, ki je vprogramirana v napravo, lahko morda poklitete, tudi ¢e je vkljuéeno omejeno klicanje.
Izberite Meni > Imenik > Moznosti > Imenik kartice SIM > Imenik za omej. klic..

S storitvijo omejenega klicanja lahko klice iz naprave omejite na doloCene telefonske Stevilke. Storitve ne podpirajo vse kartice
SIM. Ve€ informacij lahko dobite pri ponudniku storitev.

Izberite MoZnosti in izbirajte med naslednjimi moznostmi:

« Vkljuti omejeno kl. — Omejite klice iz naprave. Ce Zelite storitev preklicati, izberite Izkljuci omejeno kl.. Za vklapljanje in
izklapljanje omejenega klicanja ter urejanje seznama dovoljenih $tevilk potrebujete kodo PIN2. (e je nimate, se obrnite na
svojega ponudnika storitev.

+ Nova vizitka SIM — Telefonsko $tevilko dodajte na seznam dovoljenih. Vnesite ime vizitke in telefonsko $tevilko. (e Zelite
omejiti klice z vstopno kodo drzave, vnesite Zeleno kodo v polje Nova vizitka SIM. Dovoljeno je le klicanje telefonskih Stevilk,
ki se zatnejo z vneseno kodo drzave.

+ Dodaj iz Imenika — Vizitko iz menija Imenik kopirajte na seznam za omejeno klicanje.
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varnost

:\é’: Nasvet: (e Zelite pri vklju¢enem omejenem klicanju posiljati besedilna sporotila na $tevilke, shranjene na kartici SIM,
morate na seznam dovoljenih $tevilk dodati $tevilko sporoCilnega centra.

(e Zelite pregledati ali urediti dovoljene telefonske $tevilke, izberite MoZnosti > Imenik kartice SIM > Imenik za omej. klic..
Stevilko poklitete s pritiskom na klicno tipko.
(e Zelite stevilko urediti, izberite MoZnosti > Uredi. Za urejanje seznama dovoljenih stevilk boste morda potrebovali kodo PIN2.

Stevilko zbrigete s pritiskom na vratalko.

B Upravitelj certifikatov

@ Pomembno: Ceprav je tveganje, povezano z oddaljenimi povezavami in namestanjem programske opreme, pri uporabi
certifikatov znatno manjse, jih morate za zagotovitev poveane varnosti uporabljati pravilno. Sam obstoj certifikata
ne zagotavlja nikakrsne zasCite — za omogocanje poveCane varnosti mora upravitelj certifikatov vsebovati pravilne,
pristne in zaupanja vredne certifikate. Certifikati imajo omejeno veljavnost. Ce bi certifikat moral biti veljaven, a se
prikaZe sporocilo Certifikat je potekel ali Certifikat Se ni veljaven, preverite, ali sta v vasi napravi nastavljena totna ura
in datum.

Pred spreminjanjem kakrsnih koli nastavitev certifikata se prepriajte, ali res zaupate njegovemu lastniku in ali
certifikat res pripada navedenemu lastniku.

Digitalni certifikati se uporabljajo za preverjanje izvora programske opreme, vendar ne zagotavljajo varnosti. Obstajajo tri vrste
certifikatov: certifikati certifikatnih agencij, osebni certifikati in strezniski certifikati. StreZnik lahko med varno povezavo vasi
napravi poslje strezniski certifikat. Ob prejemu ga naprava preveri z uporabo certifikata agencije, ki je shranjen v njej. Ce
identiteta streZnika ni pristna ali Ce v napravi ni ustreznega certifikata, ste o tem obvesceni.

Certifikat lahko naloZite s spletne strani, ga prejmete v e-postni prilogi ali sporocilu, poslanem po povezavi Bluetooth ali
infrardedi povezavi. Certifikati se uporabljajo pri prenasanju zaupnih podatkov med povezavo s spletnim ban¢nim sistemom ali
oddaljenim streZznikom. Uporabljajo se tudi za zmanjSanje tveganja zaradi virusov in druge nevarne programske opreme ter za
preverjanje pristnosti programske opreme, ki jo nalagate in namescate v napravo.

:\é’: Nasvet: Ko dodate nov certifikat, preverite njegovo pristnost.

Delo z osebnimi certifikati

Osebni certifikati so certifikati, ki so izdani vam.

(e Zelite v napravo dodati certifikat, izberite datoteko certifikata in Shrani. Ce Zelite odstraniti izbrani certifikat, izberite
MoZnosti > Zbrisi.

(e Zelite preveriti pristnost certifikata, izberite certifikat in PrikaZi podrobnosti. Prstni odtisi pomenijo enolitno identifikacijo
certifikatov. Obrnite se na podporo uporabnikom za imetnike certifikatov in prosite za primerjavo prstnih odtisov. Sestmestni
zasebni kljuc vsebuje gesla in tajne kljuce, ki jih prejmete z osebnimi certifikati.

Delo s certifikati agencije

To vrsto certifikatov nekatere storitve uporabljajo za preverjanje veljavnosti drugih certifikatov.

(e zelite v napravo dodati certifikat, izberite datoteko certifikata in Shrani. (e Zelite odstraniti izbrani certifikat, izberite
Moznosti > Zbrisi.

(e Zelite preveriti pristnost certifikata, izberite certifikat in PrikaZi podrobnosti. Prstni odtisi pomenijo enolitno identifikacijo
certifikatov. Obrnite se na podporo uporabnikom za imetnike certifikatov in prosite za primerjavo prstnih odtisov. Sestmestni
zasebni kljuc vsebuje gesla in tajne kljuce, ki jih prejmete z osebnimi certifikati.

Zaupanje certifikatu pomeni, da z njim preverjate spletne strani, e-postne streznike, programske pakete in druge podatke. Za
preverjanje storitev in programske opreme lahko uporabljate samo zaupanja vredne certifikate.

(e Zelite spremeniti nastavitve zaupanja, izberite certifikat in MoZnosti > Nastavit. zaupanja. |zberite aplikacijo in Da ali Ne.
Nastavitev zaupanja osebnega certifikata ne morete spreminjati.

Za vsak certifikat je prikazan seznam aplikacij, ki ga lahko uporabljajo:

» Namest. za Symbian — Nova aplikacija za operacijski sistem Symbian.
* Internet — E-poSta in grafika.

+ Namestitev aplikac. — Nova aplikacija Java™.

+ Spletno preverj. cert. — Protokol za spletno preverjanje certifikatov.

Prikaz podrobnosti certifikata

O identiteti streznika ste lahko prepricani le, e sta bila preverjena podpis in obdobje veljavnosti strezniSkega certifikata.
(e Zelite prikazati podrobnosti certifikata, izberite certifikat in PrikaZi podrobnosti.
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varnost

PrikaZejo se lahko naslednje opombe:

« Certifikatu ne zaupate — Niste nastavili aplikacije, ki bo certifikat uporabljala. Spremenite nastavitve zaupanja.
« Certifikat je potekel — Izbrani certifikat ni ve€ veljaven.

- Certifikat e ni veljaven — Obdobje veljavnosti izbranega certifikata se $e ni zacelo.

- Certifikat je poskodovan — Certifikata ni mogoce uporabljati. Obrnite se na izdajatelja certifikata.

Varnostne nastavitve certifikata
I1zberite med temi moznostmi:

« Namestanje aplikacij — Izberite namestitev vseh aplikacij ali samo podpisanih.
« Prev. certif. ob pov. — Ce Zelite preveriti veljavnost certifikatov ob names¢anju aplikacije, izberite Vklju€eno.
* Privz.spletni naslov— Ce certifikat ne vsebuje lastnega spletnega naslova, se njegova veljavnost preveri na privzetem naslovu.

Bl NZO

Glejte "Mobilno navidezno zasebno omrezje", str. 52.

B Varnostne nastavitve za dostopne totke WLAN
Glejte "Varnostne nastavitve za dostopne tocke WLAN", str. 88.
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19.  BliZnjice

Na tem mestu so zbrane razpoloZljive bliznjice za vaSo napravo. Z bliznjicami lahko aplikacije uporabljate ucinkoviteje.

Nekatere bliZznjice so odvisne od aplikacije, zato niso vedno na voljo.

Stanje aktivne pripravljenosti

Leva izbirna tipka + modra funkcijska tipka

Zaklepanje in odklepanje tipkovnice.

Klicna tipka Odpiranje menija Dnevnik.
0 Tipko pridrZite, da odprete Storitve in se poveZete s spletom.
1 Pritisnite in pridrzite, Ce Zelite poklicati svoj telefonski predal.

Stevilska tipka (2-9)

Hitro poklicite telefonsko Stevilko. Najprej morate omogociti hitro
klicanje (Meni > Orodja > Nastavitve > Klic > Hitro klicanje > Vkljueno).

V aplikacijah

Izbiranje besedila. PridrZite dvigalko ter krmilno
palcko potisnite levo ali desno, da bi izbrali besedilo.

Dvigalka + krmilna paltka

Kopiranje. Ctrl+C
Izrezovanje. Ctrl + X
Lepljenje. Ctrl +V
LeZeCa pisava. Ctrl + 1
Krepka pisava. Ctrl +B

Vnos Stevilke ali znaka, ki sta na tipki izpisana modro.

Enkrat pritisnite modro funkcijsko tipko (tako da zagledate &) in drugo
tipko.

Vna3anje samo Stevilk ali znakov, ki so na tipkah
izpisani modro.

Dvakrat pritisnite modro funkcijsko tipko (tako da zagledate ¥J) indrugo
tipko.

Preklapljanje med velikostma Crk.

Pritisnite dvigalko.

Pregledovalnik slik

Poslje sliko.

Klicna tipka

Manj$a povecava.

0

Velja poveava.

5

Vedja povecava. Pritisnite dvakrat za prikaz na celem
zaslonu.

7

Pomik levo v povecani sliki.

Pomik desno v povectani sliki.

Pomik gor v povecani sliki.

Pomik dol v povecani sliki.

Vrtenje v smeri urnega kazalca.

Vrtenje v nasprotni smeri urnega kazalca.

P W[(O (N O |hN

Preklop med obicajnim in celozaslonskim prikazom.
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Informacije o bateriji

Vaso napravo napaja baterija, ki jo je mogoce polniti. Nova baterija bo dosegla svojo polno zmogljivost Sele po dva- ali trikratnem
popolnem polnjenju in praznjenju. Baterijo je mogoCe napolniti in sprazniti veC stokrat, postopoma pa se vendarle izrabi. Ko se
Cas pogovora in €as v pripravljenosti znatno skraj$ata, kupite novo baterijo. Uporabljajte samo baterije in polnilnike, ki jih je za
uporabo s to napravo odobrila druzba Nokia.

Ko polnilnika ne uporabljate, ga iztaknite iz elektritne vticnice in naprave. Povsem polne baterije ne pusCajte priklju¢ene na
polnilnik, saj lahko ¢ezmerno polnjenje skrajsa Zivljenjsko dobo baterij. Ce povsem napolnjene baterije ne uporabljate, se ez
nekaj ¢asa sprazni sama od sebe.

(e je baterija popolnoma prazna, utegne trajati nekaj minut, preden se bo na zaslonu izpisalo obvestilo o polnjenju in preden
boste lahko klicali.

Baterijo uporabljajte samo za namene, za katere je narejena. Nikoli ne uporabljajte posSkodovanih polnilnikov ali baterij.

Ne povzroite kratkega stika baterije. Do nehotenih kratkih stikov lahko pride, Ce se kovinski predmet, na primer kovanec, sponka
ali pero, hkrati dotakne pozitivhega (+) in negativnega pola (-) baterije. (Pola sta videti kot kovinska trakova na bateriji.) To se
lahko zgodi, kadar na primer rezervno baterijo nosite v Zepu ali torbi. Kratki stik lahko poSkoduje baterijo ali predmet, ki ga je
sprozil.

(e pustate baterijo na vrotini ali mrazu, na primer v zaprtem avtomobilu poleti ali pozimi, se zmanjata njena zmogljivost in
Zivljenjska doba. Baterijo vedno hranite pri temperaturi med 15 in 25 °C (59 °F and 77 °F). Ce je baterija v napravi vrota ali
hladna, naprava morda nekaj €asa ne bo delovala, tudi Ce je baterija polna. Delovanje baterije je zlasti omejeno pri temperaturah
pod ledis¢em.

Ne mecite izrabljenihvbaterij v ogenj, saj jih lahko raznese. Raznese jo lahko tudi, Ce je poskodovana. Baterije zavrzite skladno
z lokalnimi predpisi. Ce je mogoce, jih reciklirajte. Ne odvrzite jih v smetnjak za hisne odpadke.

B Smernice za preverjanje pristnosti baterij Nokia

Zaradi lastne varnosti vedno uporabljajte originalne baterije Nokia. Da bi zagotovo dobili pristno baterijo Nokia, jo kupite pri
pooblas¢enem prodajalcu izdelkov Nokia, na embalazi poisite logotip pristne dodatne opreme Nokia in po naslednjem
postopku preglejte hologramsko nalepko:

Uspesna izvedba itirih korakov tega postopka Se ne zagotavlja pristnosti baterije. Ce mislite, da baterija ni pristni izdelek znamke
Nokia, je ne uporabljajte in se za nasvet obrnite na najblizji pooblaseni servis Nokia ali pooblas¢enega prodajalca izdelkov
Nokia. Poobla3teni servis ali prodajalec lahko preveri njeno pristnost. Ce pristnosti ni mogote preveriti, baterijo vrnite prodajalcu.

Preverjanje pristnosti holograma

1. Ko pogledate hologram na nalepki, naj bi bil iz enega kota viden znacilni znak druzbe Nokia z iztegnjenima
rokama, iz drugega pa logotip pristne dodatne opreme Nokia.

2. Ko hologram nagnete v levo, desno, navzgor in navzdol, naj bi ob straneh logotipa videli eno, dve, tri
oziroma Stiri pike.

3. (e stran nalepke spraskate, boste videli 20-mestno kodo, na primer 12345678919876543210. Baterijo
obrnite tako, da so $tevilke obrnjene navzgor. 20-mestna koda se zatne s Stevilko v zgorniji vrstici in se
nadaljuje v spodniji.

4. Veljavnost 20-mestne kode potrdite po navodilih na spletnem naslovu www.nokia.com/batterycheck.

Ustvarjanje besedilnega sporocila z 20-mestno kodo, na primer 12345678919876543210, in posiljanje na
Stevilko +44 7786 200276.

Pri tem veljajo lokalne in mednarodne tarife operaterjev.
Prejeli boste obvestilo, ali je pristnost kode mogoce preveriti.
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Informacije o bateriji

In Ce baterija ni pristna?

(e ne morete potrditi, da je baterija s hologramsko nalepko pristna baterija Nokia, je ne uporabljajte. Odnesite jo na najblizji
pooblasceni servis ali pooblasteno trgovino izdelkov Nokia, kjer vam bodo lahko svetovali. Uporaba baterije, ki je ni odobril
proizvajalec telefona, je lahko nevarna in povzro€i neucinkovito delovanje ter poskodbe naprave in dodatne opreme. Poleg tega
lahko tudi izni€i garancijo in moZnost zamenjave naprave.

Dodatne informacije o originalnih baterijah Nokia lahko dobite na spletni strani www.nokia.com/battery.
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Nega in vzdrZevanje

VaSa naprava je vrhunski izdelek tako glede oblike kot izdelave, zato je treba z njo ravnati skrbno. Z upoStevanjem spodnjih
predlogov boste laZje zascitili garancijo svoje naprave.

Skrbite, da bo naprava vedno suha. Padavine, vlaga in vse tekoCine lahko vsebujejo mineralne primesi, ki povzrocajo korozijo
elektronskih vezij. Ce se naprava zmodi, iz nje odstranite baterijo in pustite, da se naprava popolnoma posusi, preden baterijo
znova namestite.

Ne uporabljajte in ne hranite naprave v praSnem ali umazanem okolju. Njeni gibljivi in elektronski deli se lahko poSkodujejo.

Ne hranite naprave na vrocini. Visoke temperature lahko skraj$ajo Zivljenjsko dobo elektronskih naprav, poskodujejo baterije
in deformirajo nekatere vrste plastike.

Ne hranite naprave na mrazu. Ko se naprava nato segreje na obiajno temperaturo, se v njeni notranjosti nabere vlaga, ki
lahko poSkoduje elektronska vezja.

Naprave ne posku$ajte odpirati kako drugace, kot je opisano v tem prirocniku.

Varujte jo pred padci, udarci in tresljaji. Grobo ravnanje lahko poSkoduje notranja elektronska vezja in fine mehanske dele.
Za CisCenje ne uporabljajte kemikalij, Cistil ali mocnih detergentov.

Naprave ne barvajte. Barva lahko zlepi gibljive dele in prepreci pravilno delovanje.

Za CisCenje le¢, na primer leC fotoaparata, senzorja razdalje in senzorja svetlobe, uporabljajte mehko, Cisto in suho krpo.

Uporabljajte le priloZeno ali odobreno rezervno anteno. Z neodobrenimi antenami, prilagoditvami ali prikljucki lahko
poskodujete napravo in krSite predpise o radijskih napravah.

Polnilnike uporabljajte v zaprtih prostorih.

Preden napravo odnesete v popravilo, vedno naredite kopije podatkov, ki jih Zelite ohraniti, na primer imenika in koledarskih
belezk.

Vsi zgoraj napisani predlogi veljajo enako za napravo in za baterije, polnilnike ali opremo. (e katera koli naprava ne deluje
pravilno, jo odnesite v popravilo v najbliZji pooblasceni servis.
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Dodatni varnostni napotki

B Okolje delovanja

Upostevajte vse posebne predpise, ki veljajo za posamezna obmodja, in napravo vedno izklopite, kjer je njena uporaba
prepovedana ali kjer lahko povzroéi interferenco ali nevarnost. Uporabljajte jo samo v normalnem poloZaju delovanja. Ta
naprava ustreza smernicam za izpostavljenost radijskemu sevanju, kadar jo uporabljate v normalnem polozaju ob usesu ali
kadar je od telesa oddaljena najmanj 2,2 cm (7/8 palca). Ce nosite telefon med uporabo s torbico, pasom ali drzalom, naj ti ne
vsebujejo kovine, izdelek pa naj bo od telesa oddaljen toliko, kot je navedeno zgoraj.

Da bi lahko prena$ala podatkovne datoteke ali sporotila, mora ta naprava imeti kakovostno povezavo z omrezjem. V nekaterih
primerih lahko pride do odloZitve prenosa podatkovnih datotek ali sporocil, dokler ni na voljo ustrezna povezava. UpoStevajte
zgornja navodila za razdaljo od telesa, dokler prenos ni konc¢an.

Deli naprave so magnetni, zato privlaijo kovinske snovi. V blizino naprave ne polagajte kreditnih kartic in drugih magnetnih
medijev, ker se lahko na njih shranjeni podatki zbriSejo.

B Medicinske naprave

Delovanje katere koli radiooddajne opreme, tudi mobilnega telefona, lahko moti delovanje neustrezno zasCitenih medicinskih
naprav. PovprasSajte zdravnika ali proizvajalca medicinske naprave, ali je ustrezno zastitena pred zunanjimi radiofrekvencnimi
vplivi, in se posvetujte z njim tudi, ¢e imate kaka druga vpra$anja. Izklopite napravo v vseh zdravstvenih ustanovah, v katerih
jeoznaceno, daje njenauporaba prepovedana. V bolni$nicah ali zdravstvenih ustanovah morda uporabljajo medicinsko opremo,
ki je obCutljiva za zunanjo radiofrekventno energijo.

Sréni spodbujevalniki

Proizvajalci sr¢nih spodbujevalnikov priporo€ajo uporabo mobilnega telefona na razdalji vsaj 15,3 cm (6 palcev) od
spodbujevalnika, da bi se izognili morebitnim motnjam v njem. Omenjena priporocila so rezultati neodvisne raziskave in so
skladna s priporoCili raziskave o brezZi¢ni tehnologiji. Osebe s spodbujevalniki:

* naj imajo napravo vedno vsaj 15,3 cm (6 palcev) od srénega spodbujevalnika;

* naj naprave ne NOsijo v naprsnem Zepu in

* naj jo drZijo ob u3esu na nasprotni strani od spodbujevalnika, da bi kar najbolj zmanj$ali mozZnost interference.
« (e mislite, da je prislo do motenj, izkljutite napravo in jo umaknite.

Slusni pripomocki
Nekatere digitalne brezZi¢ne naprave lahko motijo delovanje nekaterih slusnih pripomotkov. Ce pride do interference, se
posvetujte s ponudnikom storitev.

Bl Vozila

Radiofrekvencni signali lahko motijo delovanje elektronskih sistemov v vozilu, €e niso ustrezno zasciteni ali Ce so nepravilno
vgrajeni (npr. sistemi za elektronsko vbrizgavanje goriva, protiblokirni zavorni sistemi, elektronski sistemi za nadzor hitrosti,
sistemi zraCnih blazin). Ve€ informacij lahko izveste pri proizvajalcu (ali njegovem zastopniku) vozila ali katere koli dodatne
opreme.

Napravo naj servisira ali jo vgrajuje v vozilo samo strokovno osebje. Nepravilna vgradnja ali servisiranje sta lahko nevarna ter
lahko iznicita garancijo za napravo. Redno preverjajte, ali je vsa brezzitna oprema v vasem vozilu pravilno vgrajena in ali deluje
pravilno. Ne hranite in ne prenasajte vnetljivih teko€in, plinov ali eksplozivnih snovi v istem prostoru kot napravo, njene dele
ali dodatno opremo. Upostevajte, da se v vozilih, opremljenih z zratno blazino, ta napihne zelo silovito. Zato nikoli ne odlagajte
in ne vgrajujte predmetov in mobilnih brezzi¢nih naprav ¢ez zratno blazino ali v obmogju, ki ga zasede napihnjena blazina. Ce
so brezzitne naprave v vozilu namescene nepravilno in se zratna blazina napihne, lahko pride do hudih telesnih poskodb.

Uporaba naprave v letalu je prepovedana. Izkljucite jo, $e preden se vkrcate v letalo. Uporaba brezzi¢nih naprav v letalu lahko
nevarno zmoti delovanje letala, ogrozi delovanje mobilnega telefonskega omrezja in je lahko nezakonita.

B Nevarnost eksplozije

Kadar ste na obmogjih, kjer lahko pride do eksplozije, napravo izklopite in upostevajte vsa navodila in opozorilne znake. To
vkljucuje obmodja, kjer morate obicajno ugasniti motor vozila. Iskre lahko na teh obmocjih povzrocijo eksplozijo ali zanetijo
poZar ter povzrotijo hude telesne poskodbe ali celo smrt. Napravo izklopite na mestih, kjer se rezervoarji polnijo z gorivom, na
primer v blizini bencinskih Crpalk. UpoStevajte prepovedi za uporabo radijske opreme v skladis€ih ali prostorih za distribucijo
goriva, v kemicnih obratih ali tam, kjer poteka razstreljevanje. Kraji, kjer obstaja nevarnost eksplozije, so pogosto, vendar ne
vedno, jasno oznaceni. Sem sodijo: ladijska podpalubja; skladi$€a za shranjevanije in precrpavanje kemikalij; vozila, ki za gorivo
uporabljajo tekoCi plin (npr. propan ali butan); kraji, kjer je v zraku veliko hlapov kemikalij ali drobnih delcev, kot so zrnca, prah
ali kovinski delci.
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Dodatni varnostni napotki

B Klici vsili

@ Pomembno: Mobilni telefoni, vklju¢no s to napravo, delujejo prek radijskih signalov, omrezij mobilne in stacionarne
telefonije ter programskih funkeij, ki jih nastavi sam uporabnik. Zaradi tega ne moremo jamciti povezave v vseh
razmerah. Kadar gre za nujne komunikacije (npr. pri klicih za nujno zdravstveno pomoc), se nikoli ne zanasajte samo
na brezzi¢no napravo.

Izvedba klica v sili:
1. (e naprava ni vkljutena, jo vkljuite. Preverite, ali je mot signala zadostna.
Nekatera omrezja lahko zahtevajo, da je v napravo pravilno vstavljena veljavna kartica SIM.

n

Pritisnite tipko za konec, kolikorkrat je treba, da se vsebina zaslona zbriSe in je naprava pripravljena za klice.

w

Vnesite $tevilko za klice v sili, ki velja na obmogju, kjer ste. Stevilke za klice v sili se od obmotja do obmotja razlikujejo.

e

Pritisnite tipko za klicanje.

(e so vkljutene dolotene funkcije telefona, jih je morda treba pred klicanjem v sili izkljuciti. Ve¢ informacij boste nasli v tem
priroCniku ali pa se obrnite na svojega ponudnika storitev.

Pri klicu v sili ¢im natancneje navedite vse potrebne podatke. Vasa mobilna naprava je lahko edino sredstvo komunikacije na
prizoris€u nesree. Klica ne koncajte, dokler vam tega ne dovoli klicana sluzba.

B INFORMACIJE O POTRDITVI (SAR)

TA MOBILNA NAPRAVA USTREZA ZAHTEVAM ZA 1ZPOSTAVLIENOST RADIJSKIM VALOVOM.

Vasa mobilna naprava je radijski oddajnik in sprejemnik. Nafrtovana in izdelana je tako, da ne presega emisijskih omejitev za
izpostavljenost radijskim valovom, kot jih dolo€ajo mednarodne smernice. Te smernice je razvila neodvisna znanstvena
organizacija ICNIRP in vkljucujejo varnostno rezervo, ki zagotavlja varnost vseh oseb, ne glede na starost in zdravstveno stanje.

Smernice izpostavljenosti za mobilne naprave uporabljajo merilno enoto, znano kot Specific Absorption Rate — specifi¢na hitrost
absorpcije — SAR. Smernice dolocajo omejitev SAR na 2,0 vata na kilogram (W/kg), porazdeljeno prek 10 gramov tkiva.
PreskuSanje za vrednost SAR se izvaja v standardnih poloZajih delovanja, pri cemer deluje oddajnik naprave z najve¢jo mocjo v
vseh frekventnih pasovih. Dejanska vrednost SAR delujoCe naprave utegne biti manjsa kakor najve€ja vrednost, saj je naprava
narejena tako, da oddaja samo toliko moci, kolikor je potrebno za dosego omrezja. MoC se spreminja glede narazline dejavnike,
na primer oddaljenost od bazne postaje omreZja. Najve¢ja vrednost SAR po smernicah ICNIRP za uporabo naprave ob usesu
zna$a 0,79 W/kg.

Ob uporabi naprave z dodatno opremo se vrednosti SAR lahko spremenijo. Vrednosti SAR se lahko razlikujejo glede na zahtevane
merilne in preizkusne postopke v drZavi ter glede na omrezno frekventno obmocje. Dodatne informacije o vrednostih SAR so
morda na voljo na spletnem mestu www.nokia.com pri informacijah o izdelku.
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